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CommCat 3.8 

 

 the DX Advantage  

Overview 

Welcome to CommCat, the intelligent Windows radio control and logging program for hams 

who share the passion for working DX. CommCat combines the latest technological advances in 

the Internet, personal computing, and radio engineering to provide exciting new ways to enjoy 

the amateur radio hobby. 

DX contacts can provide so much more than a brief exchange of calls and a 5NN signal report. 

They also can be an opportunity to learn about the world around us--its geography, history, 

culture, and the story of its people. CommCat provides a way to learn about the countries and 

people of the world as you hear and work new countries. 

What is CommCat? 

CommCat provides tools to help you work DX, log, track awards, and QSL while learning in the 

process. CommCat is not designed for contesting or specialized communications. There are 

many excellent programs already available to help you win a contest or predict when the next 

satellite window will be. If you want to outsmart the pileups and learn in the process, CommCat-

-the DX Advantage is for you. 

...And What is CommCatLive? 

CommCatLive is your own Internet Home Page hosted on the MyQSX.net web server. 

CommCat feeds live data from your station as you operate so visitors to your home page can 

watch and listen as you work DX, learn more about you on your About page, and listen to DX 

sound clips from the CommCatLive DX Clip library. If you are lucky enough to have 

grandchildren, wait till they see grandpa's web site! 

Be there for rare DX 

Monitor a Telnet connection, your local Packet DX Cluster and the WWW DX Cluster for 

needed DX spots. CommCat alerts you about new spots within seconds by voice, e-mail, or via 

your pager, so you can be on frequency before the pileup builds. 

Outsmart the Pileups 

Unique Point-and-Pounce control of your rig gets you to the right frequency with a single mouse 

click. Analyze the pileup using the spectrum analyzer and DX tracker windows to predict where 
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the DX station will listen as he moves from one station to the next. Tune to his anticipated 

receive frequency with a single mouse click and you are ready for action. 

Watch Band Edges 

The CommCat Tuner window shows where you are in any HF band--no more embarrassing out-

of-band goofs! Tune from one band to another by clicking on a dial that harkens back to pre-

digital days. 

Work That DX  

Once you have outsmarted the pileup you can concentrate on working that DX. CW operators 

can send their call from most CommCat windows using the integrated programmable CW keyer 

or optional K1EL Winkeyer. Send a signal report with a second keystroke, and you are almost 

done! 

Keep Track of Worked Stations 

Complete the QSO by entering the contact details with one keystroke in the CommCat log 

window. Choose a log format supplied with CommCat or design your own. There are no limits to 

the number of logbooks you can maintain--keep one log for QRP and other logs for special 

awards. Complete the information in the log from the CommCat FCC Database, any one of the 

popular call sign CD-ROMs, or from the Internet. Immediately detect if you have already 

worked a particular station. Check the QSL status for a station at any time. 

Confirm that Contact  

A flexible CommCat printing capability helps you design and prepare QSL cards, logs, and mail 

labels. Each QSL card can be personalized with details for the station you have worked. Add 

country flags, maps, station photos, or any clip art you wish, to enhance your card. 

Learn Country Facts 

CommCat is packed with features that take you beyond a simple QSO. Build and explore an 

instant web page from the perspective of any other station to see their current weather, local- and 

wide-area maps, and a detailed summary of the country including history, demographics, 

geographic features, and economy. 

Explore the World 

CommCat provides scores of maps, including a great circle map dynamically drawn with your 

location as center. Large format maps are available for most DX entities. These maps show 

political boundaries, time zones, DX prefixes, and local-focus areas. 
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What's New? 

CommCat version 3.8 

1. CommCat main window 

 New splash screen 

 Set program skin 

 New menu system 

 Rotor control toolbar 

 Voice keyer toolbar (CommCatLive only) 

2. DX Spot Manager 

 Widget sidebar 

o Spot info 

o Spot Folders 

o Band/Mode filter 

o Direction filter 

o Award filter 

o Spot Watch 

o Units Converter 

o QSO Timer 

o Notes 

 Spot Processing annunciator 

3. Advanced Log 

 Widget sidebar 

o QSO History 

o QSO Filter 

o QSO Picture 

o QSO Timer 

o Notes 

o Units Converter 

 All Contacts button is sticky 

 Spacebar looks up info in callbook 

 Call Field empty on start 

4. Band Spotter 

 Redesigned graphics 

 Faster response 

 Band edges clearly shown 

5. Telnet 

Configuring_CommCat.htm#Startup
Main_Window.htm
Main_Window.htm
CommCat_Live.htm
DX_Spots.htm
DX_Spots.htm
Log.htm
Log.htm
Log.htm
Log.htm
Band_Spotter.htm
Band_Spotter.htm
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 Auto log on when window opens 

6. Rig Control 

 Better provisions for COM ports above 9 

 Improved dual receiver control 

 Rig command logging 

7. CommCatLive 

 Send logged QSO's to CommCat Twitter account 

CommCat version 3.7 

1. CommCat main window 

 Current propagation conditions shown 

2. Band Spotter 

 User settable font size and bold for spots 

 Extended data format preserved between sessions 

 Spot dupes eliminated 

 Stack button on menu bar to turn spot stacking on and off 

 Spots come from the selected folder in DX Spot Manager 

 Added +/-1 KHz resolution selection 

3. Advanced Log 

 Send selected QSO's from your log via e-mail 

4. Spots 

 Send spots to new DX Summit site from CommCat 

 Get announcements from new DX Summit site 

5. CommCatLive 

 CommCatLive home pages updated 

 Display image in place of log in privacy mode 

6. Radios 

 Improved Elecraft K3 support 

 

CommCat version 3.6 

Telnet.htm
Configuring_CommCat.htm
CommCat_Live.htm
Main_Window.htm
Band_Spotter.htm
Log.htm
Configuring_CommCat.htm#MySpots
Getting_Started.htm
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1. DX Spot Manager 

 New DX Summit spot source options support 

 Columns for DX Bearing, Continent and Grid Square added 

 Grid Square option in Worked/Confirmed Rule Condition added 

 Dupe checking now keeps latest spot rather than first 

 Option to merge cells in columns where data doesn't change 

 Auto Update setting down to 1 minute (from 3) 

2. Band Spotter 

 Spots are now "stacked" rather than painted on top each other 

3. Advanced Log 

 QSO History list shows past 100 contacts 

 Use Esc key to start new contact 

4. DX Notify Popup 

 New options to change popup color and style 

 Popup no longer brings CommCat forward unless clicked 

5. External Programs 

 Two user-defined external program added (3 total) 

 Add custom tooltips for each external program 

6. Maintenance 

 Support for new CTY format 

7. Radio Support 

 Icom IC-7700 added 

8. CommCatLive 

 Option to not show latest contacts and last change time when you are disconnected from Live 

9. Help 

 This Help file updated for new features 

 

 

CommCat version 3.5 

DX_Spots.htm
Band_Spotter.htm
Log.htm
DX_Spots.htm#Alert_Notify
Configuring_CommCat.htm#External
Log_Maintenance.htm
Getting_Started.htm
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1. Radio/Ant 

 Added Elecraft K3, Yaesu FT-950, Ten-Tec Omni VI+ 

 Fixed Winkey contest serial number bug 

2. Connection to Web 

 Major rework of web interface to make connections and data transfer more reliable and faster 

3. CommCatLive 

 S-meter data upload bug fixed to improve reliability 

 Check your subscription status from Help menu 

4. Entity Maintenance 

 Added support for new CTY data format 

5. Spots 

 Supports new DX Summit site for downloading spots 

CommCat version 3.4 

Click the links to see the associated CommCat Help topic. 

1. DX Spot Manager 

 Drag DX Alert popup to any position on the desktop where it will remain 

 Click DX Alert popup to bring CommCat forward if hidden by other windows 

 Added enable to turn spot dupe checking function on/off 

 Use Ctrl+Z to return to previous spot 

 Turn off underlines indicating hyperlink to dx and spotter calls 

2. Settings 

 Major redesign of settings windows 

 Added fields for CQ Zone, ITU Zone, and continent 

 Added SSID to Telnet settings 

3. MixW Interface 

 Improved transfer of logging info to CommCat 

 Winkey now reinitialized when returning from MixW 

 

4. Radio/Ant 

Entity_Management.htm
Configuring_CommCat.htm#OH2AQ
DX_Spots.htm
Configuring_CommCat.htm
Configuring_CommCat.htm
Configuring_CommCat.htm
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 Added support for new style M2 rotor control 

 Fixed Ham Radio Deluxe startup issues on Radios B-D 

 Improved control of Flex Radio. 

5. CommCatLive 

 Radio dial spot display added to Live window. 

 Worked/Confirmed Rule Condition added option to test for spots mentioned in ARRL DX report. 

 Latest spots and DX news included on Instant Web Page. 

 Added DX cluster to MyQSX.net to supply spots to CommCat 

 You can now send spots, including long comment, to MyQSX.net DX Cluster 

 Change the MyQSX comment from the Live window 

 Display only Active stations in the Live window 

 Test Site added to CommCatLive test window 

 'Wavosaur' audio editor option added to Audio settings 

CommCat version 3.3 

Click the links to see the associated CommCat Help topic. 

1. Integration with Ham Radio Deluxe with exchange of frequency, mode, and s-meter data 

2. Rig support 

 Improvements for Icom 756PRO series. 

 Added support for Icom IC-7000 

 Added support for Flexradio PowerSDR 

3. Option to run CommCat in system tray rather than task bar when minimized 

4. Added DX Spot Manager Alert popup to Voice Announcement Action in Rules 

5. Bug fixes 

 Main window start up position not remembered 

 CW sending 9 at end of F10 macro 

 CW macros weren't available for CW-R 

 Bottom status bar sometimes didn't open properly 

 eQSL submission missing for 60M 

 CommCatLive S-meter sometimes stuck on 0 

 DXCC Award window showing inconsistent numbers for confirmed/worked options 

   

  

Live_in_CommCat.htm
DX_Spots.htm
Instant_Web_Page.htm
DX_Spots.htm
DX_Spots.htm
Live_in_CommCat.htm
Live_in_CommCat.htm
Test_CommCatLive.htm
Getting_Started.htm
Radio_Connections.htm#supported_radios
Configuring_CommCat.htm#Startup
DX_Spots.htm#Alert_Notify
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Typical Window 
 

 

 

CommCat provides flexibility in how its various windows can be arranged, depending on your interests and 

operating needs. The window arrangement is retained by CommCat so the next time you start the program, the 

windows can be opened and returned to the way they were before. An option is available to allow you to move 

CommCat windows out of the main window, which is perfect if you are using more than one monitor, or want 

to use CommCat with another program. 

Going in a clockwise direction from the upper left, the following windows are in use in this typical 

arrangement: 

DX Spot Manager The DX Spot Manager is the heart of the CommCat DX Spot monitoring system. Spots from a Telnet 

connection, Web Cluster, Packet Cluster, and spots you create locally, are listed and tested against rules 

you define for alerts and other actions. 

Instant Web Page Shows a web page from the perspective of the DX station. 

Great Circle Map 

  

Shows world map centered on your location. The most recent DX spots and gray line are superimposed. If 

you have a rotor that can be controlled by a computer, the antenna direction and representative beam 

pattern are also shown. 

CW Keyer Send Morse code from CommCat. 

Advanced Log Enter the necessary contact data into your logbook through this window. CommCat fills in most of the 

blanks for you. 

Configuring_CommCat.htm#Startup
Configuring_CommCat.htm#Window_Position
Configuring_CommCat.htm#Window_Position
Configuring_CommCat.htm#Window_Position
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A number of selectable toolbars are shown at the top of the CommCat window. In this setup the Navigation, 

Split, Band, and Mode toolbars are in use. 

In the status bar at the bottom of the window the current frequency, Telnet status, TNC status, Rig status, 

Internet status, date and time are shown. 

Updated 3/2009  
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System Requirements 

  

Computer 

 Windows '98 or later, including Vista (run as administrator) 

 1000 MHz or faster processor 

 512 MB RAM or more 

 High resolution display (CommCat is optimized for a display having at least 800 x 400 pixels) 

 Serial ports for transceiver control, TNC, and rotor operation. CW keying can be configured through 

the same port as the rig control, other serial ports, or a parallel port. CommCat supports up to 18 serial 

and 10 parallel ports. Parallel port CW keying is supported on Windows XP and Vista systems. 

CommCat also supports the K1EL Serial or USB port Winkeyer. 

 100 MB free disk space 

 Soundblaster sound card or equivalent for CommCat Spectrum Analyzer (only one application can use 

the sound card at a time) 

 Internet access (optional for call sign lookup, Telnet, DX Cluster, QSL template sharing, and e-mail 

access). CommCat email functions are not compatible with AOL. Broadband DSL or Cable Modem 

access required for CommCatLive services. 

  

Station Requirements 

 Transceiver supported by CommCat (most Yaesu, Icom, Kenwood, Elecraft, Ten-Tec Orion, and 

Collins KWM-380). CommCat provides direct control of the Orion II and can control other Ten-Tec 

radios that are Icom compatible or controlled through a compatible program such as N4PY. 

 TNC via serial port (optional, required for Packet Cluster) 

 Rotor controller supported by CommCat (Rotor-EZ, RotorCard, Hy-Gain, Yaesu, M2, ARSWIN, and 

Heath) 

  

E-mail 

 POP3 compatible (optional for DX notification and QSL exchange) Note: CommCat email is not 

possible through AOL accounts. 

  

Pager (optional) 

 Alphanumeric or Numeric pager 

 Dial-up or email access for spot notification (email is not supported through AOL accounts) 

  

Updated 3/2009  
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Important Vista Information  

CommCat 3.0 (and later) has been extensively tested on computers using the Vista and Vista 64 operating 

system. 

Because of aggressive security measures in Vista, it is critical that you start both Installation and the CommCat 

program by right-clicking over the application icon and selecting Run as Administrator. 

To make the Run as Administrator option permanent for CommCat, select Properties from the right mouse 

menu and choose that option.  
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COMMSOFT  

COMMSOFT, Inc., has been producing consumer software for over 30 years. 

COMMSOFT's early ham radio products include RTTY89, CW89 and Cipher89, 

all for Heathkit computers. In 1984 COMMSOFT produced PhotoCaster, an 
SSTV hardware and software system, for the Apple II. 

Until 1997, COMMSOFT was a premier developer and publisher of software for 

the genealogy market, including the award-winning ROOTS and Ultimate Family 

Tree. 

CommCat represents a return to its ham radio roots for COMMSOFT. 

Visit the CommCat web site for more information about COMMSOFT. 

http://www.commcat.com 

  

   

  

http://www.commcat.com/
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Legal Stuff 

CommCat and CommCatLive are trademarks of COMMSOFT, Inc.  
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Express Setup 

The first time you start CommCat, Express Setup opens. By following the easy steps presented by Express 

Setup you will have CommCat running with your rig in a few minutes. Later you can go back and use the 

various Settings windows to further customize your preferences. 

 

If you wish to skip Express Setup, click Set Up Later. Unless you check Don't Show Again, Express Setup will 

open each time you start CommCat until you have specified your rig. You can also start Express Setup from 

the CommCat Help menu. Once you have specified your rig, the Help menu Express Setup option is dimmed. 

To continue, click Next. 

  

The name and call sign you specified during installation appear in this window. 

Click Next to continue. 
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CommCat uses your Longitude and Latitude to compute bearings and distances in several places. For example, 

CommCat rotor control uses the bearing from your location to the DX station to determine where to direct the 

antenna. If you are in the United States, CommCat can use your ZIP code to compute your Longitude and 

Latitude. This convenience is not available for those outside the US. 

Click Yes (if you live in the US) or No (if you live outside the US) to continue. 

 

If you are located in the United States, you can ask CommCat to find your Longitude and Latitude from your 

ZIP code, or, if you already know them, you may enter them yourself. In the United States, Latitude is a 

positive number and Longitude is a negative number. (If you are outside the United States, CommCat asks that 
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you enter your Longitude and Latitude manually.) Enter your ZIP code and click Compute, or enter the values 

you wish to use. 

Click Next to continue. 

  

Next specify the Manufacturer and Model of your Rig. 

Click Next to continue. 

If you are using and Icom rig, an additional Radio window opens allowing you to specify the Icom CI-V 

address of your rig and handshaking options. 
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Specify the serial port used to control your rig. CommCat checks your computer for available serial ports and 

presents them in the Serial Port list. Finally, specify the Baud rate used for communications with your rig. If 

you are unsure of the Baud rate, please check the manual for your rig or interface module. 

Click Next to continue. 

 

CommCat now tests the connection between the computer and your rig to make sure the communications setup 

is correct. Make sure your rig is turned on and connected to the serial port you have specified. Click Test to 

start the connection test. If a connection is established, the rig's frequency will appear in the Frequency box. 
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CommCat attempts to connect for approximately 10 seconds. If a connection is not established, CommCat 

notifies you of a potential problem. 

If the connection is successful, click Next to continue. If the connection fails, click Back to review your rig, 

port and Baud rate selections. 

 

With a successful rig connection, you are now ready to start using CommCat. Congratulations and welcome! 

  

Updated 10/2007  
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Installation 

  Download CommCat from the CommCat web site to a convenient folder. It is recommended that you 

use a broadband connection (Cable or DSL at a minimum) for this download since the file is over 

32MB in size. 

 Start CommCat Setup by double-clicking the CommCat icon in the folder you used for the download. 

 Follow the instructions. If you have received a CommCat serial number, enter your name, call, and 

serial number in the Registration window. Without changes in these fields, CommCat operates in the 

Demo mode. 

 Note: The data in the Call and Serial Number fields must match for CommCat to run. 

The Serial Number for your call sign was included in the COMMSOFT registration 

code e-mail, if you have purchased the program. 

 

 CommCat Setup may ask to restart your computer once all files have been installed. 

  

Starting CommCat 

Start CommCat by double-clicking the CommCat shortcut located on your Desktop. The CommCat executable 

is located in the folder in which you installed the program (normally C:\Program 

Files\COMMSOFT\CommCat). 

Updated 3/2009  
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CommCat Main Window 

 

The CommCat Main window provides a work area for all program functions. The Main window opens after 

the Splash screen appears when you start CommCat. 

Title Bar  

 

The CommCat title bar shows the name of the currently active Master Log and logbook, and the DX focus call 

(explained later) and associated entity. The title bar also contains the normal Windows controls for 

manipulating the state and size of the window, and for closing the application. 

  

Menu and Toolbars 

 

The Menu Bar below the Title Bar provides access to all CommCat functions. The Tools menu lists CommCat 

functions used during normal operation. The Awards menu provides access to windows that contain status 

information for operating awards. The Reports menu provides access to printed report windows, including 

logbook, QSL and label formats. 
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The current propagation conditions from MyQSX.net are shown on the right side of the Menu bar. This 

information is fetched from the MyQSX.net web site each time you start and every eight hours from then on. 

 

The Toolbar provides quick access to the main CommCat windows. The large Toolbar version can include 

text, or you can choose a small version which only shows the icons (as above). Several of the buttons on the 

toolbar are optional. The MixW button will be present when MixW, a digital mode program, is installed. The 

numbered Program buttons are present when optional external programs are configured. 

 

The Menu and individual Toolbars can be moved to suit your preferences. Grab the handle at the left end of 

either bar and drag the bar to one of the three remaining sides of the CommCat Main window, or simply leave 

them as floating bars. 

Status Bar 

The Status Bar, located at the bottom of the CommCat Main window, contains a number of helpful status 

indications. The Net, Live, Telnet, TNC, Rig and Net status lights will be red, yellow or green, depending on 

their respective connection states. Red indicates no connection, yellow indicates unknown, temporarily 

disconnected or busy, and green indicates a normal connection. Double-click any of these five status panels to 

see more information about connection status, or to force a connection when you wish to reconnect. 

 

When CommCat is started the first time and no settings have been made to assign ports, the Telnet, TNC, and 

Net status lights are red. When the rig has been connected and is communicating with CommCat, the current 

operating frequency is shown in the left status panel and the rig status light is green. 

The time and date are displayed in Coordinated Universal Time (UTC).  
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Navigation from One Window to Another 

CommCat follows the normal keystroke conventions for moving from one window to another via the 

keyboard. Use Ctrl-F6 or Ctrl-Tab, or their shift equivalents (Shift-Ctrl-F6 and Shift-Ctrl-Tab) to move 

through the CommCat windows. To move from one application to another, use the Alt-Tab combination. 

Moving CommCat Windows Outside the Main Window 

Any CommCat window on the Navigation toolbar can be moved outside the Main window. This option is 

perfect if you are using a dual monitor system, or wish to use CommCat along side another program. When 

you do move a window outside the main window, the window name appears as a separate program on the 

Windows Task bar at the bottom of the desk top. In addition, since they become separate windows like any 

other application, they can be hidden by a window that covers them, including the Main CommCat window. 

To choose which Windows can be moved outside, open the Program Settings window from File, Settings, and 

select the Outside Window tab. A check indicates that the window can be moved outside. 

 

Click OK to close Program Settings. Any changes you have made to the Window Position options are applied 

when the Program Settings window is closed. 
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Updated 3/2009  

  



29 

 

Toolbars 

 

The CommCat Main Window, shown above, can hold up to eight toolbars. The toolbars can be docked to any 

side of the main window, or they can be detached so they are in different levels (as shown above). When you 

exit CommCat, the toolbar positions are saved and used the next time you start the program. 

Toolbar 

Name 

Function 

Standard Log and Edtiting tools 

Band Change bands 

Mode Change the operating mode 

Navigation Open CommCat windows and bring them to the front 

Split Turn on and off split frequency operation, with splits from 0 to 20 

kHz 

Rotor Quick rotor control 

Rig CommCat can control up to 4 rigs, enabled through the Rig A, 

Rig B, Rig C, or Rig D buttons. 

CommCatLive Toolbars 

 

Two additional toolbars are available when you have a CommCatLive account. The Live Annunciator toolbar 

lets you choose the status shown on your CommCatLive home page. The Audio Record/Playback toolbar 

controls recording, streaming, and playback. 
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Modifyin g Toolbars 

Toolbars are shown and hidden by 1) right-clicking over any toolbar and choosing from the list, or by 2) 

clicking View, Toolbars on the CommCat menu bar. Click a toolbar in the list to show or hide a toolbar. 

You can also add or remove buttons from any toolbar to customize it. Open the Toolbar Customize window by 

right-clicking over a toolbar, then selecting Commands. To remove a button from a toolbar, drag the button 

from the toolbar you wish to modify. To add a button, drag the button from the Commands window to the 

toolbar you wish to use. For example, if you don't wish to show the 6 and 2 meter buttons on the Band toolbar, 

open the Commands window and drag each button away from the toolbar. 

To add text to toolbar buttons that contain only pictures, click View, Toolbars, Show Captions. 

Moving a Toolbar 

To move a toolbar, click the handle at the left end of the toolbar you wish to move, then drag it to its new 

location. When the toolbar is near one of the edges of the main window, it will snap to the edge. The following 

moves are possible. 

 Move a toolbar to the left, right or bottom of the main window. 

 Change the order of toolbars. 

 Create a multi-line toolbar. 

  

Updated 3/2009 
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Settings 

CommCat uses information about you, your station, and your access to the Internet to provide a highly 

personalized operating environment. Your personal information is entered in the Settings windows (File, 

Settings). 

Important Settings 

When you installed CommCat your name and call sign were entered automatically in the Station and Code 

Settings. These are the only required settings for the program. There are several additional settings that are 

important to enter the first time you run CommCat. These settings are normally made through Express Setup: 

 Longitude and Latitude in the File, Settings, Station window, required to calibrate direction headings, 

distances and the center of the Great Circle Map (in the US, CommCat can determine the longitude 

and latitude from your ZIP code). 

 Rig settings in the File, Settings, Station, Radio/Ant window (required to set the necessary control 

parameters so CommCat can "talk" to your radio). 

Most other settings are already entered with default values which you can change later as you learn more about 

the program. 

Many windows can be customized to your liking. Fonts for windows can be specified, and the size and 

position of windows can be adjusted. 

Setting Details 

CommCat Settings are divided into four categories. Program Settings include those associated with program 

startup, help options, font choices for many windows, external program information, window position choices, 

and backup options. Radio/Ant settings are used to specify up to 3 rigs with their port and other associated 

information, and up to 3 rotor controllers and multiple antennas. Station Settings include all options related to 

you, your station, and operating options. Spots Settings are used to configure general spot processing details, 

and packet, web, and Telnet spot retrieval options. 
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Program Settings 

 

Program Settings Roadmap 

The following table provides a roadmap for the various program settings in CommCat: 

Startup Set the CommCat environment when the program is started. 

Help Customize program help options. 

Fonts Set fonts for primary windows. 

Backup Choose log backup strategies. 

External Parameters for external programs, including MixW and a program that can be configured to any application. 

Window Position Specify which windows can be moved out of the Main CommCat window. 

Voice Enable/disable CommCat's voice announce capabilities 

Environment Miscellaneous program settings 

Startup 

Field You Provide Where Used 

Restore   

Restore Previous 

Windows 

The size and position of open windows are retained by 

COMMSOFT and used the next time the program is started 

Program start 

Restore Last DX 

Call 

The focus call sign when the program was last closed is restored 

on startup. 

Program start 

General   

Fast Computer 

System 

If your system is faster than 300-400 MHz, checking this option 

removes several restrictions that are necessary to improve CW 

timing on slower systems. 

Morse Code transmission. If you find that 

the character timing is not precise when 

CW is being sent, uncheck this option. 

Don't Show Delete Overrides CommCat reminders that something important is Log 
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Warnings about to be deleted. 

No Rig Timeout Keeps rig serial port open even though the rig is not 

communicating. 

Rig control 

Minimize to Tray When you minimize CommCat, the program runs in the System 

Tray rather than the Task Bar. When running in the System 

Tray, CommCat continues to run. CommCat pauses when 

running in the Task Bar. This option is useful if you want the 

DX Spot Manager to continue to look for spots even though the 

program is hidden. Restart CommCat after changing this option. 

Minimizing CommCat 

Use Kilometers Check to have distance units in Kilometers rather than miles Great Circle Map, Instant Web Page 

Diagnostics   

Test Mode Provides additional troubleshooting information if problems are 

encountered. CommCat-to-radio control information is logged 

in a file named rclog.txt located in the Controls folder when 

Test Mode is enabled. 

Entire program 

Log Rig Control Creates a log of control commands sent by CommCat to your 

rig. The resulting file is named rclog.txt, located in the Controls 

folder. (This is the same log created with Test Mode, above, but 

no other logs are created.) 

Rig control 

Internet   

Connect to Internet CommCat will attempt to connect to the Internet when this 

option is selected. 

Web Spot announcements, e-mail, 

callsign lookup, weather lookup, time 

check 

Ignore Internet 

Errors 

If a connection error is detected do no disconnect CommCat 

from the Internet 

All Internet activity 

Enable 

CommCatLive 

Enable CommCatLive feeds when you have a CommCatLive or 

QSXer account 

CommCatLive/QSXer 

Force QSXer If you have a CommCatLive account, this option causes 

CommCat to run in the QSXer mode where only the QSXer 

Activity Map is updated. 

CommCatLive/QSXer 

Toolbars 

Field You Provide Where Used 

Toolbars Specify which toolbars you wish to appear in the main window 

and whether they are small or large (with text captions). 

Entire program 

Help 

Field You Provide Where Used 

Display Tooltips Displays Tooltips help when mouse pointer hovers over a toolbar 

pushbutton or other control 

Entire program 

Use F1 for Help, not 

CW Message 1 

Windows convention is that help is provided when you press the 

F1 function key. CommCat allows you to reassign this key to CW 

message 1 or Voice Macro 1 when in a voice mode. 

Entire program (Voice Macros are a 

feature of CommCatLive) 
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Fonts 

Field You Provide Where Used 

Log Set the font and size for this window Advanced Log window 

Morse Code Set the font and size for this window Morse Code window 

Packet Cluster Set the font and size for this window Packet Cluster window 

DX Spot Manager Set the font and size for this window DX Spot Manager window 

Telnet/Internet 

Cluster 

Set the font and size for this window Telnet/Internet Cluster windows 

Backup 

Field You Provide Where Used 

Periodic   

Periodic Specify when you want CommCat to back up your log. If you 

wish to ignore this backup do not check any options. 

Logging, Timed 

Backup Only When 

Changes 

Is a backup really necessary? (Also applies to Program Exit 

backup.) 

Logging, Timed 

Program Exit   

Program Exit Back up when program closes Program Exit 

Enabled CommCat will back up log when program closes if checked Program Exit 

Ask Me First/Just 

Do It 

How much do you want to be involved? Logging, Program exit 

Destination   

Destination Patch for Back up file. Set separate paths for Periodic and 

Program Exit backups. 

Logging, Program exit 

External 

Field You Provide Where Used 

MixW   

MixW Enabled When MixW is installed with CommCat, use this option to 

temporarily turn off the control of MixW by CommCat. When this 

option is checked and MixW is installed, a MixW button is 

provided on the Navigation toolbar. See Accessories Help for 

more information about MixW. 

MixW control 

 

CAT Auto CommCat and MixW use the same serial port to control your 

radio. This option provides automatic serial port switching when 

MixW is started from CommCat. CommCat releases the serial 

port when MixW opens, and regains control when MixW is 

closed. 

MixW control 

MixW Always on 

Top 

The MixW window is always on top when MixW is open and this 

option is set. Note that this condition can hide other open 

windows which would normally be visible. 

MixW control 

MixW Path The complete path to MixW, including mixw2.exe. (The installed 

path is normally c:\program files\mixw\mixw2.exe.) 

MixW control 

Program   

Accessories.htm
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External Program 

Enabled (1, 2, 3) 

When an external program is installed with CommCat, use this 

option to temporarily turn off the control of that program by 

CommCat. When this option is checked, a windows button is 

provided on the Navigation toolbar. See Accessories Help for 

more information about external programs. 

External program control 

 

Test Starts the external program External program control 

Tooltip Short description of the external program that appears as a tooltip 

when you move the mouse pointer over the program button. 

External program control 

External Program 

Path 

The complete path to the external program, including the program 

name, extension, and any parameters you wish to use. For 

example, "c:\windows\notepad.exe qsonotes" starts Notepad with 

a text file named qsonotes. 

External program control 

DX Atlas   

DX Atlas Enabled When DX Atlas is installed with CommCat, use this option to 

temporarily turn off the control of DX Atlas by CommCat. See 

Accessories Help for more information about DX Atlas. 

DX Atlas 

Toolbar Button Add a button on the CommCat Tools toolbar for DX Atlas DX Atlas 

DX Atlas Path The complete path to DX Atlas, including the program name, 

extension, and any parameters you wish to use. For example, 

"c:\program files\Afreet\DX Atlas\DXAtlas.exe". 

DX Atlas 

Outside Window 

Field You Provide Where Used 

Allow Position 

Outside Main 

CommCat Window 

Select the windows you want to be able to move outside the Main 

CommCat window. This option is useful for dual monitor 

systems, or when you want to use one of the CommCat windows 

(such as the DX Spot Manager) with another program. 

Selected window 

Voice 

See also: CommCat Voice 

Field You Provide Where Used 

Windows Select the windows you would like to have announced by 

CommCat Voice. 

Selected window 

Time Use CommCat Voice to announce the UTC or local time, on the 

hour or on the half hour 

Program 

Radio/Antenna Announce the rig status (current frequency, mode, and split 

frequency), the bearing sent to the rotor, and the bearing returned 

from the rotor. 

Rig and antenna information 

Program Greeting CommCat welcome when the program starts. Leave blank to 

disable the greeting. 

Program start 

Environment 

Field You Provide Where Used 

Refresh Instant Web 

Page.. 

Check this option to have the Instant Web Page refreshed 

automatically when the Focus DX Call changes. 

Instant Web Page 

Accessories.htm
Accessories.htm
CommCat_Voice.htm
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Show Google Map Adds a Google map to the Instant Web Page showing the 

location of the station. 

Instant Web Page 

Main Window 
Background 

  

Display a bmp image of your choice on the CommCat Main 

window. Check the Display Image option to display an image 

specified in the path box. Show it in actual size of scale it to fit 

the window size. If shown in actual size you can drag it to a 

position in the main window you prefer. 

Main Window 

Skin Choose from a variety of skins to apply to the CommCat 

windows. 

Entire Program 
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Radio and Antenna Settings 

 

Radio A, B, C, D 

CommCat can control up to 4 rigs, switching from one to the other with a mouse click. These setups are 

designated Radio A, B, C, and D. When you have defined more than one radio, you can switch using the Rig 

option menu items on the File menu, or use the Rig toolbar. 

Field You Provide Where Used 

Radio   

Manufacturer Select the manufacturer of the rig you are using Rig control and data 

Model Select the radio you are using from this list Rig control and data 

Log Name   

Log Name Name of this radio used for log and QSL Cards. If blank, the 

model is used. 

Log and QSL Cards 

Port   

Port Select the serial port used for your radio. If the port has been 

assigned elsewhere, "used" appears next to the port number. The 

Collins KWM-380 uses LPT1 by default. 

Rig control and data 

Advanced Enter serial communications parameters when necessary (usually 

the defaults are correct). If the communications parameters are 

fixed by the manufacturer, the Advanced pushbutton is disabled. 

If using an Icom rig, set the rig address here. 

Rig control and data 

CW   

CW Keying Port Select the port you wish to use for CW keying. Select "same as" to 

use the same serial port assigned to the rig. You may also use the 

K1EL WinKeyer with Radio A by checking the Use WinKeyer 

option. Specify the serial port you wish to use with the WinKeyer. 

CW keying 

DTR When selected, the Data Terminal Ready serial port control line is CW keying 
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used for CW keying. Note that some rigs require the use of the 

DTR line for data communications or level converter power, so it 

may not be possible to use this line for CW keying. 

RTS When selected, the Request To Send control line on the serial port 

is used for CW keying. Note that some rigs require the use of the 

RTS line for data communications, so it may not be possible to 

use this line for CW keying. 

CW keying 

Test CW Closes CW key so you can test the connection between the 

computer and CW keying input on the radio. 

CW keying 

CW Pitch Set the pitch of the CW sidetone when the radio does not support 

the reading of this parameter. 

Spectrum Analyzer window 

CW Mode Off 

When Quit 

Program 

Check this option to cause CommCat to leave the radio in the SSB 

mode when leaving the program. This option is useful to prevent 

your computer from inadvertently keying the radio when keying 

through a serial port. 

CW keying 

S-Meter   

S-Meter For radios that support the transfer of signal level data to 

CommCat, the amount of data transferred can be lessened by 

unchecking this option. 

Tuner window 

PTT   

PTT Control Select type of desired PTT control (non, via software, or via 

hardware LPT port). 

Transmitter control 

PTT Port Specify LPT port to be used for PTT control. Parallel port 

operation is not supported with NT-based systems. 

Transmitter control 

PTT Delay Set time between PTT activation and CW keying. Transmitter control 

Amplifier   

Amplifier Model Enter the description of your linear amplifier here. QSL and Label designer window 

Transmitted 

Power 

Transmitter plus amplifier power QSL and Label designer window 

Ant/Rotor  

Use the Ant/Rotor window to specify up to 10 antennas and 3 rotor controllers and how they are used. 

Field You Provide Where Used 

Antennas Identify the antennas you will be using. Add the offset from North 

relative to the rotor North. For example, if a rotor indicates North 

while the antenna points East, enter 90 in the Offset field. Once 

you have specified any rotors, identify them by number with their 

associated antenna. 

Log, QSL, Log Report, Rotor Control 

Band Identify the antenna by number for each band you use. Log, QSL, Log Report, Rotor Control 

Rotors Describe each rotor you use and specify the port parameters (baud 

rate, etc.). Enter the rotor stop position if other than North. Use the 

rotor number to complete the Antennas data. If the port shown in 

the Port list has been assigned elsewhere, "used" appears next to 

the port number. 

Log, QSL, Log Report, Rotor Control 

 

Remote and LPT 
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A parallel port can be used to cotrol external devices, such as the Top-Ten controller. 

Use the Remote window to specify the connection parameters to control a remote radio. See CommCat 

Remote. 

Field You Provide Where Used 

Device Enable extrernal control and determine the protocol. External device control 

Port The parallel port to be used External device control 

Test Test the output from the parallel port for the specified band. External device control 

Remote Enabled Enable CommCat to control a radio over the Internet. Control remote radio 

Remote IP Address 

and Remote Port 

The IP address and port of the computer that is controlling the 

remote radio. 

Control remote radio 

Password The password assigned to CommCat at the remote computer to 

allow control. 

Control remote radio 

All Radios 

Field You Provide Where Used 

Tuning   

Synchronize VFOs If you would like VFO B to be synchronized with VFOA as you 

tune, check this option. 

Rig Control 

Enable Dual 

Receiver 

To set the sub receiver to the transmit VFO frequency, select this 

option. 

Rig Control 

Polling   

Rig Refresh Factor Relative rate at which the rig is polled. The rate determines how 

often the data light flashes on many rigs. If set too low (less than 

1) data exchange can become unreliable. You must restart 

CommCat to have this setting applied. 

Rig Control 

  

WinKeyer 

The K1EL WinKeyer (serial or USB) can be used when Radio A is selected. Not available for Radios B, C, 

and D. 

Field You Provide Where Used 

Settings   

Settings Set the two sliders to your Weight and Ratio preferences. You 

may also connect an external paddle to the Winkeyer and set the 

mode, hang time, and right or left hand operation. 

WinKeyer 

Keyer Outputs   

Keyer Outputs Set the pin connections for the WinKeyer serial port. If you wish 

you can use the sidetone option from the WinKeyer with an 

external audio amplifier. 

WinKeyer 

 

Station Settings 

CommCat_Remote.htm
CommCat_Remote.htm
CommCat_Remote.htm


40 

 

 

Station Settings Roadmap 

The following table provides a roadmap for the Station settings in CommCat: 

Station Call, License Class, name, address, and longitude/latitude 

CW Function key memories, default code speed settings, and contest options 

Pager Alphanumeric and numeric pager options including telephone numbers, e-mail address and other information 

necessary to send spot notification pages 

Modes Mode list and mode editing functions 

Log Logging options 

eQSL eQSL options 

Time URL for remote time server and time update options 

GoList Options for the GoList QSL Manager service 

Callbook Callbook data source for US and international calls, either from a local CD-ROM or on-line database 

  

Station 

Field You Provide Where Used 

Call   

Call Your ham callsign. Entered when you install the program. If it is 

necessary to use another callsign, such as when operating from a 

portable location, simply change the call in the Settings window. 

CommCat always defaults to the original registered call on 

startup. 

Code window (Settings, Code); Global 

Code Messages (Settings, Code); QSL 

Designer; Label Designer; Log; Packet 

window (for initializing your TNC); Spot 

Announcements. 

License Class Select the appropriate License Class. If not in the US, use Other. Band Spotter band edges 

Address   

Name Your name QSL and Label Designer 

Address 1 First address line (such as apartment, company name) QSL and Label Designer 
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Address 2 Second address line (such as post office box, street) QSL and Label Designer 

City City QSL and Label Designer 

ST State, Province QSL and Label Designer 

ZIP ZIP or Postal Code QSL and Label Designer 

County County QSL and Label Designer 

Country Country QSL and Label Designer 

Location   

Longitude Longitude of your station (enter as a decimal value, enter 

negative for west longitude) 

Grid square calculation; DX circle map 

center; QSL Designer; Label Designer 

Latitude Latitude of your station (enter as a decimal value, enter negative 

for south latitude) 

Same as longitude 

Compute from ZIP Computes your US latitude and longitude from your ZIP code 

and enters the data in the respective fields. 

See above 

Grid Square Locator grid square. Computed grid square is based on longitude 

and latitude 

QSL and Label Designer, Send MyQSX 

Spots (CommCatLive only) 

My CQ Zone Your CQ Zone (Computed zone is based on your call) Send MyQSX Spots (CommCatLive 

only) 

My ITU Zone Your ITU Zone (Computed zone is based on your call) Send MyQSX Spots (CommCatLive 

only) 

E-mail   

E-mail Name The name you wish to appear on e-mail messages originated by 

CommCat. 

Email spot notification 

Mail Host The host name used to send e-mail from your account. 

CommCatLive users can enter MyQSX.net to have MyQSX 

handle outgoing mail. 

Same 

My E-mail 

Address 

The return address included in your messages. Same 

Send Test E-mail Sends a test message from your account to the address in the To 

box. 

Settings 

To Distribution list for spot announcements sent by CommCat. Use 

e-mail addresses and separate multiple address by semi-colons. 

Same 

CW 

Field You Provide Where Used 

Macros   

CW Message Macros (F1 

- F10) 

Text to be sent in Morse Code when the respective F-key is 

pressed. Note that F1 can be assigned to a Morse Code macro or 

to the CommCat Help system. Special characters can be included-

-see Morse Code Help topic. See the Program Settings, Help 

window, to change how F1 is used. 

Sending Morse Code 

Macro Slow Speed Speed at which macro messages are sent when the Shift Key is 

used along with the F-key. 

Sending Morse Code 

Macro Fast Speed Speed at which messages are sent using a macro or when speed-up 

character (>) is used in a macro or Shift key is used when sending 

CW message via a macro. 

Sending Morse Code 

Sidetone   

Code.htm
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Sidetone Off Turns off sidetone from speaker and from sound board. If using a 

WinKeyer you can use its internal sidetone. 

Sending Morse Code 

PC Speaker Sends CW sidetone to the PC speaker. This option is available for 

Windows Me and earlier systems (not available for NT or XP 

systems). 

Sending Morse Code 

Sound board Uses computer's sound board to create sidetone. Sending Morse Code 

Spacing   

Farnsworth Spacing Regulates the rate at which characters are sent for code speeds of 

18 WPM and less. The Farnsworth rate is held at 18 WPM with 

increasing time between characters for slower sending. 

Sending Morse Code 

Hang   

CW Hold "Hang" Number of seconds CommCat background processes are stopped 

after a CW character is sent. CW start and character timings are 

improved when these background processes are stopped. When set 

to 0, background processing is stopped indefinitely while the 

Morse window has focus. 

Sending Morse Code 

Contest Serial   

Contest Start Starting serial number for contest operation. This number 

increments each time a contact is logged. Enter the number 0 to 

disable the Contest Counter. 

Sending Morse Code 

Contest Serial Length Sets the number of characters to be sent in a serial number. Many 

contests require that 3 digits be sent for serial numbers below 999. 

Serial number 9 is sent as 009 when the length is set to 3. 

Sending Morse Code 

Send 0 as T Substitutes the letter T for the number 0 in contest serial numbers. Sending Morse Code 

Pager 

Field You Provide Where Used 

Type   

No Pager Disables pager DX Spot notification 

Pager Type 

Alphanumeric 

Pager is capable of receiving and displaying text messages Same 

Pager Type Numeric Pager can display numbers 0 through 9 Same 

Destination   

Page Destination 

Direct or E-mail 

Page will be sent to pager by direct telephone connection to 

paging service, or by e-mail if a telephone connection is not 

available because you are connected to the Internet 

Same 

Page Destination E-

mail Only 

Only send pages via e-mail Same 

Page Destination 

Direct Only 

Only send pages by calling the paging service Same 

Page Destination 

Test Page 

Send a test page Same 

Details   

Pager Telephone 

Number 

Number used to call paging service Same 

Minimum Time 

Between Pages 

Prevents continuous pages Same 
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(Mins) 

Pager Baud Rate Baud rate to be used when paging service is called directly--get 

this number from your paging company 

Same 

Pager PIN Identification number assigned to your pager, used when calling 

paging service direct--get this number from your paging service 

Same 

Maximum Message 

Block Size 

Maximum number of characters an alphanumeric pager message 

can contain--set by paging service. Messages longer than this 

number are broken up into consecutive pages. 

Same 

Page E-mail 

Address 

E-mail address used to send pages via the Internet Same 

Page Mail Host Name of your mail host used to send e-mail messages Same 

Modes 

Field You Provide Where Used 

Names   

Mode List List of modes supported by CommCat. This list can be modified 

as new modes are developed. 

Log, Log Report, Export, QSL 

Add Add a new mode to the mode list. Log, Log Report, Export, QSL 

Delete Delete a mode from the mode list. Log, Log Report, Export, QSL 

Mode Long Name Descriptive name for the mode Settings 

ADIF Export Name Mode abbreviation to be included when you export the mode in a 

log via Amateur Data Interchange Format (ADIF). See 

http://www.hosenose.com/adif for the most recent specification 

for ADIF. 

Export 

Award Name The mode name used when applying for awards. For example, 

SSB may be specified as PHONE. 

Award reports 

Notes Add any notes you wish to help understand this mode in the 

future. 

Settings 

Mode Tracking Synchronizes VFO B mode with VFO A mode. Frequency Control 

Use Spot Notes for 

Mode Hints 

Specifies that CommCat will use information in spot notes, such 

as RTTY, to determine the current mode. 

Rig control 

RTTY Options   

For RTTY Rig uses Mode used for RTTY by your radio Mode control 

RTTY Offset Audio offset used for RTTY Frequency control 

Log 

Focus Call   

Focus Call to Log Determines how the DX Focus Call is used in the two log 

(Advanced and Quick) windows. This selection determines if 

the Focus Call is preloaded into the log. 

Auto logbook entry 

Lookup Options   

Lookup when Call Logged Tells CommCat to use the callbook source you have specified 

to look up additional data for this contact when it is logged. 

This operation can be accomplished manually by clicking 

Lookup on the Advanced Log toolbar. 

Advanced Log 

http://www.hosenose.com/adif
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Look Up Full Name CommCat will find the full name for the license holder rather 

than just the first name. 

Advanced Log 

Sound Dupe Alert When CommCat determines that a DX Focus Call has already 

been worked, the selection bar in the Advanced Log is shaded 

red. When checked, this option additionally sounds an audio 

alarm. A file named ding.wav, located in the CommCat Audio 

folder, is used. You may change this file to any other audio 

file (.wav) of your choosing. 

Advanced Log 

Use Enter for Lookup When checked, CommCat looks up information from previous 

contacts for the specified call rather than creating a new log 

record. 

Advanced Log 

All Logs   

All Logs Selection Click the Logs you wish to use when All Logs is selected Advanced Log, Awards, 

Export 

When QSO Logged   

When QSO Logged Data in the log data entry fields can be kept or deleted when a 

new contact is logged. 

Advanced Log 

Time/Date Entry   

Time/Date Entry Automatic/Manual In normal operation CommCat enters the time and date for a 

contact from the system clock. The time and date are 

determined when the contact is logged. Sometimes is is 

necessary to override this automatic feature, for example, if 

you wish to manually add contacts after the fact. 

Log 

Preferred Style   

Preferred Style Select Advanced or Quick Log as your preferred log data 

window. This is the log format that opens when you open a 

log from File, Open Log, or you click the Logbook button on 

the main toolbar. 

Log 

eQSL 

Field You Provide Where Used 

eQSL User Your eQSL user name, usually your call. eQSL submissions from the Advanced 

Log 

eQSL Password 

  

Your eQSL password that you assign when you register for eQSL 

See http://www.eqsl.cc 

eQSL submissions from the Advanced 

Log 

 

 

 

Time 

Field You Provide Where Used 

Offset   

http://www.eqsl.cc/
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Time Offset (read only) 

  

The computed difference between local time at Coordinated 

Universal Time (UTC). This number is determined 

automatically by your operating system. 

Beacon service; logging 

Use Local Time Time displayed in your log and bottom status bar is in local 

time. The log continues to use UTC, although local time is 

displayed. 

Logging 

GoList 

Field You Provide Where Used 

Enable GoList When checked, CommCat looks up DX QSL Managers using the 

GoList database. See http://www.golist.net. 

Advanced Log, QSL Manager lookup 

Path to GoList 

Database 

Enter the path to the GoList Database on your system. Advanced Log, QSL Manager lookup 

Callbook 

Field You Provide Where Used 

US   

United States Data 

Source 

Specify source of callsign data for calls in the United States. If 

the source is a CD-ROM, an additional drive selection box 

appears. QRZ Subscription is a paid subscription service from 

QRZ, which requires a password. MyQSX is available to 

CommCatLive users. 

Logging, call lookup 

International   

Outside United States 

Data Source 

  

Specify source of callsign data for calls outside the United 

States. If the source is a CD-ROM, an additional drive 

selection box appears. This option allows you to choose the 

FCC database for US calls and a commercial database for 

others. QRZ Subscription is a paid subscription service from 

QRZ, which requires a password. MyQSX is available for 

CommCatLive users. 

Logging, call lookup 

 

 

 

 

 

 

 

 

http://www.golist.net/
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Spots Settings 

 

Spots Settings Roadmap 

The following table provides a roadmap for the various spots settings in CommCat: 

DX Spot 

Manager 

DX Spot Manager layout and timing options 

Circle Map Circle Map spot options 

My Spots Destinations for spots you create 

MyQSX Spots from MyQSX (CommCatLive only) 

DX Summit Internet URL's and control information 

Telnet URL's and details for Telnet connections 

Packet Cluster Packet Cluster settings 

DX Notify 

Popup 

Settings for the DX Popup 

DX Spot Mgr 

Field You Provide Where Used 

List   

Max Hours to Retain 

Spots 

Specify number of hours before a spot is deleted from the spot 

database 

DX Spot Manager 

Minimum Spots 

Retained 

Leave this number of spots in the spot database no matter how 

long they've been there 

DX Spot Manager 

Update Interval Interval in minutes between automatic Internet Cluster updates DX Spot Manager 

AutoTune Tune the radio to the spot frequency when a DX spot is selected. 

Normally the radio is tuned after you double-click the spot 

DX Spot Manager 

Use Update Interval Holds Telnet spots for the Update Interval to reduce DX Spot DX Spot Manager. 
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for Telnet Manager rapid changes 

Selector   

Select Latest 

Incoming Spot 

When checked, the DX Spot Manager selection bar always 

shows the most recent spot after new spots arrive. When not 

checked, the DX Spot Manager always returns to the Focus DX 

Call. 

DX Spot Manager 

Selector 

Arrow/Solid/Outline 

Determines the selector bar style for the DX Spot Manager spot 

list. Select Outline to see the color of the spot. Add an arrow to 

the left side of the selected spot. 

DX Spot Manager 

Auto Update The DX Spot Manager list is updated through the Internet 

automatically at an interval set by the Update Interval described 

above. 

DX Spot Manager 

Grid Options   

Horizontal Lines Chhose the style you wish to separate spots from each other DX Spot Manager 

Hide Underlines Removes underlines from DX and Spotter calls that indicate link 

to the Instant Web Page. (See Call Lookup, below.) 

DX Spot Manager 

Foreground, 

Background colors 

Set the default background and foreground colors for the spot 

grid 

DX Spot Manager 

Info Panel Options   

Show Sunrise/Sunset Adds calculated sunrise and sunset for the DX station in the info 

panel. Important Note: this option requires Internet lookup for 

each spot so it will slow processing 

DX Spot Manager 

Call Lookup   

Single-click Call 

Lookup 

Single-click a DX or Spotter call to display the Instant Web Page 

for that call. (See Grid Options, above, for adding/removing the 

underlines under each call when this option is enabled.) 

DX Spot Manager 

Circle Map 

Field You Provide Where Used 

Great Circle Map 

Maximum Spots 

Shown 

Maximum number of spots shown on the Great Circle Map Great Circle Map 

Show Grayline Show the grayline (sunrise/sunset) on the Great Circle Map Great Circle Map 

My Spots 

Field You Provide Where Used 

Logged Contacts   

Add (Logged Contacts) 

to My Spot Table 

When a contact is logged, the call, frequency and note (see below) 

are added as a local spot to the Spot Manager. The worked station 

then appears on the Spectrum Analyzer. 

DX Spot Manager 

Logged Contacts Note Text to include in note field for local log spots DX Spot Manager 

Destination   

Send Spot Destination: 

Spot Manager 

When announcing a new spot (Ctrl-S), add it to the DX Spot 

Manager List 

DX Spot Manager 

Send Spot Destination: When adding a new spot (Ctrl-S), post it to the Internet cluster DX Spot Manager 
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DX Summit (Important note: if your Packet Cluster also forwards spots to the 

Internet Cluster, do not specify Packet Cluster as well as Internet 

Cluster.) 

Send Spot Destination: 

Telnet 

Post to the enabled Telnet connection. DX Spot Manager 

Send Spot Destination: 

Packet 

When adding a new spot (Ctrl-S), post it to the Packet cluster. See 

note above. 

DX Spot Manager 

Send Spot Destination: 

MyQSX 

Upload spot to MyQSX spotting system. Spots sent to MyQSX 

are not forwarded to other spotting systems. 

DX Spot Manager 

Send Spot Destination: 

E-mail 

When adding a new spot (Ctrl-S), send it to the e-mail distribution 

list. (Note: If you have set up a distribution rule in the DX Spot 

Manager window that would also send this spot via e-mail, the 

rule is ignored by CommCat so multiple e-mail messages are not 

sent.) 

DX Spot Manager 

Send Spot Destination: 

Pager 

When adding a new spot (Ctrl-S), send it to your pager. (Note: If 

you have set up a distribution rule in the DX Spot Manager 

window that would also send this spot to your pager, the rule is 

ignored by CommCat so only one page message is sent.) 

DX Spot Manager 

MyQSX 

Field You Provide Where Used 

Preferences   

Enable MyQSX Spots Use MyQSX.net as a source of DX spots DX Spot Manager, Band Spotter, 

Great Circle Map 

MyQSX Auto Update CommCat asks for new spots periodically, as set in DX Spot 

Manager List, above 

DX Spot Manager, Band Spotter, 

Great Circle Map 

Filter   

Spotter must be from Any continent or selected continent DX Spot Manager, Band Spotter, 

Great Circle Map 

All/CommCatLive 

spots 

Get all spots, or only those originating from CommCatLive users DX Spot Manager, Band Spotter, 

Great Circle Map 
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OH2AQ DX Summit 

 

Field You Provide Where Used 

Preferences   

Enable DX Summit 

Spots 

Use DX Summit as a source of DX spots DX Spot Manager, Band Spotter, 

Great Circle Map 

DX Summit Auto 

Update 

CommCat asks for new spots periodically, as set in DX Spot 

Manager List, above 

DX Spot Manager, Band Spotter, 

Great Circle Map 

URLs   

Custom Spots 50 HF: http://www.dxsummit.fi/DxSpots.aspx?count=50&range=2 

HF/CW: 
http://www.dxsummit.fi/DxSpots.aspx?count=50&range=500 

HF/Phone: 
http://www.dxsummit.fi/DxSpots.aspx?count=50&range=501 

50 VHF: http://www.dxsummit.fi/DxSpots.aspx?count=50&range=3 

VHF/CW: 

http://www.dxsummit.fi/DxSpots.aspx?count=50&range=502 

VHF/Phone: 

http://www.dxsummit.fi/DxSpots.aspx?count=50&range=503 

Most Wanted: http://www.dxsummit.fi/MostWantedSpots.aspx 

25 Plain Test (fastest download): http://www.dxsummit.fi/dx25.aspx 

DX Spot Manager, Band Spotter, 

Great Circle Map 

Announcements Announcements from DX Summit: 

http://www.dxsummit.fi/Announcements.aspx 

Tools, Web 

 



50 

 

Telnet 

Field You Provide Where Used 

Name "Friendly" name of the Telnet Site. Four Telnet sites are 

provided by CommCat. You can change any or all to sites of 

your choice. 

Telnet Window 

URL Actual URL to access Telnet server Telnet Window 

Port Telnet port of remote server, usually Port 23. Telnet Window 

Call Prompt The prompt used by the Telnet site to ask for your call, normally, 

"Please enter your call:". This prompt is used for automatic 

logon. 

Connecting to a Telnet site. 

SSID (advanced) ID Some Telnet connections require an 

SSID. 

Keepalive When checked, CommCat attempts to keep the Telnet 

connection active even though data is not being processed. If not 

checked, most Telnet sites will disconnect due to inactivity. 

Connecting to a Telnet site. 

Packet Cluster 

Field You Provide Where Used 

Model   

Model Select the TNC model you are using. Packet window; DX Spot window 

Port   

Port Select the Port through which your TNC is connected TNC control and data 

Advanced Change the default communications parameters for the selected 

TNC 

TNC control and data 

Commands   

Packet Node Call sign of the Packet Cluster node you wish to use. This call is 

only required if you wish to connect to the node--CommCat does 

not require that you be connected to monitor spots 

Packet window; DX Spot window 

Connect Command Command used to connect to the Packet Node Packet node communications 

Disconnect Command Command used to disconnect from the Packet node Packet node communications 

Get DX Command Retrieve a list of the most recently reported DX spots from the 

Packet node. You must be connected to the Packet for this to 

function 

Packet window; DX Spot window 

Show Users Command Display a list of stations currently connected to the Packet node Packet window 

Get WWV Command to get latest WWV reports Packet window 

Notes Place to include notes about the Packet node, such as frequency or 

location. 

Settings 

Command Mode   

Command Mode Ctrl-

C/Escape 

Select the character required to force your TNC to the command 

mode. 

Packet window 

Force Cmd when 

disconnect 

Check this option to force the TNC to go to the command mode 

when the Disconnect button is pressed 

Packet window 

Notes   

Notes (Logged Note added to the local spot. You can use this note to filter how DX Spot Manager 
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Contacts) the spot will be treated (color, for example) by any rules you have 

defined. 

DX Notify Popup 

Field You Provide Where Used 

DX Notify Popup   

Style Select the style of the popup window DX Spot Manager 

Transparency Select how much of the background behind the popup shows through DX Spot Manager 

Fade In/Out Does popup fade in and out, or simply tunr on and off. DX Spot Manager 

Test DX Popup See how the popup will look DX Spot Manager 

CommCatLive Settings 

See the CommCatLive Getting Started Help topic. 

Update 3/2009  

  

Getting_Started.htm
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Radio Connections and Settings 

Overview 

 CommCat controls radios through serial ports. Many radios require a level converter for proper 

operation. Up to 4 radios can be configured in CommCat. 

 Morse code Keying can be done through a serial or parallel port. A simple interface circuit is required 

(see below). The K1EL WinKeyer may also be used with Radio A. 

 The CommCat Spectrum Analyzer requires that audio from your radio be fed to the input of an audio 

card (Soundblaster) in your computer. 

 Optional PTT control of the radio can be done through a serial or parallel port. 

 Several radios have advanced settings to set preferences. 

Supported Radios 

CommCat works with a wide range of radios. A list of supported radios is provided below. New radios are 

added after tests have shown compatibility, so this list may not be complete. 

Yaesu FT100D, FT747GX, FT757GX, FT817, FT847, FT857, FT897, FT900, FT920, FT950, FT990, FT1000, 

FT1000D, FT1000mp, FT1000 Mark V, FT2000, FT-dx9000 

Kenwood TS440s, TS850, TS870, TS950, TS2000 

Icom IC706MKII, IC706MKIIg, IC718, IC725, IC735, IC746, IC746PRO, IC756, IC756PRO, IC756 PRO II, IC 756 

PRO III, IC775, IC781, IC7000, IC7400, IC7700, IC7800 

Elecraft K2, K3, K3 + Sub Receiver 

Collins KWM380 

Ten Tec Pegasus, Jupiter (both with support provided through program such as N4PY), Orion II, Orion III, Omni VI+ 

Alinco DX77 

Ham Radio 

Deluxe 

Use HRD to control your radio and CommCat to help chase DX, feeding frequency and mode data to HRD 

Flexradio PowerSDR Native 

Serial Communications 

Radios are controlled by CommCat through serial ports. (CommCat supports the Collins KWM-380 through a 

parallel port.) It is not possible at this time to control a radio directly through a USB port, so if your computer 

does not have an available serial port, a USB-to-serial adaptor is necessary. 

Any serial port from 1 through 10 can be used. Many radios have fixed communication parameters, in which 

case CommCat sets the necessary Baud rate, data bits, parity and stop bits. These parameters can be specified 

in the File, Settings, Radio/Ant window for those radios that are adjustable. When the communications 

parameters are adjustable, it is generally best to set the Baud rate as high as possible to improve 

communications and control performance. It may be necessary to reduce the Baud rate if communications are 

unreliable. 

Some radios require the addition of a level converter to adapt to RS-232 signal levels. Level converters are 

available from the rig's manufacturers or other suppliers for this purpose, or you can construct your own for a 

significant savings. Sample schematics are provided below. 
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Radio Timeout 

CommCat maintains a steady dialog with your radio. If the communications are interrupted for any reason--

perhaps you turned off your radio--CommCat attempts to re-establish communications for 10-20 seconds. If 

reconnection fails, a warning window is displayed asking if you wish CommCat to keep trying. If you don't 

respond, or you click No, further attempts to establish contact with your rig are halted. The radio will be 

reconnected if you restart the program, or you can force CommCat to try again by double-clicking the rig 

status pane in the bottom status bar. Rig timeout can be turned off in the File, Settings, Program window. 

Audio 

The CommCat Spectrum Analyzer receives its audio signal from your radio via the sound card in your 

computer. Many radios have a fixed-level audio output connection which is ideal for this application. 

If your radio only has a connection for an external speaker, it may be necessary to use this audio source. If this 

is the case, provisions may have to be made to feed an external speaker in addition to the sound card. The 

audio level will vary as you adjust the volume control on the radio, which will cause the Spectrum Analyzer 

display to vary. A slider audio level control is provided on the Spectrum Analyzer window so the display can 

be adjusted. 

 

If your radio has an external speaker jack, try inserting the audio plug into the audio jack far enough to pick up 

the audio signal, but not far enough to disable the internal speaker. 

Use the stereo sound card Line Input if your radio provides left (tip) and right (ring) channels corresponding to 

the main and sub VFO's. 

Open the Volume Control window for your sound system and make sure the Line Input mute check box is not 

checked and that the volume slider is in the upper half of its range. If you are using the microphone input, open 

the Recording Control window and make sure the Microphone input is enabled and that the level control is at 

least in mid-range. 

CW Keying 

CommCat provides CW keying through a dedicated connection in a serial or parallel port. The serial port can 

often be the same port used to control the radio. You may also use the K1EL Winkeyer with Radio A. 

For connection to the serial port, use the circuit shown below. The 4N33 opto-isolator provides electrical 

isolation from the computer to your radio. 
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Use the schematic below for connection to a parallel port. 

   

PTT 

PTT (Push To Talk) control from CommCat can be done through the data control stream, or through a 

dedicated connection in a serial or parallel port. The type of PTT control can be specified in the File, Settings, 

Radio/Ant window. Not all radios support PTT Control though the data stream. 

Special Considerations By Manufacturer 

Yaesu 

The 1000MP and later rigs have RS-232 ports which do not require a level converter. 

 

An advanced setting is available for the Yaesu rigs that allows you to set the port parameters and a preferred 

sideband for the CW mode. Open the Yaesu Advanced Rig Settings window from the File, Settings, Station, 

Radio/Ant window. Yaesu radios normally receive CW in the upper sideband (USB) mode. Select LSB to have 

CommCat use the LSB mode by default. 
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Icom 

Icom radios require additional settings. Each Icom radio is assigned a unique hex address, and for many 

models, it is possible for you to change this default assignment. Enter the actual address used by your radio in 

the Advanced Port Settings window. 

Some Icom interfaces require that the RTS or DTR lines on the port be held high. (The circuit below requires 

that DTR be held high.) If your interface requires that either or both lines be held high, check the appropriate 

box. Finally, some Icom radios, such as the 775, have a great deal of flexibility in their filter settings. The CW 

and SSB filter settings can be customized for radios that require it. 

The CI-V interface allows more than one Icom radio to be connected to a single serial port. CommCat 

normally prevents you from assigning more than one radio to the same serial port. When Icom radios are 

installed, CommCat alerts you when you assign more than one radio to the same port, but allows you to 

proceed. 

The CI-V Transceive and CI-V with IC-731 options in your Icom radio must be turned off. 

 

The IC7800 retains filter settings for each mode so the CommCat filter settings are disabled for this radio. 
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Icom Interface by G3VGR 

The Icom Interface shown below provides a simple way to connect your computer to an Icom radio. The 

resistors labeled 4k7 are 4700 ohm 1/8-watt resistors. This circuit uses the serial DTR line for power, so be 

sure to set the DTR High option in the Radio settings window. Dave, G3VGR, has given permission to include 

this circuit diagram in the CommCat manual. 

 

Kenwood 

Some Kenwood radios allow you to set the serial communications Baud rate higher than 4800. Click 

Advanced... on the Radios settings window to choose another Baud rate. 

Elecraft 

The Elecraft KI02 Aux I/O option and firmware 2.01 or higher are required for computer control of the K2. 

 

http://www.g3vgr.co.uk/
http://www.g3vgr.co.uk/
http://www.g3vgr.co.uk/
http://www.g3vgr.co.uk/
http://www.g3vgr.co.uk/
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Two advanced CommCat settings are provided for the K2. The advanced settings are reached by going to the 

File, Settings, Radio/Ant window and clicking Advanced. 

The first advanced setting controls your preferred filter choices for CW and SSB. The second provides a way 

to set a preferred sideband for CW operation. 

Four bandpass filters can be present in the K2. The CommCat Spectrum Analyzer window has buttons to select 

"wide" or "narrow" bandpasses. The filter setting has provisions for setting a preferred filter for CW narrow, 

CW wide, SSB narrow and SSB wide. 

The K2 receiver design uses lower sideband (LSB) in the CW receive mode for frequencies below 21MHz, 

and upper sideband (USB) at and above 21MHz. Use the CW Sideband setting to choose the K2 design, USB 

for all bands, or LSB for all bands. When you choose USB, the K2 will show the mode as CWr (CW reverse) 

on CW frequencies below 21 MHz. With LSB the K2 will show CWr on 21 MHz and above. If you wish to 

use the CommCat Spectrum Analyzer with the K2, many prefer to use USB since pile ups generally use "split 

up". 

Ten-Tec 

 

Some Ten-Tec radios use the same communications control as Icom radios. Check your manual to see if you 

can use your Ten-Tec radio with CommCat by selecting Icom. 

The Pegasus and Jupiter radios interface with CommCat through a third-party program, such as that provided 

by N4PY. Set the path to the control program in the Ten Tec Advanced Settings window. Start the control 

program before you start CommCat. 

The Orion II and Orion III are directly supported by CommCat. 

Collins KWM380 

The Collins KWM380 has limited control of operating frequency through the keypad port when that option has 

been added. The interface operates through a parallel port. CommCat uses LPT1: to control the KWM380. 

Parallel Connector KWM380 Keypad Connector 

2 1 

3 2 

4 3 

5 4 

6 5 

7 6 

8 7 

9 8 
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18-25 10 

In addition to the connections in the table above, the following loopback jumpers are also required on the 

computer end of the KWM380 control cable for Windows NT and XP computers: 

 1 to 13 (Strobe to select) 

 10 to 16 (ACK to INIT) 

 11 to 17 (BUSY to SLCTIN) 

 12 to 20 (PAPER END to GND) 

Selecting a Radio 

Three radios can be configured in CommCat. The radio you wish to be active is selected from the Rig toolbar 

or from the File menu. You may also turn off control to all radios by selecting Off. The hot keys Ctrl+F1 

through Ctrl+F3 can be used to enable a radio or use Ctrl+F5 to disable all radios. 

 

Radios that are not configured are dimmed in the toolbad and menu. 

To activate the Rig toolbar, right-click over the toolbar and select Rig. 

  

Updated 7/2008 
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Logs 

CommCat provides a flexible system for maintaining QSO logs. Information about contacts is maintained in 

logbooks. You can have as many logbooks as you wish. Perhaps you wish to keep a separate log for RTTY 

operation, or for QRP. It is easy to move contact records from one logbook to another and to switch from one 

logbook to another. Award data is kept for each logbook. 

Logbooks are kept in Master Logs. Master Logs are completely independent from each other. Master Logs are 

useful if more than one operator is using CommCat such as when several of your family members hold 

licenses. 

Each Master Log carries the call, name, and log preferences for the logbooks it contains. In addition, the path 

to the digital mode program MixW is kept separately. Separate logs are kept by MixW when it is installed in 

more than one folder. 

The only way to move contact data from one Master Log to another is through ADIF export and import. QSO 

records can be moved from one logbook to another within a Master Log by using Copy and Paste. 

Existing Master Logs are opened, or new Master Logs created, from the File menu. 

  

Updated 10/2007  
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Internet Connections 

CommCat uses a connection to the Internet for many of its functions. The following is a list of operations that 

require this connection: 

 

 Instant Web Page, including weather 

 Internet DX Cluster spot retrieval 

 Callsign lookup (if configured for an Internet source) 

 Time correction (if activated) 

 E-mail spot notification (if activated) 

 QSL template exchange 

 DX Spot Manager Rule Profile exchange 

CommCat can use any Internet connection ranging from dial-up, to a broadband connection that is 

continuously active. CommCat tests the Internet connection when it starts to see if an active connection is 

present. When CommCat determines that there is a net connection, the Net status light at the bottom of the 

main screen is green. 

See the CommCat Internet settings topic for information on the necessary settings. 

E-mail Technical Requirements 

CommCat uses SMTP (Simple Mail Transfer Protocol) and POP3 for all e-mail functions. If your Internet 

service does not send and receive mail using these protocols, the CommCat e-mail functions will not work. 

Configuring_CommCat.htm#Internet_Cluster
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(CommCatLive subcribers can use the MyQSX mail system, however.) Since AOL uses a proprietary system 

for mail exchange, AOL is not compatible with CommCat e-mail functions. 

  

Updated 10/2007  
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TNC Connections 

 

CommCat connects to a VHF/UHF Packet repeater through a radio and TNC (Terminal Node Controller). The 

TNC converts audio tones coming from the radio into data, and data into audio tones to be transmitted and 

PTT control for the transmitter. The TNC is connected to a serial port on your computer. 

See the CommCat Packet settings topic for more information on configuring CommCat to communicate with 

the TNC and your packet node. 

  

Updated 10/2007  

  

  

Configuring_CommCat.htm#Packet
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Antennas and Rotors 

Setting your preferences for antennas and rotors is easier than it may first appear. The CommCat Ant/Rotor 

setup provides a great deal of flexibility allowing you to define multiple antennas, specify what band they will 

be used on, and assigning rotors to rotatable antennas. Once you have specified your antennas, the direction of 

those that are rotatable can be controlled by CommCat, and the correct antenna can be automatically added to 

log entries. Antennas and rotors are specified in three steps, shown below. 

 

1. Specify Antennas 

 Enter a description for each antenna. This will normally be the manufacturer's model number, or a 

short description if home-built. Each antenna is thus assigned a number, such as "1" for the "TH 11 

DX" beam, above. 

 Check the band boxes where the antenna can be used. This is only used for your reference. Later, in 

step 2, you will specify your preferences for each band using the antenna numbers. 

 Enter direction offsets in the provided column. (If your beam points North when the rotor controller 

shows North, enter 0.) 

2. Specify Band Preferences 

 Specify the antenna you wish to use for Receive (R) and Transmit (T) on each band using the antenna 

number assigned above. The "TH 11" (antenna 1) is used on 20 through 10 Meters in the view above. 

3. Specify Rotors 

 Click the Model field in the Rotors grid to specify any rotors you are using. The list of supported 

rotors is accessed by clicking the down arrow on the right end of the Model field. Select the rotor you 

are using from the list. 
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Supported Rotors 

Idiom Press Rotor-EZ, RotorCard 

Hy Gain DCU-1 (Note: the DCU-1 does not send bearing info back to CommCat) 

M2, Inc. RC2800 

Yaesu SDX 

EA4TX ARSWIN 

Heath HD-1780 

 Enter the rotor number for assigned rotors in the Antennas Rotor No. field. The Rotor-EZ Rotor 

Controller is used with the "Roof" antenna in the view above. 

 Complete the rotor setup by specifying the remaining rotor parameters. 

  

Updated 10/2008  
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LPT Control  

CommCat can control external devices through a parallel port depending on band. The Top Ten Devices Six 

Way Antenna Relay Box is one device that can be used. 

 

To use this feature, select Top Ten in the Device list. Select the parallel port you wish to use. You can test the 

connections by clicking the Set Relay button after selecting a band. 

  

Updated 3/2009  
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Call Sign Lookup 

CommCat provides a number of ways to look up information about other stations. Information can be found 

from one of three commercially available CD-ROMs, the FCC database included with CommCat, or from the 

Internet. To add or change the Callbook settings, open the File, Settings, Station window and click the 

Callbook tab. 

 

CommCat allows two independent callbook sources to be used, one for United States calls and the other for all 

other calls. You may wish to use the FCC database for US calls and an Internet source for all others. 

CD-ROM Databases 

Three CD-ROM radio amateur databases are supported by CommCat. 

Radio Amateur Callbook (RAC) QRZ! HamCall 

PO. Box 2013 QRZ Order Department Buckmaster Publishing 

Lakewood, NJ 08701 1202 W. Vista Ave. 

Phoenix, AZ 85021 

Mineral, Virginia 23117 

The CD-ROM data can be used from a CD-ROM drive on your system, or, if you have sufficient hard disk 

space, from your hard disk. 

Moving the Call Sign Database to your Hard Drive 

Using the databases on a hard drive rather than a CD-ROM drive can provide much better performance, 

resulting in faster operation. The table below summarizes the requirements for using the data from one of the 

three supported CD-ROMs is this way. 
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CD-ROM Type Required Hard Disk Space Required CD-ROM Files CD-

ROM 

Folder 

HamCall 190 MB hamcall.dat, hamcall.idx, hamcall.cdx, 

hamcall.rdx 

\ham0 

QRZ! 80 MB callbkc.dat, callbkc.idx \callbk 

RAC 710 MB all files in CD-ROM \data directory \data 

Copy the required files from the CD-ROM folder listed in the table into a folder on your hard disk having the 

same name. For example, if you wish to install the RAC database on drive C:, create a new folder C:\data into 

which to move the files. Go to CommCat File, Settings, Station, Callbook to specify the drive you will be 

using. 

To copy a file or folder 

1. In My Computer or Windows Explorer, click the file or folder you want to copy. 

2. On the Edit menu, click Copy. 

3. Open the folder or disk where you want to put the copy. 

4. On the Edit menu, click Paste. 

To select more than one file or folder to copy, hold down the CTRL key, and then click the items you want. 

To select a folder in the left pane of Windows Explorer, click the folder. 

CommCat FCC Database 

The FCC publishes the amateur radio database which can be downloaded from the FCC site on the web. To be 

used with CommCat, this database must be located on your hard disk.  

The FCC updates the Amateur data using a partial database on a daily basis. The complete updated database is 

available from the FCC once per week. CommCat uses the complete database and is not able to use the daily 

partial updates. 

See the FCC Data topic in the Maintenance section of CommCat help for more information about downloading 

and keeping your database current. 

Internet Lookup  

CommCat can obtain call sign data from the MyQSX.net site or from QRZ.com. Both sources require that you 

subscribe to its respective service. To use one of these services you must also have an Internet connection. 

Choose the call sign lookup service you wish to use from the list on the CommCat File, Settings, Station, 

Callbook US or Intrernational window. 

To learn more about CommCatLive or the QRZ subscription service, see the CommCat or QRZ.com web site. 

When you select QRZ Subscription you must also enter the password provided by QRZ by clicking the 

Password button. 

 

FCC_Data.htm
http://www.commcat.com/
http://www.qrz.com/
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GoList for QSL Manager Lookup 

The GoList (http://www.golist.net) is a subscription service that provides weekly updates with current QSL 

manager information for DX stations. A sample GoList file has been provided by K1XN, and is found in the 

GoList folder on the CD-ROM. Enable GoList and set the path to the GoList database from the Files, Settings, 

Station, Callbook window. To use GoList, click Lookup on the Advanced Log toolbar. If one or more QSL 

Managers for the current DX call is found, you are asked to select the proper one. Click OK to have the DX 

QSL Manager's call added to the QSL Manager field for the current contact. 

  

Updated 5/2008 

  

  

   

  

http://www.golist.net/
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Pager 

 

Overview 

DX spots coming from the Internet or a Packet Cluster can trigger a number of forms of notification from 

CommCat. If you have a Numeric or Alphanumeric pager, DX spot announcements can be sent directly to your 

pager. 

CommCat supports Numeric and Alphanumeric pagers. Numeric pagers receive and display only numbers 

from 0 through 9, while alphanumeric pagers normally receive and display upper case ASCII text. 

Pages can be sent in one of three ways depending on the type of paging service you have. The most common 

and limited paging option is by telephone as if you had placed the call yourself and left a page message. 

CommCat dials your paging number, then sends a stream of digits that represent the frequency on which the 

spot is operating. This simple form of communicating with your pager has two disadvantages--only numbers 

can be sent, and CommCat has no way of knowing if your page was actually received by the paging service. 

Alphanumeric pages can be sent directly to your pager via a special telephone number provided by the paging 

service. This number is not the same as the number someone might use to send you a page using their 

telephone touch pad. In addition to the special telephone number, your paging service must provide several 

additional pieces of information that are required to complete the connection. The Baud rate in use and your 

pager PIN number are also needed. 

Many paging services also have the ability to accept alphanumeric pages as an email message sent to a special 

address. CommCat can use this route once you have provided the associated email address. 

If you use the same telephone modem for sending pages and for your connection to the Internet, CommCat has 

a paging option that checks the telephone connection to see if it is available for direct paging. If it is busy, 

CommCat then checks to see if you are connected to the Internet. If so, the page is sent as an email message. 

Alphanumeric pages are only sent for new information. Multiple pages are not sent by CommCat for spots that 

have the same call, frequency and time even though such spots may appear in the spot list. 

When DX spot announcements are received by the Web or through a Packet Cluster they are displayed on the 

DX Spot Manager window. As they arrive they are checked against the rules you have set up to see if any 

action is required. If you have specified that you wish to be notified through your pager, a pager message is 

constructed and held until the Minimum Time Between Pages timer releases it. If the page is being sent to a 

numeric pager, only the last DX spot is included in the message. 

For alphanumeric pages that are longer than your paging system accepts, the messages can be broken up into 

shorted message which are then sent sequentially. The Pager Settings window provides a place to enter the 

Maximum Number of Characters per Block. 

 Updated 10/2007  

Configuring_CommCat.htm#Pager
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Beacons 

Overview 

The Northern California DX Foundation has sponsored 18 CW beacons around the world. By monitoring these 

beacons it is possible to determine whether a band is currently open to the location of the beacon. 

CommCat provides the ability to monitor and identify beacon transmissions to help determine band conditions. 

Beacon transmissions are made on the 20, 18, 15, 12 and 10 meter amateur bands. Not all beacons are 

available on all bands, although time slots are provided for each of the 18 stations. Additional details 

describing the world-wide beacon system appear below (map provided by the NCDXC Foundation). 

 

The Tuner and Map windows provide beacon information and monitoring control. To tune the radio to the 

beacon frequency on one of the supported bands: 

 Open the Tuner window 

 Click Beacons 

 Click the beacon icon (triangle) in the band you wish to monitor 

Beacon Locations 

Use the Map window to display the location of all beacon stations. To display the beacon locations: 

 Open the Map window 

 Click Beacons 

Beacon locations are marked on the map by "+" symbols. If you are currently monitoring a beacon frequency 

(using the steps above), a line is drawn from your location to each beacon location as its turn comes. 
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The following information is taken directly from the Northern California DX Foundation web site at 

http://www.ncdxf.org 

Please visit their web site for the latest information about beacon status and schedules. 

NCDXF/IARU Beacon Transmission Schedule 

The table below gives the minute and second within each hour of the start of the first transmission of each of 

beacon on each frequency. Each CW transmission cycle is repeated every three minutes. A transmission 

consists of the call sign of the beacon sent at 22 words per minute followed by four one-second dashes. The 

call sign and the first dash are sent at 100 watts. The remaining dashes are sent at 10 watts, 1 watt and 0.1 

watts. 

The actual starting time of each transmission is approximately twenty milliseconds after the nominal time due 

to the keying delay of the transmitter. Equipment used at each beacon site includes a Kenwood TS-50S 

transmitter, a Cushcraft R-5 vertical antenna, a Trimble Navigation AcutimeÊ GPS receiver (recently updated 

and renamed the Palasade Ê) and a controller built by the NCDXF. For more information, see: 

The NCDXF/IARU International Beacon Network by John G. Troster and Robert S. Fabry, QST, October 1994 

pp. 31-33 and November 1994 pp. 49-51 

The NCDXF/IARU International Beacon Project by John G. Troster and Robert S. Fabry, QST, September 

1997 pp. 47-48 

or contact the Northern California DX Foundation, PO Box 1328, Los Altos, CA 94023-1328, USA. 

Latest Beacon News 

Slot DX Entity Call 14.100 18.110 21.150 24.930 28.200 Operator Status 

1 United Nations 4U1UN 00:00 00:10 00:20 00:30 00:40 UNRC OK 

2 Canada VE8AT  00:10 00:20 00:30 00:40 00:50 RAC OK 

3 United States W6WX  00:20 00:30 00:40 00:50 01:00 NCDXF OK 

4 Hawaii KH6WO 00:30 OFF 00:50 OFF 01:10 KH6BYU OK 

5 New Zealand ZL6B 00:40 00:50 01:00 01:10 01:20 NZART OK 

6 Australia VK6RBP 00:50 01:00 01:10 01:20 01:30 WIA  OK 

7 Japan JA2IGY 01:00 01:10 01:20 01:30 01:40 JARL OK 

8 Russia RR9O 01:10 01:20 01:30 01:40 01:50 SRR Off, being repaired 

9 Hong Kong VR2B 01:20 01:30 01:40 01:50 02:00 CRSA, HARTS OK 

10 Sri Lanka 4S7B 01:30 01:40 01:50 02:00 02:10 RSSL OK 

11 South Africa ZS6DN 01:40 01:50 02:00 02:10 02:20 ZS6DN OK 

12 Kenya 5Z4B 01:50 02:00 02:10 02:20 02:30 RSK OK 

13 Israel 4X6TU 02:00 02:10 02:20 02:30 02:40 IARC  OK 

14 Finland OH2B 02:10 02:20 02:30 02:40 02:50 SRAL OK 

15 Madeira CS3B 02:20 02:30 02:40 02:50 00:00 ARRM OK 

16 Argentina LU4AA  02:30 02:40 02:50 00:00 00:10 RCA OK 

17 Peru OA4B 02:40 02:50 00:00 00:10 00:20 RCP OK 

18 Venezuela YV5B 02:50 00:00 00:10 00:20 00:30 RCV OK 

 Updated 10/2007  

table.html
http://www.kenwood.net/products/index.cfm?AMA=open&ama_bstat=open&radio=TS-50S&selection=Amateur
http://www.cushcraft.com/
http://www.trimble.com/
http://www.trimble.com/products/pd_ts.htm
http://www.iaru.org/articles/
http://www.iaru.org/articles/
http://www.iaru.org/articles/
http://www.iaru.org/articles/
http://www.ncdxf.org/Beacon/BeaconSchedule.html#News
http://narc.net/
http://www.rac.ca/
http://www.ginner.com/
http://www.ncdxf.org/index.htm
http://www.nzart.org.nz/nzart
http://www.omen.net.au/~vk6wia/bhf-bcn.html
http://www.wia.org.au/
http://www.jarl.or.jp/
http://ra3apw.demos.su/srr
http://www.crsa.org.cn/
http://www.harts.org.hk/
http://www.qsl.net/rssl/
http://www.qsl.net/rssl/
http://www.iarc.org/
http://www.sral.fi/indexeng.htm
http://www.lu4aa.org/
http://www.inkanet.com.pe/oa4o/
http://www.qsl.net/yv5aj


72 

 

Focus DX Call 

The Focus DX Call is the call sign that CommCat uses as a default call. Many windows, such as the Instant 

Web Page, use the Focus DX Call to create a view. Other windows, such as the Log window, are preloaded 

with the Focus DX Call automatically to facilitate special functions, such as logging. The Focus DX Call is 

displayed in the caption bar of the main CommCat window. 

 

In general, the Focus DX Call is the call sign of the most recent station to which CommCat was instructed to 

tune. 

There are a number of ways to establish the current DX Call. 

 Double-click a spot in the DX Spot Manager window 

 Look up a call in the Advanced Log window 

 Log a new contact 

 Open an Instant Web Page by specifying a new DX Call 

 Tune the radio from the Packet Cluster window 

 Tune the radio from the Internet Cluster window 

 Tune the radio to a new spot by double-clicking a spot on the Spectrum Analyzer window 

 Tune the radio to a new spot by double-clicking a spot on the World Map window 

 Tune the radio to a new spot by double-clicking a spot on the Band Spotter window. 

  

Updated 10/2007  
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Entity Identification  

Each Entity is assigned a unique number by CommCat called the DXCC Number. This number, rather than the 

name of the entity, is used by the program to find information about entities including award status. 

The DXCC Numbers come from the Amateur Data Interchange Format (ADIF) specification which is used by 

many logging programs as a means for exchanging data. DXCC Numbers are assigned below 1000. Numbers 

above 1000 can be assigned for use by CommCat when a new entity is not found in the list. 

CommCat uses the DXCC Number that is listed in the Entity Grid. The Entity Grid is opened from File, 

Maintenance, Entity, Entity Grid. In the view below, Abu Ail (not an active entity) has the unique DXCC 

Number of 2. 

 

To edit the information for any entity, double-click the entity of interest. 

 

To change the order the data are displayed, click the header of the data you wish to use as the order. For 

example, to see the entity list in order by DXCC Number, click the DXCC header. 
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If you find that the award summaries reported by CommCat are incorrect, the first place to look is the DXCC 

Number in the Entity List or the log. 

  

Updated 10/2007 
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Keyboard Shortcut Reference 

Window control 

Alt + K Morse Code Window 

Ctrl + E CW Message Settings 

F12 Advanced Log 

Ctrl + F12 Quick Log 

Shift + F12 Spectrum Analyzer 

Ctrl + S Send DX Spot Announcement 

Rig and Rotor control 

Ctrl + F1 Enable Rig A 

Ctrl + F2 Enable Rig B 

Ctrl + F3 Enable Rig C 

Ctrl + F5 Enable Rig D 

Ctrl + F6 Disable all radios 

F11 Rotor Go Short Path 

Ctrl + F11 Rotor Go Long Path 

Alt + F11 Rotor Stop 

CW Messages 

Esc Stop outgoing code and flush type-ahead buffer 

Alt + F9 Message normal speed slower by 2 WPM 

Alt + F10 Message normal speed faster by 2 WPM 

F1 CW Message 1 or Help 

F2 - F10 CW Messages (normal Speed) 

Shift F2 - F10 CW Messages (high speed) 

Ctrl + E Display CW Message Settings 

Editing 

Ctrl + C Copy 

Ctrl + V Paste 

Ctrl + X Cut 

Ctrl + A Select All 

Ctrl + Z Undo 

Ctrl + F Find 

Log 

F12 Advanced Log 
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Ctrl + F12 Quick Log 

Ctrl + N New Log 

Ctrl + O Open Log 

Alt + C Select call in Call text box 

Space Find matching calls in log (Adv Log) 

Shift + Space Find matching entities in log (Adv Log) 

Ctrl + Space Find matching calls in log for current band and mode 

(Adv Log) 

Alt + Space Fond matching entities in log for current band and mode 

(Adv Log) 

Enter Enter current contact into log (can be used for lookup in 

Advanced Log depending on settings) 

Ctrl + Enter Saves the current time as the start time for a QSO. This 

allows you to fill in the blanks for a QSO while 

preserving the correct start time. 

Shift + Enter Enter ending time and date to the contact selected in the 

detail grid (Advanced Log) 

Tuning via Keyboard 

 10 KHz 1 KHz 100 Hz 10 Hz 

VFO A UP Shift + Right Arrow Right Arrow Shift + Plus Key Plus Key 

VFO A DOWN Shift + Left Arrow Left Arrow Shift + Minus Key Minus Key 

VFO B UP Ctrl + Shift + Right 

Arrow 

Ctrl + Right 

Arrow 

Ctrl + Shift + Plus Key Ctrl + Plus 

Key 

VFO B DOWN Ctrl + Shift + Left 

Arrow 

Ctrl + Left 

Arrow 

Ctrl + Shift + Minus 

Key 

Ctrl + 

Minus Key 

Ctrl + PgDn VFO A receives 

Ctrl + PgUp VFO B receives 

Ctrl + End End Split Operation 

Ctrl + Home Set VFO B = VFO A, Split mode 

  

Updated 10/2007  
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Getting Help 

CommCat provides help in a number of formats. Many of these formats can be customized to suit your 

personal preferences. 

Main Help 

Additional help is available for most windows through the Windows help system. The Help window associated 

with a window can be opened in several ways: 

 Press the F1 key if you have configured CommCat to provide help when the F1 key is pressed (rather 

than send CW Message 1). 

 Use the Help Menu. Menu selections are provided for opening the context Help, Search and Index 

views of the Help window. Press Alt-H to open the Help menu. 

  

What's This? Help 

Some CommCat windows have context sensitive What's This? help available for each control on the the 

window. 

 If the What's This? button appears on the window's title bar: 

 Click the What's This? button. The mouse pointer changes to a question mark. 

 Position the mouse pointer over any control in the window 

 Click the left mouse button 

 When you have finished reviewing the help for that control, click anywhere else on the window or 

press the Escape key to close the What's This? help pane. 

Tool Tips 

With Tool Tips enabled (File, Settings, Program, Help), when you move the Mouse pointer over a control or 

field, a brief help message is displayed. 

CommCat Technical Support 

Help is available online by email for problems you may encounter while using CommCat. Telephone support 
is not available. 

If you wish to send email, use the address support@commcat.com. 

CommCat Forum 

The CommCat Forum is located on the MyQSX web site at http://www.myqsx.net/forums. 

  

Updated 3/2009  
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CommCat Voice 

See Also: Voice Settings 

CommCat Voice adds text-to-speech features to CommCat. CommCat Voice uses the Microsoft Speech 

Engine to convert text to synthesized speech. This engine is provided with Windows XP and later. If you are 

using Windows 98 or later, you can easily check to see if the speech engine is present on your system. If not, it 

can be downloaded and installed from the CommCat web site and installed. If you are using CommCat Gold, 

the necessary software is supplied on the CD in the Voice folder. 

Text-to-speech (TTS) is the ability of the operating system to play back printed text as spoken words. An 

internal driver, called a TTS engine, recognizes the text and using a synthesized voice chosen from several pre-

generated voices, speaks the written text. A TTS engine is installed with the XP operating system. 

CommCat provides the following TTS options: 

 Programmable greeting when CommCat starts 

 Time announcement, UTC or local 

 Window caption as the CommCat window focus changes 

 Navigation announcements for the Advanced Log and DX Spot Manager 

 Instant Web Page lookup 

 Dialog box messages (major) 

 Rig status (frequency, split frequency, and mode) 

 Rotor set bearing and get bearing 

 DX Spot Manager spot announcements from Rules 

 Contents of the CommCat Clipboard 

Determining if Speech is Installed 

The options on the File, Settings, Program, Voice window are disabled if CommCat does not find the speech 

engine. 

Open Control Panel 

If present, click the Speech icon and then the Text-to-Speech tab. 

If Speech is installed you can test Text-to-Speech by clicking Preview Voice. 

Installing TTS 

If you are using Windows 98 or later, and TTS is not installed on your system, the installation file can be 

downloaded from the CommCat web site: 

http://www.commcat.com/files/CommCatVoice.msi 

Download this file to a convenient folder and double-click to start installation. Once TTS is installed, go to 

Control Panel and set the properties for Text-to-Speech. 

Configuring_CommCat.htm#Voice
http://www.commcat.com/files/CommCatVoice.msi
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You can also install CommCat Voice from the CD if you are using the Gold Version. CommCatVoice.msi is 

located in the Voice folder. 

CommCat Voice Settings 

Open the CommCat Voice settings window from File, Settings, Program. 

 

Control Name Function 

DX Spot Manager Summarize each spot as the focus changes from one spot to another. The call, band, entity, 

and note are announced. 

DX Spot Manager Actions Spots satisfying Conditions set by Rules in the DX Spot Manager can cause Actions, 

including a voice announcement of a spot. CommCat Spot announcements can be created 

with TTS rather than the built-in voice announcements. 

Instant Web Page CommCat reads the Instant Web Page created for any call sign. When a call is entered in 

the search text box, CommCat reads the call sign characters as they are typed. 

Advanced Log CommCat reads the contents of the call text box and the field names in the data entry pane, 

and reads the most significant details of each log entry when a new contact is selected in 

the QSO list. 

Dialog Boxes CommCat reads the contents of the main dialog boxes and states what options are available. 

Hour Time announced on the hour 

1/2-Hour Time announced every half hour 

UTC Time is announced using Universal Coordinated Time 

Local Time is announced using local time 

Rig Status Rig status, including frequency, mode, and split frequency when in split mode, is 

announced when there are changes 

Get Bearing The desired bearing is announced when CommCat sends a rotate command to the rotor 

Set Bearing The current rotor bearing is announced as there are changes. 

Program Greeting As CommCat starts this greeting is read. Change the text to any greeting you wish. Test the 
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greeting by clicking Preview. When the Greeting is blank, no greeting will be used. 

Halting Voice Announcements 

A current voice announcement can be stopped by pressing the Escape key. Voice announcements are also 

stopped any time CommCat Hold is active, such as when sending CW. 

Updated 10/2007  
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DX Spot Manager Window 

 

Overview 

The DX Spot Manager is the primary CommCat window for monitoring and analyzing DX Spots. The spots in 

the list can originate from a VHF/UHF Packet Cluster, Web Cluster, an Internet Telnet site, or from spots you 

create in CommCat. 

DX Spots provide a way to monitor DX activity and band conditions. It is also possible to track the operation 

of specific DX stations. By analyzing a DX station's operating habits over time, it is often possible to second 

guess when and where they may appear next. 

The spot list shown above lists incoming spots in the order they were received. CommCat provides many spot 

order options in addition to the order they are received. The information provided for each spot in the list 

includes the DX call, frequency, call of the reporting station, time, spot priority, date and day of the week, 

short notes the reporting station has added, the DX Bearing, continent, and grid square. 
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The DX Spot Manager window is divided into two panes. The right pane contains a spreadsheet showing 

detailed information for each spot. The left pane contains a sidebar that provides a number of useful tools that 

provide further information about spots, spot filtering, and operating aids. 

Spots arrive first in the Inbox folder where they can then be redirected through the use of rules to other folders. 

This operation is similar to mail sorting in Microsoft Outlook Express. 

Rules which test conditions and take action on incoming spots can be specified.. Each rule contains one or 

more conditions and one or more actions. CommCat provides extensive sets of conditions and actions that 

provide much flexibility in how spots are processed, redirected, and used to notify you. Here are a few 

examples: 

 Play a tone whenever a spot for 3Y0C is received. 

 Move spots that contain "psk" in their note to a "PSK" folder. 

 Delete all spots for 160 Meters. 

 Shade spots that are more than 30 minutes old. 

 Beep your pager when P5/4L4FN is reported on 20 CW. 

 Send all CW spots to a dedicated CW folder. 

  

DX Spot Manager Spot Details 

 

The details for selected spots appear in the Spot Detail portion of the DX Spot Manager window. In the sample 

above, TN6X has been reported on 14.025.30 MHz, 9 minutes ago. From the note supplied by K5SWW, we 

can see that TN6X's name is Baldur. This spot was received through a Web cluster and it was reported at 2035 

UTC. CommCat has determined the DXCC entity to be Congo at a bearing of 59 degrees short path and 239 

degrees long path. It is 21:44 local time in the Congo. 

DX Spot Manager Sidebar 

Display or hide the DX Spot Manager Sidebar by clicking the Sidebar button on the menu bar. You can also 

hide the sidebar by clicking the X in the upper right corner of the sidebar panel. 

Different panels are opened by clicking their icon at the bottom of the sidebar. To show more icons, drag the 

dotted handle at the bottom of the sidebar up. You can remove and add panels to the sidebar by clicking the 

configure button on the right side of the icon bar at the bottom of the sidebar as shown below. 
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Spot Filters 

Several of the panels filter spots. The filtered spot list is also used by the Band Spotter window. The Quick 

Filter button in the DX Spot Manager menu bar must be engaged for the filtering to work. The panels that 

perform filtering are: 

 Bands and Modes 

 Continent 

 DX Bearing 

 Award 

 Watch 

Spot Info 

To display the Spot Info panel, click the Info icon in the panel list. 

 

Click a spot in the spot list to display the Spot Info for that call. 

The Spot Info panel has 5 tabs to display different information. 
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Info The call, name, QTH, spot details, rule used to color the spot, and worked status are shown. 

Bio The bio for the selected call is collected from your Callbook source, including any photos. 

Spots A list of the recent spots for this call. 

Bands A graph of activity for this call by band and mode. 

Dates A calendar showing the dates this call has been spotted and the number of spots each day, plus the bands and modes 

for the spots. (Move the mouse pointer over a date to reveal the spot totals.) 
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Spot Folders 

 

To display the DX Spot Manager Folders panel, click the folder icon in the sidebar list. 

The Spot Folders are used to sort incoming spots into categories. DX Spot Manager Rules can be used to 

automatically move spots from the Inbox to another folder, or you can drag-and-drop a spot from the spot list 

directly to a folder. 

CommCat provides a set of folders to get you started. You can add folders to meet your own needs, and, with a 

few exceptions, folders can be removed when no longer needed. The DX Spot Manager, Spot Folders, and 

Inbox folders are permanent and cannot be removed. Instructions for folder management are provided below. 

As spots arrive, a spot counter keeps track of the number of new spots. The counter for each folder gives you 

the count of new spots received in the last update cycle, Three new spots have arrived in the Inbox folder. 

Click the folder name or double-click a spot to reset its spot counter. 

The sidebar and DX Spot Manager folder list can be hidden from view. To do so, click Sidebar in the toolbar 

View, Layout menu so that option is not checked or click the X in the upper roght corner of the Folder pane. 

To re-display the folder list, check the Sidebar option in the View, Layout menu. 

You can move through the folder list using the Next Folder and Previous Folder options in the View menu. If 

you wish to limit the folders you will visit with the Next and Previous selections, open the Folder Preferences 

window from the View menu where you can choose which folders you want included. Use the Go to Folder 

View menu option to go directly to a folder. 
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Bands and Modes 

To open the Bands and Modes panel, click the Microphone icon. 

The Bands and Modes panel provides a quick way to filter spots in the spot list. The Quick Filter option in the 

DX Spot Manager menu bar must be selected for the filtering to be applied. 

 

Click a Band button to show spots for that band. To add bands to those previously selected, use Ctrl+Click. 

The buttons below the band buttons operate on groups of bands. Follow Rig displays spots on the band on 

which the rig is tuned. AutoTune can be selected so the radio is tuned with a single click. The Sequence button 
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shows spots band-by-band when you have selected more than one band. Each band is shown for approximately 

seconds. 

Click the Modes tab to show the mode filters. Click a mode button to add a mode filter to the band filter. To 

show more than one mode, use Ctrl+Click. 

To reset all filters, right-click over the Bands or Mode panels and select Reset All Filters. You can also turn off 

all filters by clicking the Quick Filter button in the DX Spot Manager menu bar. 

Continent 

To open the Continent filter panel, click the World icon. 

The Continent filter adds filtering to any choices you have made on other panels. 

 

Click a Continent button to display DX spots from that continent. To select more than one continent, use 

Ctrl+Click. In the panel above, EU (Europe) has been slected. The button colors are a key to the world map, 

they do not result in the color for a spot being changed. 

You can also filter spots by the continent of the Spotter. Click the Spotter tab to display the continent choices, 

and click a continent button to show spots whose spotters are from that continent. To select more than one 

continent, use Ctrl+Click. 

The Sequence button can be used to cycle through the selected contients when you have selected more than 

one. Each continent is show for approximately 5 seconds. 
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DX Bearing 

To open the DX Bearing filter, click the compass icon in the panel list. 

The DX Bearing filter adds filtering to any choices you have made on other panels. 

 

Click a DX Bearing button to view spots for DX at that bearing. To select more than one bearing, use 

Ctrl+Click. To rotate you beam to the selected bearing, click the button below the bearing buttons. 

Awards 

To open the Awards filter, click the cup icon in the panel list. 

The Awards filter adds filtering to any choices you have made on other panels. 
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The Awards filter provides a quick way to look for spots that will satisfy a need you have for a prticular award. 

The available awards are DXCC, WPX, WAZ, IOTA, WAS and County. The Mixed button is selected above, 

so any spots that would qualify for a needed DXCC entity, mixed mode, will appear in the spot list. 

Only one award can be selected as a filter at one time. 

The Prefilter group indicates the status of the Band/Mode, Continent, and Bearing filters. If one of the 

prefilters is in use, a dot shows next to the respecitve filter in the list. 

Watch 

To open the Watch panel, click the "watch dog" icon in the panel list. 

The Watch panel can be used to filter spots in the spot list, or to watch for a specific spot. 
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The filter mode for the Award panel is shown above. The letter W has been entered, so all spots starting with 

W are shown. 

The Watch mode responds with a selected response when a spot matches the entered letters. Select a Popup, 

email, or audio alert. 

Convert 

The Convert panel is an operating aid. It allows you to easily convert between different unit systems, such as 

meters to feet. 

Open the Convert panel by clicking the geometric icon in the panel list. 
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The image above shows that 20 meters is equal to 65.6 feet. Click the up and down arrow buttons to the right 

of the units window to select the starting units. Enter the value you wish to convert in the value box. 

ID Timer 

The ID Timer is an operating aid. It provides an alarm to remind you to ID your station in a long QSO. 

Open the ID Timer panel by clicking the alarm clock icon in the panel list. 
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The timer is preset to 9 minutes 30 seconds. Click Start to initiate the timer. When the time reaches 0, the 

alarm is activated. The alarm can flash the clock display, display a popup alert, or sound a tone. As the timer 

goes negative (indicating the time has exceeded 9 minutes 30 seconds), the timer display changes to red. 

Notes 

The Notes panel is an operating aid. Enter any notes on the panel regarding information you wish to preserve. 

The Notes panel is also available form the Advanced Log. 

Open the Notes panel by clicking the note icon on the panel list. 
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Drag a spot from the spot list, or a QSO from the Advanced Log to include that info in the Note. 

  

Sticky Spots 

Spots older than 30-60 minutes are often out-of-date. Perhaps the band conditions have changed, the DX 

station has ceased operation, or she has moved to another frequency or band. For this reason, CommCat 

provides an adjustable expiration time for incoming spots. Spots that are older than this time limit are deleted 

from the spot list the next time the list is refreshed. 

There are situations, however, where you may find it desirable to retain spots indefinitely. Spots you wish to 

retain can be made "sticky" so they are not deleted once they are older than the time limit. Sticky spots can be 

used for: 

 Tracking DX stations to determine their operating habits. 

 Retaining frequencies of interest, such as broadcast stations or nets. 

 Identifying band edges for use as a tuning aid in the Spectrum Analyzer and Band Spotter windows. 

There are several ways to make a spot sticky. To create a sticky spot automatically, create a Rule that has a 

"sticky" action. To set a sticky spot manually, right click over any selected spot in the spot list and click the 

Sticky menu option, or click the Sticky check box for that spot. Finally, you can drag-and-drop spots from any 

folder to the DX Tracker or Band Edges folders which are permanently sticky. 
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Prioritizing Spots 

The spot priority can be set automatically or manually. CommCat DX Spot Manager Rules can contain an 

Action that can set the priority of a spot. Priorities of 0 (lowest/no priority) to 10 (highest priority) can be set. 

To set the priority manually, right click over the selected spot and choose Set Priority... from the menu. The Pr 

column in the DX Spot List shows the priority that has been assigned to each spot. 

 

To sort the spot list in priority order, click the label at the top of the Priority column, labeled Pr. The spots are 

shown from highest to lowest priority. Click Pr again to show the spots in low to high priority order. 
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The spot priority is used in the Band Spotter window to determine the order in which spots are painted. Higher 

priority spots are painted last and appear on top of earlier spots. If a frequency is occupied by more than one 

spot, the spot with the highest priority shows. 

Displaying Spots in Other Windows 

In addition to the DX Spot Manager spreadsheet, spots processed by the DX Spot Manager appear in three 

other windows. 

 The Great Circle Map window displays spots with radials from your location to the DX location. 

 The Spectrum Analyzer window displays spots that show the reported spot frequency on the spectrum 

display. 

 The Band Spotter window shows spots-vs-frequency in an adjustable bandwidth centered on your 

operating frequency. Select a folder in the DX Spot Manager to show the spots in that folder in the 

Band Spotter. 

The color of the spots is determined by color actions you have defined in DX Spot Manager rules. Only spots 

in the Inbox folder or a child of the Inbox folder are shown on the Great Circle Map. These spots, as well as 

spots in the Band Edge folder, are shown on the Spectrum Analyzer and Band Spotter. 

The Advanced Log window lists all previous contacts for the selected spot. If you have worked a station on the 

current band and mode, the selection bar in the Log window is painted in light red to alert you about a possible 

duplicate contact. There is also an option to sound a tone alarm when a possible dupe is found. 

Tuning to a Spot Frequency 

Double-click any spot in the spot list to tune your radio to the spot frequency. This action set the Focus DX 

call and enters the DX call into the Log window. If CommCat determines that the DX station is operating split 

(by analyzing the note for that spot), the split frequency is also set. The Space Bar can be used in place of 

double-clicking a selected spot to set the frequency. 

When the AutoTune check box (Files, Settings, Spots) is checked, the radio is tuned to the spot frequency 

whenever the selected spot in the spot list changes. Autotuning is convenient when you wish to scroll through 

the spot list using the arrow keys with the radio automatically tuning to the spot frequency. 

You can also right-click any spot and choose Tune from the menu to tune to the spot frequency. 

To prevent the radio from being tuned, but allow all other functions to operate when a spot is selected, hold the 

Ctrl and Alt keys down while double-clicking a spot. This operation allows you to check the status of spots 

while monitoring a specific frequency. 

Finally, you can define a rule that contains a "tune radio to spot" action. 

Configuring_CommCat.htm#Logging
Configuring_CommCat.htm#Spots
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Instant Web Page for spots 

Click a call in the DX Call cloumn to open the Instant Web Page for that call. Click a call in the From column 

to open the Instant Web Page for the spotter. This option is enabled in File, Settings, Spots Settings, DX Spot 

Manager, Call Lookup. Underlines can be applied or hidden for the calls in the two columns by using the 

check box in File, Settings, Spots, DX Spot Manager, Grid Options. 

If you use the DXpedition Condition in a Rule to highlight spots that represent a DXpedition, click the DX 

Call for the spot to view the DX Bulletin information for that spot in the Instant Web Page (CommCatLive 

only). 

Special Folders 

CommCat treats several spot folders in special ways. These special folders are permanent folders which cannot 

be deleted or renamed. Any number of child folders can be added to these special permanent folders. The 

special folders are described below. 

Inbox 

All spots pass through the Inbox folder and remain there in the absence of any rule actions that could move or 

delete them. Spots in the Inbox (or in any Inbox child folder that you add) are displayed in the Great Circle 

Map, Spectrum Analyzer, and Band Spotter windows. 

Band Edges 

Spots can be moved to any Band Edge folder using a Rule action, or dragged from any folder. Spots that are 

dragged are automatically made sticky. Band Edge spots are displayed on the Spectrum Analyzer and Band 

Spotter windows as a tuning aid. 

It is easiest to create a band edge spot when you have set up CommCat to allow local spots to be entered. This 

option is enabled from the File, Settings, Spots window. In the Local Spot Destination group, check Spot 

Manager. Spot announcements, including local spots, are created from any window by pressing Ctrl+S. In the 

call box type a short description, such as 20 CW LOW. Enter 14.000.00 in the frequency box, and press Enter. 

The new Band Edge spot is sent to the DX Spot Manager. From there you can drag the spot to the 20M Band 

Edge folder. 

Spectrum Analyzer Band Edge Band Spotter Band Edge 
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DX Tracker 

The DX Tracker folder is normally used to hold spots for DX stations you are tracking. Spots can be sent to the 

DX Tracker folder (or any DX Tracker child folder you add) with a rule action, or dragged and dropped from 

any other folder. When you drag a spot to a DX Tracker folder, the spot is made sticky. 

Deleted Spots 

The Deleted Spots folder holds spots that have been deleted. The sticky property of a spot is removed when a 

spot is deleted, so that all deleted spots are removed from the Deleted Spots folder the next time the spot list is 

refreshed. Spots can be deleted from a folder manually or automatically. 

To delete a spot, select it in the spot list and press the Del key, or choose Delete Spot from the right mouse 

menu. Except for the special folders, entire folders can be deleted with their contents ending up in the Deleted 

Spots folder. Spots can be deleted automatically by creating a Rule with a Delete Spot action. 

Folder Status 

As new spots are added to folders, the number of spots added since the folder was last viewed is updated and 

added to the folder name. If a spot is added to a folder that isn't visible because that particular branch is 

collapsed, the branch is expanded to give you a view of activity. When you open the folder for viewing, the 

spot number is reset. This feature provides a way for you to review spot activity while you have been away 

from your computer. Click the Spot Folder folder so that no spots numbers are showing. As spots arrive, 

activity is immediately apparent by observing the spot numbers on each folder. 

Important: You must have at least one Rule assigned for the folder spot numbers to appear. See below. 

Telnet Spots 

Through an Internet Telnet connection, CommCat can tap into a continuous flow of spots. There are many 

Telnet spot servers throughout the world. It is possible to find sites that cater to local geographic areas or 

special modes. 

To establish a Telnet connection, double-click the Telnet status panel in the CommCat status bar, or open the 

Telnet window from the Tools menu. Once a connection is established you can close the Telnet window and 

spots continue to flow to the DX Spot Manager. 

To view the incoming Telnet data within the DX Spot Manager window, drag the colored bars at the bottom of 

the DX Spot grid up. 

Web Cluster 

DX Summit is a popular web site that provides continuously updated DX spots. The spots originate from other 

sites which feed DX Summit, or from individual users entering spots through the Internet. In addition to spots, 

DX Summit provides announcements which are short notes or comments from other hams. 

CommCat provides a number of ways to request spots. Click the down arrow next to the Web Spots button on 

the DX Spot Manager toolbar to see the list of possibilities. For example, click the HF item to ask for spots 

that are from the HF bands, including Phone and CW spots. The Custom Setting is a URL you can enter in the 

File, Settings, Spots, DX Summit, URLs window. 
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The selection you make from the list is used for Auto Updates and when you click the Web Spots button on the 

toolbar. 

 

Spots can be updated automatically or manually. The number of minutes since the last update is displayed in 

the status bar at the bottom of the DX Spot Manager window. 

To update the spot list manually, click the Web Spots button on the DX Spot Manager toolbar. To have the 

spots updated automatically on a periodic basis, put a check in the DX Summit Auto Update box in the File, 

Settings, Spots, DX Summit, Preferences window. The number of minutes between updates (Spot Update 

Interval) is set in the DX Spot Manager, List window. 

As spot requests are sent to DX Summit, the connection status is displayed in the bottom status bar on the DX 

Spot Manager window. If you wish to stop a data retrieval cycle, click the Stop button next to the Web Spots 

button on the DX Spot Manager toolbar. 

More complete interaction with DX Summit can be achieved through the Internet Cluster window, accessible 

on the CommCat Tools menu. It is not necessary to have the Web Cluster window open to receive spots. 

To view the raw incoming Web Cluster data within the DX Spot Manager window, enable the Incoming Data 

option in the DX Spot Manager View, Layout menu. Drag the colored bar up at the bottom of the DX Spot 

Grid. 

Configuring_CommCat.htm#Spots
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Packet Spots 

VHF or UHF repeaters that are designed to provide spots through packet protocol are called Packet Clusters. 

Packet clusters generally serve a limited geographic area, but are often linked to other nearby Packet Cluster 

repeaters providing a network than can cover one or more states. The parameters necessary to connect to a 

Packet Cluster repeater are located on the Packet Cluster tab of the File, Settings, Spots window. 

For CommCat to receive spots from a Packet Cluster, you must have a VHF or UHF radio and a TNC 

(Terminal Node Controller). CommCat processes spots as they are received from the Packet Cluster. 

More complete interaction with the Packet Cluster can be achieved through the Packet Cluster window, 

accessible on the Tools menu. It is not necessary to have the Packet window open to receive spots in the DX 

Spot Manager window. 

To view the raw incoming Packet data within the DX Spot Manager window, enable Incoming Data in the 

View menu, and drag the colored bars up at the bottom of the DX Spot Grid. 

Sending a Command to the Telnet Site or Packet Node 

Press Ctrl+X to open the Send window. Special commands, such as SH/DX, can be sent to the Telnet site or 

Packet Node by entering them in the text box and clicking OK. You must be connected to a Telnet site or 

Packet Node. 

Customizing the DX Spot Manager Window 

View 

Use the View, Layout menu to customize which information panels will appear on the DX Spot Manager 

window. The following options are provided: 

 Status Bar 

 Folder List 

 Incoming Data 

 Bottom Status Bar 

Configuring_CommCat.htm#Packet
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Each of the three information panels can be shown or hidden by checking or unchecking the menu item. 

Three incoming data panels, showing raw Web, Telnet and Packet can be opened below the spot grid. To close 

or open any of the data panels, start by diabling or enabling the Incoming Data option in the View menu. 

Customize the Status Bar 

Four DX Spot Manager status bar styles are available from the View, Status Style sub menu: 

KL7 Winter 

 

KC4 Summer 

 

LCD 
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Map 

 

You can reverse the position of the spot timer and bearing readouts in the status bar by clicking the Reverse 

Time/Bearing Positions menu item. See below for how the bar looks with these items reversed. 

 

Panel Size 

The size of the DX Spot Manager window and the width of the Folder panel can be changed by dragging the 

associated window or panel border. When the width of the spot list is less than the grid, a horizontal scroll bar 

allows you to scroll the spot list. In addition, the spot list can be split, allowing you to view two portions of the 

spot list. To split the spot list grid, drag the split box that appears on the left end of the horizontal scroll bar. 

Column Width  

The width of any spot list column can be adjusted by dragging the associated separator line in the spot list 

header. 

Column Position 

The order of columns in the DX Spot Manager list can be changed to suit your preferences. To move one or 

more columns, right-click over the grid and choose Move Columns from the menu. Select the column or 

columns you wish to move by clicking their headers. Drag the header of the selected column to its new 

position. To exit the Move Column mode, right-click the mouse over the grid and choose Move Menu to 

remove the check mark. 

Spot List Background and Foreground Colors 

Normally the Spot Grid has a white background and black letters when a Rule hasn't painted a spot. You can 

change these default colors to any color you wish. The colors are set in the File, Settings, Spots, DX Spot Mgr 

window. 

Spot List Horizontal Lines 

Normally the Spot Grid does not have horizontal lines separating the spots. You can add lines in your choice of 

several formats in the File, Settings, Spots, DX Spot Mgr window. 
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Spot List Font 

The font style and size of the DX Spot Manager grid and folder list can be changed from the File, Settings, 

Program, Font window. 

Spot Order 

Spots are normally shown in the order they are received by CommCat. The list can be sorted by any column by 

clicking the header of the column you wish to use, or through the View, Sort By menu. For example, to sort 

the list by DX call, click the DX Call header. Clicking it again sorts the list in the opposite order. To return the 

spot list to the original (unsorted) order, click the Reset Order option on the right mouse menu, or choose 

Order Received in the DX Spot Manager View menu. The current list order is displayed in the status bar at the 

bottom of the DX Spot Manager window. The following spot orders are provided: 

 Order Received 

 DX Call 

 Frequency 

 Note 

 Priority 

 Time Received 

 Date/Time Received 

 Source 

 Spot From 

 Spotter Distance from your QTH 

 Keep 

 Day of Week 

 Entity name 

 DX Bearing 

 Grid Square 

 Continent 

Add a Folder 

Folders can be added to the DX Spot Manager folder list. Once a folder has been added you can create rules 

with actions that transfer spots to the new folder, or you can drag-and-drop spots directly to the folder. 

To add a folder, select a folder in the folder tree, then right-click to open the Add Folder dialog. Enter a name 

for the new folder. (Note that a folder name can only be used once in the folder tree.) Next select the folder 

under which you want the new folder to appear. Click OK to finish adding the new folder. 

Rename a Folder 

To rename a Folder, select the Folder you wish to rename, then right-click the mouse. Choose "Rename" from 

the menu. The Enter Folder Name dialog opens allowing you to enter the new name. Note that a folder name 

can only be used once, and that several special folders cannot be renamed. The Rename option is disabled 

when you attempt to rename one of these special folders. Any rules that use the renamed folder are updated to 

use the new name. 
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Remove a Folder 

Select the folder you wish to delete, then click the right mouse button. Choose "Delete" from the menu. Note 

that several folders cannot be deleted. For these special folders, "Delete" is disabled in the right mouse menu. 

When you delete a folder, any rules that use the deleted folder are updated to show that a folder has not been 

specified. It is necessary to modify any rule actions that use the deleted folder to include a new folder name. 

Rules that Copy or Move spots to a deleted folder no longer perform that action until you replace the 

destination folder. 

Moving DX Spot Manager Out of the CommCat Main Window 

If you wish to move the DX Spot Manager window out of the Main CommCat window, check the DX Spot 

Manager option on the File, Settings, Program, Window Position window. This option is useful if you want to 

display the DX Spot Manager window while using another program, or you have a dual monitor system. 

Spotlist default foreground and background colors 

Normally the spot list uses a black font with a white background for spots that have not been colored by a Rule 

Action. You can change the default background and foreground colors in File, Settings, Spots Settings, DX 

Spotmanager, Grid Options. 

  

DX Spot Manager Toolbar 

Band Filter 

Click the down arrow on the Quick Filter button and Choose Band Filter Settings from the Quick Filter menu 

to open the Band Filter window. 
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Use the Band Filter to reduce the number of spots displayed. For example, if you are operating in the CQ 

Magazine 10 meter contest, you can display only 10 meter spots. You can include spots from the current band, 

a single band, or a selection of bands. The Band Filter does not use the Rule system. Even though you do not 

see the spots in the Spot List that are hidden by the Band Filter, they remain in the list. To engage the Band 

Filter, click the Band Filter button on the DX Spot Manager menu bar. 

Two types of Band Filtering are provided. To make a selection, click the down arrow to the right of the Band 

Filter button to open the Band Filter window. You can limit the spots to the "Current Band" or to a 

combination of specified bands. 

The Current Band option hides all spots in the spot list except those on the same band as your radio. As you 

tune from one band to another, the filtering tracks the current band. 

You can also specify a band or set of bands you wish to monitor. When a band is selected a check mark 

appears next to the band name. Click a band name to add or remove a check mark. When a band is checked, 

spots for that band do not appear in the spot list. 

The Band Filter settings in the DX Spot Manager also apply to the Great Circle Map. 

View 

Add or remove information panels from the DX Spot Manager window, change the status pane style, refresh 

the spot list, or set the order of spots in the list. The current spot order is displayed in the right pane of the DX 

Spot Manager status bar. 

Grid Shifted Tooltips provides a way to show different spot data in the tooltips as you move the mouse pointer 

over the spot list. The normal tooltip shows spot call, spotter, frequency, and spot note. By pressing Ctrl+Shift 

the tooltips are switched to their alternate mode which can be the underlying rule for the spot, or the worked 

status for the spot. To switch back to the normal mode, press Ctrl+Shift once more. You can also use this menu 

to turn off tooltips. 

Shift the view to the next or previous Folder through the View menu. Specify the Folders you wish to visit 

with the Next and Previous selections through the Folder Preferences window. Go directly to a folder through 

the Go to Folder option. 

Hold 

Pause the processing of incoming spots with the Hold button. During times of intense spot activity, Hold will 

allow you to explore the spot list without interference. Hold is also engaged during CW transmissions so that 

CommCat can devote full attention to code timing. 

Spot Duplication Filtering 

Incoming spots are tested against a duplication filter and Notify Rules you have defined. Open the Spot Dupe 

Rules or Notify Rules from the Rules toolbar button. 

The duplication filter removes incoming spots that are similar to existing spots from further processing. This 

filt er reduces the processing resources required by subsequent Notify Rule processing, which can be 

substantial when there are many spots arriving. 
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Turn on the filter by placing a check in the Enable checkbox. As you add filter options in the Spot Dupe Rules 

window, the filter description is shown in the sentence at the bootom of the window. An option without a 

check is not used as part of the duplication test. For example, if you don't use Spotter call, Spotter call is not 

used for the duplication check. Similar spots from different spotters will be identified as duplicates without the 

Spotter call option. 
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Spot Notification 

Each Notify Rule consists of one or more conditions which specify the test and one or more actions which 

determine the response. You can define as many rules with conditions and actions as you wish. Several sample 

rules are included with CommCat. You can use these rules, modify them, or delete them. 

 

Notify Rules are organized into Notify Profiles. Each Profile holds a set of rules you can use for a special 

purpose. For example, you may have different Profiles for contests, chasing CW DX, or different Profiles for 

day and night use. Two Profiles are provided with CommCat: Notification Off, and Normal. Notification Off, 

used to turn off rule processing, cannot be deleted. Normal is provided with several sample rules you can use 

to study how rules are made. The Profile selected in the Notify Profiles list is the active Profile. The name of 

this Profile is shown in the caption bar at the top of the DX Spot Manager window. 

The Rules associated with the selected Profile are shown in the list below the Notify Profiles list. You can add 

to, remove, or modify the rules in this list. 

Rules are processed in the order they appear in Rules list. Rules can be disabled by clicking their check boxes 

to remove the checks. They can also be moved in the list (and thereby their processing order) by clicking the 

Move Up or Move Down buttons. 

Creating a New Rule 

 Click Rules to open the Notify Rules window. 
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 Click the Profile you wish to use, or click New Profile.. to add a new Profile. 

 Click New Rule... to open the New Notify Rule window. 

 Select and check the Conditions and Actions you wish to apply for this rule. 

 Click the underlined words in each Condition and Action in the Rule Description box to specify the 

parameters for each item. 

 Name the rule and click OK to close the New Notify Rule window. 

 Test the new rule by clicking Apply Now. 

All checked rules are tested including the new rule. If you wish to test only the new rule, temporarily disable 

all other rules by unchecking them. Note that all spots are marked as "tested" once they have been added to the 

spot list. Apply All "untests" them so they can be tested again. 

The Contact Status condition window below shows how you may wish to filter spots based on whether or not 

you need a particular entity. The Check DXCC Entity option is selected so the DX spot's entity will be used in 

the test. We want to be notified of any spots from an entity we haven't worked in any log. We will only be 

notified if we haven't worked this entity on the current (DX) band and current (DX) mode. In other words, if 

you need P5/4L4FN on 15 RTTY, you will be notified when he is on that band and mode even if we have 

already worked him on 15 SSB. If you want to be notified only when you need him QRP, check the My Power 

QRP box. The DXpedition box is checked so the condition also requires that the DX be mentioned in this 

week's ARRL DX Bulletin (this option is available with CommCatLive). 

 

Modifying an Existing Rule 

Existing rules can be modified to make changes in the Conditions or Actions associated with that rule. For 

example, you may wish to change the frequency limits or background color for a rule. 
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 From the DX Spot Manager window, click Rules to open the Notify Rules window. 

 Select the Profile and then the Rule you wish to modify. 

 Click Modify... to open the Modify Rule window. 

 Select or deselect any Conditions and Actions you wish to add or remove from the rule. 

 Click the underlined words in each Condition and Action in the Rule Description box to specify or 

change the details for each item. 

 Change the rule Name if you wish and click OK to close the window. 

 Test the modified rule by clicking Apply Now. 

Copy an Existing Rule 

Use Copy to create a new rule identical to an existing rule. All Conditions and Actions are copied into the new 

rule, and a new name is assigned. Follow the steps above to Modify an Existing Rule to make any necessary 

changes. 

Removing an Existing Rule from the Rule List 

Select the rule you wish to remove from the list and click Remove. This permanently removes the rule from 

the rule list. Note that you can temporarily disable an existing rule in the rule list by unchecking it if you wish 

to keep it for later use. 
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Exporting and Importing Profiles 

 

Right-click over the Notify Profile list to open the Profile Export/Import menu. Profiles are saved in 

compressed (Zip) files which contain all Rules for the Profile and any external audio files that have been used 

with a Rule. Profiles are imported into CommCat directly from the compressed file--it is not necessary to unzip 

a compressed Profile. If a Rule in the imported Profile uses a folder that has not been created in your DX Spot 

Manager, a new folder is created. 

To e-mail a Profile to another CommCat user, choose the E-mail Profile option in the Profile menu. CommCat 

Zips the selected Profile along with any audio files, and attaches the zipped file to an e-mail message. When an 

e-mail is received with a Profile attachment, save the file in the CommCat Profile folder. Import the Profile 

into CommCat by using the Import option on the Profile menu. 

Rule Conditions 

CommCat Condition Search Details 

Where the DX Call contains specified characters Look for one or more characters in the DX Call. See Text Search, below, for 

additional information on text searches. 

Where the DX frequency is in a specified range Define the lower and upper frequency for processing this spot. 

Where the Spot Note contains specified 

characters 

Look for one or more characters in the Note field. See Text Search, below. 

Where the Spot Time is in a specified range Process this spot only if it is received in a specified time range. 

Where the Spotter call sign contains specified 

characters 

Look for one or more characters in the From call. See Text Search, below. 

Where the Spot is from a specified source Perform specified action when the source is from the Web, Telnet, Packet, or 

Local. 

Where the DX is from a specified DXCC entity Look for DX from specific DXCC entities (countries). The entity DX 

Reference number is used rather than the entity name. 

Where the DX is from a specified continent Look for DX from specific continents. 

Where the Spot is a number of minutes old Perform action at specified time intervals after the spot has been received. 

You can use this rule in phases to paint spots in different colors depending on 

the elapsed time. Be sure to place rules with longer elapsed times later in the 

rule list. 

Where the DX Call sign/Entity hasn't been 

worked/confirmed 

Identify spots for specific call signs, or DXCC Entities, Zones, Grid Squares, 

or Prefixes that have not been worked, or worked but not confirmed, in the 

current log or any log, using the current DX mode or any mode, or on the DX 
spot band or any band. 

If an entity is ambiguous (i.e., VP8), be sure to update the Entity data using 

the Entity Editor by adding the call. If you do not update the Entity data, the 
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DX Spot Manager will probably show an incorrect entity for a known spot, 
and will not correctly identify worked entities. 

If you check DXCC Entity, NOT Worked, DX Band, and DX Mode, 

CommCat will find all spots for entities you haven't worked using the current 

DX band and mode. 

The options DX Band and DX Mode on any Band are useful to identify spots 
that will give you an all-time new band and mode for that entity. 

The call sign option, useful for working DXpeditions, provides a way to watch 

for spots on bands and modes on which you haven't worked a particular 

station. If you enter an asterisk in the call sign field, CommCat paints all spots 

that haven't been worked on the DX band. This is useful for casual contesting. 

(Be sure to use a new log for the present contest.) 

Place a check in the DXpedition checkbox to include spots where the call was 
listed in the most recent ARRL DX Bulletin (CommCatLive only). 

If you wish to limit this rule to spots needed while you are operating QRP, 

check the My Power option. 

Where the DX is using a specified mode Select Phone, CW, or RTTY/PSK as a condition for spots. The mode is 

determined from the spot frequency using the CommCat Ham Band Plan. This 

condition is useful if you want to exclude spots by mode from the spot list, or 

separate them into their own folders. 

Where the Spotter is from a specified continent Use this condition to accept or reject spots originating from specified 

continents. You may wish to use only spots originating from your continent. 

Where the DX is on a specified band Set up rules for specific bands with this condition. 

Where the Spotter is closer or further in miles/km 

than a specified distance 

Sometimes it is useful to set up rules for spots originating within a specified 

distance from your QTH. CommCat uses miles or kilometers depending on 

the program settings for distance units. This condition looks up the location of 

the station that submitted the spot in the Spot Distance database kept by 

CommCat. The distance to the spotter is shown in the Spotter Dist column. 

CommCat checks the database for a spotter call. If it isn't found, the call is 

added to the database. If it is found but the distance hasn't been added to the 

database, a ? is added to the beginning of the From call. When the distance has 

been entered, the From call is shown without a ?. See the Spotter Distance 
topic in the Maintenance section of Help for more information. 

The Spotter Lookup On option must be checked in the Spotter Distance 

window to have this Condition work. 

  

Rule Actions 

CommCat Action What Happens 

Highlight this Spot in the Spot List with a color Accents the spot with a choice of foreground and/or background colors. The 

background color also establishes the color of the spot when displayed in the 

Spectrum Analyzer, Band Spotter, and Great Circle Map windows. 

Make a voice announcement Announce the call, frequency, and sound alert tone or play any external WAV 

file, or any combination, through your computer's audio card. Display an Alert 

popup window with a list of needed spots. CommCat processes spots in 

blocks. Tone and external WAV announcements are not repeated in a block 

when it is triggered by more than one spot. 
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Spotter_Distance.htm


112 

 

Delete this Spot from the Spot List Move this spot to the Deleted Spots folder. 

Send this Spot as an e-mail message Send this spot to the e-mail address distribution list specified in the E-mail tab 

of the File, Settings, Station window. 

Send this Spot to a pager Send this spot to the pager designated in the Pager tab of the File, Settings, 

Station, Pager window. See the Pager topic in the Getting Started section of 

Help for more information on communicating with pagers. 

Tune Rig to the Spot frequency Self explanatory 

Forward this Spot to a selected destination Forward this spot to the Web Cluster or Packet Cluster. Special care must be 

taken when using this action to prevent spots from circulating. 

Make this Spot sticky Retain this spot indefinitely. 

Move this Spot to a specified folder Move the spot from the Inbox to a specified folder. 

Copy this Spot to a specified folder Copy the spot from the Inbox to a specified folder, leaving a copy of the spot 

in the Inbox. The spot copies are ignored in subsequent Rule processing. 

Stop processing more rules for this Spot Do not process any more rules for this spot. 

Move this Spot to end of list "Age" this spot. 

Move this spot to the DX Tracker window Create a spot marker on the DX Tracker window. The DX Tracker window 

must be open for this Action to work. 

Give this spot a priority level Assign a priority level of 0 to 10. 

Repaint the entire spot list Refreshes the spot list color scheme to repaint old spots whose status may 

have changed since they were originally painted. 

Text Search 

Three CommCat Conditions in the table above provide for text searches in incoming spot announcements. The 

DX Call, Notes, and From Call can be included in Condition text searches. The following rules apply: 

 Case is ignored. Text searches are case independent. 

 The number sign (#) is a special character that can be used to specify a single digit. Any digit from 0 

to 9 will be recognized. For example, W#A will find W6A and W1A. Only one # can be used in a 

condition. #D#C (when trying to find 3D1C) violates this rule. 

 The asterisk (*) is a wild card which can be used alone or with the number sign. The asterisk can be 

used at the beginning of a call or at the end. *B* will find all calls that contain the letter B. WB6HQF 

and BV4US will be found. *BAC will find all calls that end with the letters BAC. VE* will find all 

calls that start with the letters VE. P5* will find P51AB but not VP5E. *P5 will find both. 

 If no asterisks are included, the search is exact. VP5E will find VP5E and not VP5EC. 

Troubleshooting Rules 

It is possible to build complex Profiles containing many Rules. You may find that some spots are not being 

processed or filtered consistent with what you desire. Several trouble shooting hints are provided below to help 

you determine the cause of a problem. 

 Rules are processed in the order they are listed in the Notify Rules window. If you find that the spots 

are not being painted in a color you expect, make sure the order of the Rules makes sense. For 

example, if the first rule says, "Paint the spot red if I haven't worked him," and the second rule says, 

"Paint the spot blue if that entity hasn't been confirmed," you won't see any red spots. In this case, use 

the Move Up button to move rule 2 to the top of the rule list. 

 To isolate a problem Rule, turn off all rules by removing the checks to the left of each Rule. Then 

walk through the Rule list, and use the Apply Now button to test each Rule independently of the 

others. You should be able to find the offending Rule and correct any problems. 

Configuring_CommCat.htm#E-mail
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History 

Click History to display a menu of the last ten spots you have viewed. Click a spot in the menu to return to that 

frequency and set the Focus DX call to that call sign. 

Web Spots 

Refresh the spot list from the Internet Cluster. You must be connected to the Internet for this function to work. 

Stop 

Stop any Internet activity. Use this option if the Internet Cluster is not responding. Stop can also be used to 

stop a long string of voice announcements which are the result of a Rule. 

Rotate S and Rotate L 

Instruct the rotor to go to the indicated bearing, short or long path. This button is disabled when a valid rotor is 

not found for the current band. The operation of this control is different from other rotor controls in CommCat, 

which use the bearing to the Focus DX call as their basis. The DX Spot Manager Rotate control uses the 

bearing that is in the status panel, which isn't necessarily for the Focus DX call. 

Stop (Rotation) 

Stop rotor activity. 

Right Mouse Menu 

A number of menu selections are available on the DX Spot Manager right mouse menu. The menu is shown 

below. 
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Send Telnet/Packet Cmd... 

Opens a window which provides a way to send a command to a Telnet site or Packet Cluster. You must be 

connected to one or the other for this command to be functional. 

Add Spot to Notepad 

Copies the selected spot to the CommCat Notepad, if Notepad is open (Main CommCat menu bar, Tools, 

Accessories, Notepad). 

Move Columns 

Places the spot list grid column headers in the column move mode. Normally when you click a column header, 

the order of the spot list is set to that item. In the column move mode, clicking a header selects it and allows 

you to move it to another column position. 

Print Preview... 

Opens the print preview window displaying the spot list. You may then print the list if you wish. 

Sticky Spot 

Sets or clears the sticky spot status for that spot. When the sticky spot status is set for the selected spot, a check 

marks appears next to the label in the menu. 
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Set Priority... 

Opens a window which provides a way for you to set the priority level of the selected spot. 

Clear Priority 

Sets the priority of the selected spot to 0. 

Send Spot... 

Opens a window which allows you to send a spot to a Telnet, Web, or Packet site. The destination is selected 

in the File, Settings, Spot window. 

Add Spot to Spot List... 

Opens a window which allows you to add a spot to the DX Spot Manager spot list. This spot is not sent to an 

outside destination. 

Delete Spot 

Remove the selected spot from the spot list and send it to the Deleted Spots folder. 

Spotter Distance List 

Open rhe Spotter Distance window to view and maintain the list of spotter calls. 

AutoTune 

Tune the current radio to the DX frequency reported in the selected spot. 

Add to DX Tracker 

Add the selected spot to the DX Tracker window. The DX Tracker window must be open for this option to be 

enabled. 

Reset Order 

Reset the order of the spots in the spot list to "as received". If this option is dim, the order is already reset 

Hold 

Temporarily stop all spot processing. 

Instant Web 

Create an Instant Web Page for the DX station reported by the selected spot. 

Edit Entity... 

Open the Entity Editor window for the entity of the DX reported in the selected spot. 

Configuring_CommCat.htm#Spots


116 

 

DX Atlas... 

Engage the DX Atlas window for selected spots. When the DX Focus call changes, DX Atlas opens showing 

the location of that DX. This function is turned on when there is a check next to the DX Atlas menu item. See 

the DX Atlas Help topic for more information about DX Atlas. 

Propagation... 

Opens the Propagation Prediction window to show the approximate path conditions between you and the 

selected DX spot. This option requires the installation of a freeware program. See the Propagation Prediction 

Help topic for more information about HamCAP from VE3NEA. 

Special Keys 

A number of special key assignments are available in CommCat for navigating within the DX Spot Manager 

spot list. The key assignments are described below. The functions work within any DX Spot Manager folder. 

For example, if you have defined a rule that passes all 20 meter spots to a folder, and then view that folder, the 

special keys work within that folder. 

Key Function 

Mouse wheel Scroll through the spot list 

PgUp Move spot list up one page at a time 

PgDn Move spot list down one page at a time 

Up Arrow Move to next higher spot 

Dn Arrow Move to next lower spot 

Alt+Home Move to top of spot list 

Alt+End Move to bottom of spot list 

Space Tune to selected spot 

Ctrl+L Shift view to next Spot List Folder 

Ctrl+Shift+L Shift view to previous Spot List Folder 

Ctrl+X Send Telnet/Packet command 

Ctrl+Y Open Folder Selection window 

Ctrl+Z Retrun to last spot 

Ctrl+S Send Spot announcement (also available in other windows) 

Printing the Contents of the DX Spot List 

To prepare a printed copy of the DX Spot List, choose Print Preview from the File Menu, or right-click over 

the spot grid and choose Print Preview. 

DX Alert Notification Popup  

Sometimes you are busy on a computer project, but want CommCat to run in the background to alert you when 

a spot of interest is announced. The DX Alert Popup provides a list of desired spots that appears on top of all 

other applications on your desktop. 

Accessories.htm#DX_Atlas
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The popup stays for a few seconds, then disappears. To keep it from disappearing before you've had a chance 

to review it, position the mouse pointer over the popup. Click the popup to bring CommCat forward from 

behind any other applications. 

Drag the top edge of the popup window to move the popup to the location you prefer on your desktop. 

You can change the appearance of the popup in the Spots Settings window. Options include settings for Style, 

transparency (how much of the background behind the popup shows through), and whether it fades in and out 

when opening and closing. 

 

To set up what will trigger the DX Alert Notification popup, use the DX Spot Manager Rule system. Create a 

condition you want to be met to create a Notification. For example, you may want to display the popup for 

spots from entities that have not been confirmed in your log. Next add the Action 'Make a Voice 

Announcement.' Put a check in the Alert and Popup options. If you wish a tone to be played to announce the 

Alert, put a check in the Tone option. 

Update 3/2009  
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Tuner Window 

 

Overview 

The Tuner window provides a way to control the frequency of the radio through an analog dial display. Three 

window formats are provided: a General Coverage Main tuning window (shown above) which displays the 

entire spectrum between 100 KHz and 30 MHz; a Bandspread tuning window which displays individual radio 

amateur bands and US operating privileges from 160 through 10 meters; and a status window that displays 

VFO frequencies and signal strength. With the two windows that display frequency dials, the radio is tuned to 

the frequency specified by a mouse click. 

An analog signal strength meter is included in the General Coverage Main and status windows. This meter 

responds to signal strength data sent from the radio for any radio that provides such data. 

Main and Bandspread windows 

Click any frequency on the Main Tuning window to tune the radio to that frequency. If you click a frequency 

located in one of the HF amateur bands, the Bandspread tuning window changes to the associated band. 

Likewise, you can click a frequency in the Bandspread tuning window to tune the radio inside the displayed 

band. When a frequency is changed, CommCat determines and sets the mode for that frequency from the Band 

Plan. 

Click the Up or Down button on the Bandspread tuning window to go to the next higher or lower band. 

Customizing the Tuner Window 

Switch through the three Tuner window formats by clicking the double-arrow sizing button in the lower right 

corner of each window. You can also use the right mouse menu to change the window format by clicking Size. 



119 

 

 

 

The Band, Mode and Split toolbars can be removed from the Tuner window by clicking Toolbars on the right 

mouse menu. 

The Tuner window cannot be resized. 

Modifying the Bandspread Dials 

The bandspread dials provided with CommCat show the operating privileges for US hams. If you wish to 

modify the band layouts, perhaps to reflect the requirements in a different country from the US, CommCat 

provides a way to do this. 

A set of bandspread dials is contained in the file named bands.zip located in the CommCat BMPs folder. When 

these files are unzipped, CommCat uses them rather than the internal dials. Any changes you make to the 

bandspread dials in the BMPs folder will be reflected in the Tuner window. 

Floating toolbars 

Three floating Tuner toolbars are provided to control the radio. The Band toolbar is used to change from one 

amateur band to another. The Split toolbar is used to control the split functions in the radio. Click Off to turn 

the split off, -1KHz to set up a minus one-Kilohertz split, Zero to keep the split on with the same frequency in 

both VFO's, or +1 KHz to set a plus one-Kilohertz split. The third toolbar is used to control the operating mode 

of the radio. 
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The Toolbars can be positioned anywhere on your screen. Drag the handle on the left end of the toolbar you 

wish to move to a new position. Hide the toolbars by clicking Toolbars on the right mouse menu. 

 

The Reset Toolbars option returns the toolbars to their default positions at the top of the Tuner window. 

Markers  

A number of markers are provided on the Main and Bandspread dials. The Main tuning window markers can 

be turned on or off depending on your preferences. 

 

Operating privileges for US amateurs are shown on the Bandspread tuning window. Phone and non-phone 

band portions are shown, along with operating class. 

 Red: Novice 

 Yellow: General 

 Blue: Advanced 

 Green: Extra 

Four band marker types are available for the Main tuning dial. 

Ham Bands 

Display the amateur radio bands by clicking the Ham Bands button. The radio amateur bands are shown in red. 
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WWV  

Display the WWV frequencies by clicking the WWV pushbutton. A clock icon is used to mark the frequencies 

of WWV transmissions. Click the clock to tune to the respective WWV frequency. 

Broadcast 

Broadcast bands can be displayed by clicking the Broadcast button. Broadcast bands are shown in green. 

Beacons 

Display yellow triangle markers for the propagation beacons. Click a triangle to tune to the respective beacon 

frequency. When you click a beacon triangle, the current, next, and previous beacon call signs are displayed 

below the radio frequencies on the left side of the Main Tuner window. The number next to the current call 

shows the position of that call in the beacon list. If you are connected to the Internet, CommCat can check and 

adjust your computer's system clock automatically. 

All  

Show all markers 

Clear 

Turn off all markers 

Tuning via Keyboard 

In addition to setting the frequency by clicking the mouse, it is possible to control the frequency through 

keyboard control. 

Frequency Up/Down 

 10 KHz 1 KHz 100 Hz 10 Hz 

VFO A UP Shift + Right Arrow Right Arrow Shift + Plus Key Plus Key 

VFO A DOWN Shift + Left Arrow Left Arrow Shift + Minus Key Minus Key 

VFO B UP Ctrl + Shift + Right 

Arrow 

Ctrl + Right 

Arrow 

Ctrl + Shift + Plus Key Ctrl + Plus 

Key 

VFO B DOWN Ctrl + Shift + Left 

Arrow 

Ctrl + Left 

Arrow 

Ctrl + Shift + Minus 

Key 

Ctrl + 

Minus Key 

Split Control 

Ctrl + PgDn VFO A receives 

Ctrl + PgUp VFO B receives 

Ctrl + End End Split Operation 

Ctrl + Home Set VFO B = VFO A, Split mode 
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Band Up 

Press the Up Arrow key of move the main dial up one band. 

Band Down 

Press the Down Arrow key to move the main dial down one band. 

Direct Entry 

Select the numbers in the Main or Sub band readout you wish to change and make desired changes. 

Moving Tuner Out of the CommCat Main Window 

If you wish to move the Tuner window out of the Main CommCat window, check the Tuner option on the File, 

Settings, Program, External Window window. This option is useful if you want to display the Tuner window 

while using another program, or you have a dual monitor system. 

  

Updated 7/2008  
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Spectrum Analyzer Window 

 

The CommCat Spectrum Analyzer displays signals present in a 2.7 kHz band (depending on 

your rig's receive bandwidth) above or below the receiver frequency. In the Waterfall display 

shown above, time is shown along the horizontal axis and frequency is shown along the vertical 

axis. Signal amplitude is represented by the color of the trace with red being the strongest and 

blue the weakest. 

Overview 

The Spectrum Analyzer is designed to aid with operation in a CW pileup, especially when the DX station is 

operating in a split frequency arrangement. This tool is especially valuable when the receiver provides a CW 

bandwidth of 2 kHz or more and uses USB for the CW mode. Depending on band conditions, it is easy to see a 

station that is working the DX station and rapidly tune to that frequency with a single click. 

Controls 

Waterfall 

Choose the Waterfall mode to display the time vs. frequency spectral display. The scale on the right side of the 

display represents frequency, with each major mark at 1 kHz increments. The frequency to which the radio is 

tuned is 0 on the scale. When in the CW mode, the your rf frequency is offset from 0 by the sidetone 

frequency. When in the USB mode, frequency increases along the vertical axis, while in LSB the opposite is 

true. Elapsed time increases to the left along the horizontal axis. The present spectrum is at the right side of the 

display. 

 

 

 



124 

 

Amplitude 

 

The spectrum displayed in the amplitude mode shows signal strength on the vertical axis and frequency along 

the horizontal axis. When using the USB mode, frequency increases to the right with each major mark 

representing 1 kHz. When using LSB the opposite is true. 

Raster 

 

The raster spectrum display shows a history of spectrum lines going back into the display. Signal strength is 

shown on the vertical axis and frequency along the horizontal axis. 
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Scope 

 

The audio waveform of the received signal is displayed in the scope mode. 

Wide 

The wide pushbutton selects the wide bandwidth mode of the receiver when filter selection is supported. For 

example, many Icom radios allow the bandwidth to be set in the CW mode when an optional filter is installed. 

Some rigs, such as the Elecraft, have filter preferences available in the Advanced Settings for this purpose. 

Narrow 

The narrow pushbutton selects the narrow bandwidth mode of the receiver. The same conditions apply as 

above. 

Up 2 kHz 

Tune the receiver frequency up two kHz. If the split mode is on with Rx A (VFO A) enabled, the split mode is 

turned off and VFO A is tuned up 2 kHz. If the split mode is on and Rx B (VFO B) is enabled, the split mode 

is kept on and VFO B is tuned up 2 kHz. If the receiver is in the narrow bandwidth mode, the wide bandwidth 

mode is selected. 

Dn 2 kHz 

Tune the receiver frequency down two kHz. If the split mode is on with Rx A (VFO A) enabled, the split mode 

is turned off and VFO A is tuned down 2 kHz. If the split mode is on and Rx B (VFO B) is enabled, the split 

mode is kept on and VFO B is tuned down 2 kHz. If the receiver is in the narrow bandwidth mode, the wide 

bandwidth mode is selected. 
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Freeze 

Stops the display. This is useful if you want to capture the contents of the current spectrum with a screen 

capture program. 

Undo 

Returns to the last frequency. 

Split 

Turns on the split mode of the radio. 

Marker 

Places a blue marker on the spectrum display that serves as a tuning guide when tuning CW, sideband, or 

RTTY signals. 

Rx A 

Activates the Main VFO. If in the split mode, the frequency of the secondary VFO is shown by a yellow 

marker. The display is green in the Amplitude, Raster, and Scope Spectrum Analyzer modes. You can also use 

Ctrl + PgDn to switch to Receiver A. 

Rx B 

Activates the secondary VFO. If in the split mode, the frequency of the primary VFO is shown by a green 

marker. The display is yellow in the Amplitude, Raster, and Scope Spectrum Analyzer modes. 

If you are using a dual-receiver radio, such as the Yaesu FT1000mp, the Spectrum Analyzer displays the audio 

from the sub receiver. (Use a stereo cable from the radio audio output to the sound card line input. The main 

receiver should be on the tip and the sub receiver on the ring.) You can also use Ctrl + PgUp to switch to 

Receiver B. 

If you are not using a dual-receiver radio, the main radio audio is used. 

A=B 

Copies the contents of VFO B to VFO A. Not supported by all rigs. 

B=A 

Copies the contents of VFO A to VFO B. Not supported by all rigs. You can also use Ctrl + Home to set VFO 

B = VFO A and turn on the radio's split mode. 
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Signal Level Control 

 

Use this slider control to set the audio level for the spectrum analyzer. Set the audio level so background noise 

appears as light blue specks on the display. It may be necessary to adjust your sound card mixer levels to get 

the right signal range. 

Moving the Spectrum Analyzer Out of the CommCat Main Window 

If you wish to move the Spectrum Analyzer window out of the Main CommCat window, check the Spectrum 

Analyzer option on the File, Settings, Program, Window Position window. This option is useful if you want to 

display the Spectrum Analyzer window while using another program, or you have a dual monitor system. 

Tuning 

Click on a signal that is displayed in the Spectrum Analyzer window to tune your radio to that frequency. 

Double-click a signal to send the frequency to the DX Tracker window (if it is already open) and mark the 

frequency in addition to tuning the radio. In the split mode, clicking the display sets the frequency of VFO B. 

The split mode assumes you are listening to a DX station with VFO A and want to tune your transmit (VFO B) 

frequency. 

Configuring_CommCat.htm#Window_Position
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In radios that do not have a dual receiver, you can use VFO B for the receiver in the split mode by clicking Rx 

B. This mode allows you to listen for stations calling the DX but also sets the transmit frequency to VFO A. 

VFO A is probably the DX station's transmit frequency. Be sure to return to Rx A before calling the DX 

station! 

Tuning Strategy 

The Spectrum Analyzer is a powerful tuning aid, especially when opening in the CW mode. Rare DX stations 

often create pileups with many stations attempting to work a new entity. A DX operator will often use split 

operation, transmitting on one frequency and listening on a second (usually higher) frequency. This type of 

operation has the advantages of dispersing the calling stations so they are easier for the DX station to hear, and 

keeping the DX frequency clear of loud local stations. 
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5B4/RW9UP working a CW pileup on 20 CW. On the left side of the display a 

station is signing with RW9UP. In the center of the display, RW9UP is sending 

QSL info, then standing by. A number of stations then start calling. 

By watching for patterns in a DX station's operating habits you can significantly increase your chances of 

working him/her. A DX operator may arbitrarily work through a pileup from low frequency to high, tuning his 

receiver higher in frequency after each contact. It is more common for a DX operator to respond to stations 

close to the frequency of the last contact. In either case, the CommCat Spectrum Analyzer can help. 

The Spectrum Analyzer provides up to a 2.7 kHz frequency/time view of the pileup. By listening to the radio 

audio and watching the spectrum, you will quickly learn how to spot a station that is in contact with the DX 

station. For this to be true, a propagation path to the station working the DX station must exist, and the 

passband of your receiver must be wide enough to allow the full spectrum analyzer bandwidth to be used. 

When you identify the station working the DX station, simply click the associated spectrum analyzer trace, and 

your radio is tuned to the correct frequency. If you have identified a tuning pattern being used by the DX 

operator, click higher or lower in frequency as determined by your prediction of frequency step size. 

The tuning procedure you use depends on the frequency difference between the pileup and the DX station, and 

the way your radio transmits CW. Yaesu radios typically use USB (Upper Sideband) in the CW mode, while 

other radios, such as Icom, use LSB (Lower Sideband). With USB radios you will see the DX station and an 

associated pileup on the same view, so long as the pileup is higher in frequency than the DX station, and is 

within 1-2 KHz. With LSB radios, it is not possible to see the DX station and pileup at the same time unless a 

"down" split is being used by the DX operator. For radios that use LSB on CW it may be possible to use CW 

Reverse for best use of the Spectrum Analyzer. The Elecraft K2 uses USB on the high bands and LSB on the 

low bands. Using the Advanced Settings for the Elecraft radio you can have CommCat automatically use CW-

R on the low bands to provide USB on all bands. 

The Spectrum Analyzer can be used in concert with the DX Tracker window. Double-click a frequency in the 

pileup to tune the radio to that frequency and set a tuning mark on the DX Tracker window. As you double-

click on the stations that successfully contact the DX station, it is easy to see a developing pattern on the DX 

Tracker display. 

Trouble Shooting 

Here are some guidelines to help figure out why the Spectrum Analyzer is not working: 

DX_Tracker.htm
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1. The Spectrum Analyzer computes the spectrum in your computer using a sound card supplied by audio from 

your radio. 

2. Use the Line Input on the sound card. This connection requires a stereo plug. Connect the radio audio to the 

tip and ground to the sleeve. If your radio has two audio channels (for two receivers) connect the second audio 

output to the ring on the connector. 

3. The line input to the sound card recorder must be enabled. You can check this on the Windows mixer panel. 

4. When set up properly, you will be able to hear the radio audio through your computer speakers. If you don't 

hear the audio, the Spectrum Analyzer will not receove the proper signals. 

5. You can adjust the Windows mixer audio level to lower or raise the level fed to the Spectrum Analyzer. You 

can also use the audio level slider on the Spectrum Analyzer to adjust the levels. 

  

Updated 10/2006 
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DX Tracker  

See also: Spectrum Analyzer, DX Spot Manager 

 

The DX Tracker provides a graph of frequency activity. The spots are shown in the upper panel while 

the corresponding signal levels for each spot are shown in the bottom panel. The signal levels are 

updated when you tune to a spot. 

Overview 

The DX Tracker window provides a number of useful functions. 

 Track the stations a DX operator is working to analyze his operating patterns. 

 Look for clear frequencies inside the spread of a DX pileup. 

 Tune through a band of interest and mark frequencies you want to revisit. 

 Set up custom scans to listen for a DX station who operates consistently on the same frequencies. 

 Transfer spots from the DX Spot Manager window and then scan those spots for active signals. 

 Use your radio as an HF scanner. 

The DX Tracker window contains two panes. The upper pane displays a frequency range on the vertical axis 

with the range adjustable from +/- 1 KHz (2 KHz) to +/- 15 MHz (30 MHz). Two frequency markers (green or 

yellow horizontal lines) can be shown, the green representing VFO A and the yellow VFO B. Frequency points 

Spectrum_Analyzer.htm
DX_Spots.htm
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of interest, called scan points, appear as dots connected by a red line. The collection of scan points is the scan 

set. Scan sets can be named, saved, and recalled later. 

The lower pane contains signal level bar graphs for each scan point. The bar graphs are updated from the 

transceiver's s-meter readings (not all radios provide this data). The active bar graph is green, while the 

inactive bar graphs are red. The radio must support s-meter reading through its data port for the bar graphs to 

operate. 

A threshold, represented by the red line, can be set by clicking a point on the signal bar graph pane. If a signal 

exceeds the threshold, the upper portion of that spot's bar graph is painted yellow. Once a signal has exceeded 

a threshold level, a number of actions can be specified. 

 

Scan points can be added to the DX Tracker in a number of ways, including double-clicking the scan point 

position, clicking the Set toolbar button, double-clicking a frequency on the Spectrum Analyzer window, or 

transferring spots from the DX Spot Manager. Through the DX Spot Manager, spots can be transferred 

automatically by setting up a rule, or manually. 

You can also use scan points to provide an indication of the frequency limits of a pileup. These limits are 

useful as you tune through a pileup as a visual cue that you have reached one frequency limit or the other. 

Click a scan point to tune the radio to the spot frequency indicated by the dot. 

Starting a New Scan Set 

A DX Tracker scan set is initialized in one of several ways: 

 Open the DX Tracker window. The center frequency of the window is set to the current active VFO 

frequency. 

 Click the Reset button on the DX Tracker toolbar to set the center frequency of the display to the 

frequency of the currently active VFO. 

The green frequency marker is set to the center of the display. Set the desired bandwidth of the display by 

clicking the bandwidth button on the toolbar. Bandwidths from 2-kHz to 30-mHz can be selected. 

Setting Scan Points 

 Tune the radio to a frequency of interest and click Set on the toolbar to create a scan point for that 

frequency. 

 Double-click a point in the upper panel to set a scan point. 

 Double-click a frequency on the Spectrum Analyzer to set a scan point for that frequency. 

 Define a rule in the DX Spot manager to transfer spots automatically. 
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 Click a spot in the DX Spot Manager list, then choose Transfer Spot from the right mouse menu 

Recentering a Scan Set 

To recenter a scan set, click a scan point of interest to tune the radio to that frequency. Then choose Reset 

Center Frequency from the right mouse menu. Adjust the bandwidth as necessary to show all spots of interest. 

Scanning 

Click Scan on the DX Tracker toolbar to start CommCat scanning through the scan points. Press the Escape 

key (or click the Scan button) to stop scanning and hold the current frequency. The scan rate can be set from 1 

second per scan point to 10 seconds per scan point. Select the scan rate you wish to use from the Scan menu 

after clicking the down arrow next to the Scan button. 

 

Scanning can also be stopped if a signal level exceeds the threshold level. Click the Rules button on the toolbar 

to see the list of possible actions when the threshold is exceeded. Reset the threshold alarms by clicking the 

right mouse button an choosing Reset Thresholds from the context menu. 

 

Manual scanning is provided through the arrow keys on the keyboard number pad. Use the Right arrow to step 

to the next scan point to the right, and the Left arrow to step to the next scan point to the left. The Home key 

moves to the first scan point, while the End key moves to the last. 

Removing a Scan Point 

To remove a scan point from a scan set, position the mouse pointer over the point you wish to remove. Choose 

Remove This Point from the right mouse menu. The scan set is redisplayed minus the deleted scan point. 
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Resizing the DX Tracker Window 

The maximum number of scan points displayed in the DX Tracker window depends on the width of the 

window. To increase the width, drag the right side of the window with your mouse. The most recent scan 

points are always shown in the window. You can also resize the height of the DX Tracker window by dragging 

the top or bottom border of the window. The vertical scale of the window is changed to reflect the new height 

of the window. Adjust the size of the signal level bar graph panel by dragging the bar that separates this pane 

from the scan pane. 

Moving DX Tracker Out of the CommCat Main Window 

If you wish to move the DX Tracker window out of the Main CommCat window, check the DX Tracker option 

on the File, Settings, Program, Window Position window. This option is useful if you want to display the DX 

Tracker window while using another program, or you have a dual monitor system. 

Saving a Scan Set 

Scan sets can be named and saved for later use. For example, if you have created a scan set for your favorite 

frequencies, you can save it with the name "Favorites." You can open the scan set later to use it or modify it. 

Long scan set names, such as "FO0AAA Jim," can be used to describe the scan set. 

To save a scan set, choose Save or Save As from the CommCat File menu. The Save option saves a scan set 

that is already open, while Save As allows you to rename a Scan Set or save a new one. The Save As dialog 

displays the contents of the Scans folder. Enter a name and click OK. (If you enter the name of an existing scan 

set, CommCat will ask you to confirm that you wish to overwrite the existing set.) 

The Save and Save As options are also available on the right mouse menu. 

Opening a Scan Set 

Open the Open Scan dialog by choosing Open from the File menu. The Open Scan dialog opens and displays 

the contents of the Scans folder. Double-click a scan set, or select a scan set and click OK. The current scan set 

name is displayed in the caption bar of the DX Tracker window. When the scan set is open the radio is tuned to 

the center frequency that was saved with the scan set. 

A second form of Open is provided on the right mouse menu. The Open Here option opens a scan set and 

translates the points to the current frequency. This option provides a way to open scan sets on different 

frequencies, such as when a DX operator changes his operating frequency but follows the same tuning pattern 

as before. 

A scan file for the amateur radio beacons is provided with CommCat. This scan file tunes your radio to all 

beacon frequencies in turn, staying at each frequency for 3 minutes. 

Copying the Scan Set to the Clipboard 

Copy the scan set image to the clipboard by choosing Copy from the CommCat Edit menu. Once on the 

clipboard, you can paste the image into any document that can accept clipboard images, including a QSL card 

design or Word document. 
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Transferring Spots Automatically from the DX Spot Manager 

The DX Spot Manager contains a sophisticated system of rules for testing new spots and performing actions 

when specified criteria are met. For example, you can monitor incoming spots for specific call signs, unworked 

entities, or spots that appear in a frequency range. The list of actions that can result includes an option to 

transfer the spot to the DX Tracker window. 

The spot action can also determine the color used to show the spot, the shape of the spot, and the color of the 

corresponding s-meter. You can specify that certain spots will be show in green with a square shape, and other 

spots using yellow with a round shape. Note that these shapes and colors are also used for the map pins on the 

Great Circle Map window. 

Analyzing DX Operating Patterns 

The DX Tracker and Spectrum Analyzer windows, operating as a pair, make a powerful tool for analyzing the 

operating patterns of a DX operator as he/she works through a pileup. By understanding this pattern, the 

likelihood of making a successful contact is increased since you can often "second guess" where the DX 

operator will be listening next. This is especially true for CW DX pileups where you can use the Spectrum 

Analyzer to monitor a band of frequencies that may encompass the entire pile-up. 

Double-click each signal that the DX operator works to record the frequency in the DX Tracker window. A 

DX operator may use a "saw tooth" pattern, jump from one end of a pile up to another, or simply work a 

number of stations close to the same frequency before moving on. Once you have established the pattern, click 

the DX Tracker or Spectrum Analyzer on the most likely frequency. 

Right Mouse Menu Summary 

The DX Tracker right mouse menu provides additional functions. The menu is shown below. 

 

Remove This Point Remove the scan point designated by the mouse pointer position. This option is disabled when the 

mouse pointer is not over a scan point. 

Reset Center Frequency Reset the center frequency of the scan set to the current rig frequency. This will change the 

frequencies of the scan points unless you set the transceiver frequency to one of the scan points first. 

To do so, click a scan point of interest, then choose Reset Center Frequency from the right mouse 

menu. This option is disabled when the mouse pointer is not over a scan point. 

Reset Alarms Reset all s-meter threshold alarms. 

Save Save the current scan set, replacing the previously opened scan set. 

Save As... Save the current scan set under a new name. 

Open... Open a previously saved scan set. Frequencies in the original scan set are preserved. 

Open Here... Open a previously saved scan set, and center the set on the current transceiver frequency. This is 

DX_Spots.htm
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useful if you have created generic scans, such as a number of steps 2 KHz apart to search a band. 

Scan Choose a scan step interval. 

  

Updated 10/2007  
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Morse Code 

See also: Code Settings 

 

The Morse Code window provides access to the CommCat Morse code keyboard. The keyboard features a type-

ahead buffer accessed through the Work Area so you can prepare a message in advance and then send it at the right 

time. The Transmitted Text area displays outgoing text that has been sent. 

Morse timing is provided by the computer and is subject to minor inconsistencies depending on the speed of your 

processor. You may wish to use the K1EL WinKeyer external keyer if the timing is a problem for you. The 

Winkeyer can be used with Radio A. See the CW Timing topic, below. 

Special control characters 

Control characters can be used to instruct the keyer to perform special functions and send prosigns such as AR and 

SK. These characters are described in the table below: 

Char Result 

'*  Your call sign (apostrophe asterisk) 

'X His call sign (apostrophe X) 

@ or 'A AR 

+ AA 

'B BK 

- or _ BT 
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'C CL 

'E "dit space dit" 

# or 'K KN 

[ or 'S SK 

] or 'Z AS 

! Pause the keyer 

> Increase the current code speed to the "fast" setting 

< Restore the code speed to normal 

% Insert contest number. This number increments by one after every complete log entry. Set the starting point 

by using File, Settings, Station, Code. 

Programming the memory keys 

The CommCat Code window provides 10 programmable messages, F1 through F10, for sending text 

automatically. To change the text in the 10 messages, go to the File, Settings, Stations, Code Settings window. 

(You can also click the right mouse button over the Message buttons in the Morse Code window to open the 

Code Settings window.) Any special codes from the table above can be used in a message. 

F1 is normally used as a Help key according to Windows convention. CommCat allows you to reassign this 

key for use as a CW message key. To reassign the F1 Help key, go to the File, Settings, Program Settings 

window. Choose the Help tab and then remove the check from the Use F1 As Help option. 

The CW Messages can be sent from most CommCat windows by pressing the associated F-key. The contents 

of the message memories are displayed in the Morse Code window. Each of the CW message keys has a button 

in this window. You can press an F-key, use the Alt+number key, or click one of the CW message keys to 

insert a CW message. 

CW Timing  

Windows is a multitasking operating system, dividing its attention if more than one process is running at the 

same time. The operating system "slices" time to service multiple processes, so it is possible for Windows to 

assign a slice to another program when CommCat expects to have control to start and stop Morse elements. 

CommCat is designed to minimize this timing interference, but interruptions in the CW timing can still occur. 

Many CommCat functions are placed in a standby ("hold") mode when CW is being sent to lessen the chance 

that a timing interruption will occur. For example, communications with your rig stops during a CW 

transmission. The Rig light on the CommCat status bar turns yellow to indicate this paused condition. If you 

notice inconsistent timing, try setting the Slow Computer option on the File, Settings, Program window which 

can help. 

CW Hang 

When CW is being sent from the Morse Code window, the control of background processes in CommCat can 

be further automated to reduce timing inconsistencies. The delay from the time the last CW character is sent to 

the time the background processes are free to resume is called the Hang Time. This delay can be set anywhere 

from 1 second to infinite. This setting is made in the File, Settings, Station, Code window. 

When set to 0, background processes are stopped for as long as the Morse Code window has the focus. Once 

another window gains the focus, the processes are released. If the CW Hang setting is set to 5, background 
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processes are delayed for 5 seconds. When the outgoing CW stops, the CW Hang counter counts down to 0. 

When it reaches 0 the background processes are released. The Hang counter is displayed in the Morse Code 

window status pane. 

The CW Hang counter can be reset by sending a character, pressing the Space bar, or clicking anywhere in the 

status pane. 

A quick way to open the Code settings window is to right-click over the macro keys below the status pane and 

choose Edit CW Messages. 

Farnsworth Spacing 

CommCat supports the Farnsworth method for spacing code characters at speeds below 18 words per minute. 

With the Farnsworth method, when the code speed is less than 18 wpm, the code elements are spaced as if the 

speed were 18 words per minute, but the spacing between characters is lengthened to achieve the desired word 

per minute. Many believe this method makes copying code easier to learn and copy. 

Open the File, Settings, Station, Code window and check the Farnsworth option to enable this timing. 

When you have enabled the Farnsworth method and are sending at speeds less than 18 wpm, the label 

"Farnsworth" appears in the Code window status pane. 

Code Toolbar 

Control Function 

Pause/Start Pause the outgoing code or start it if paused 

Flush Erase all text in the type ahead text box. (Press the Esc key during any CW transmission to accomplish 

the same function.) 

15 Set the code speed to 15 wpm 

20 Set the code speed to 20 wpm 

25 Set the code speed to 25 wpm 

30 Set the code speed to 30 wpm 

Up Increase code speed by 1 wpm 

Dn Decrease code speed by 1 wpm 

1-10 Send message 1 through 10. Program these message by using File/Settings/Station/Code. Note that F1 

is normally the Windows Help key. You can reassign it to CW message 1 (see text). 

PC Tone 

If you are using a Windows '95, '98, or compatible operating system, CommCat can send the Morse code 

through your PC speaker. To enable the PC Speaker, go to the File, Settings, Station, Code window and check 

the PC Tone option. The PC Tone feature is not available in Windows NT, XP or later systems. 

You can also send the Morse Code through your sound card. Select Sound Card in the File, Settings, Station, 

Code window. 
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Contest serial numbers 

In contests where it is necessary to send a serial number as part of the exchange, CommCat can generate these 

numbers for you automatically. The percent crater (%) is used to insert the current serial number into the 

outgoing code. This special character can be used in the Code window or programmed into one of the CW 

memory keys. The starting number for the sequence is set in the File, Settings, Station, Code window. 

If you wish CommCat to use the letter T instead of the number 0 in the serial number, this translation is 

enabled by setting an option on the Code settings window. 

Halt Outgoing CW 

Press the Escape (Esc) key or click Flush to stop outgoing code and erase any data in the Morse Code type-

ahead buffers. To temporarily suspend outgoing Morse Code, click the Pause button on the Morse Code 

toolbar. To restart transmission, click the same button which is now labeled Start. 

During the time Morse characters are being sent, CommCat yields control to the Morse window to preserve 

correct Morse timing. 

Moving the Morse Code Window Out of the CommCat Main Window 

If you wish to move the Morse Code window out of the Main CommCat window, check the Morse Code 

option on the File, Settings, Program, External Window window. This option is useful if you want to display 

the Morse Code window while using another program, or you have a dual monitor system. 

  

Updated 7/2008  
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Quick Log Window 

See also: Log Maintenance, Advanced Log 

 

 

Overview 

The Quick Log is a streamlined data entry window for the station logbook. It provides data fields for call, time, 

date, band, mode, and RST exchanges. The Quick Log is designed for rapid entry and storing of log data, and 

to consume as little screen area as possible. You can set the Quick Log format to horizontal or vertical. 

Data Entry 

The Quick Log fields are filled with information obtained from CommCat. Even though the fields are filled 

automatically, they can be edited to accommodate any necessary changes. Once you are satisfied with the log 

entry, click Save or press the Enter key to save the information in your log. 

Window Formats 

The Quick Log can be displayed in a horizontal or vertical format. In addition, labels for the data fields can be 

shown or hidden. To configure the window format, click the right mouse button when the mouse pointer is 

over the window and select from the menu. 
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Editing Log Entries 

To edit a log entry, open the Advanced Log window by pressing F12 on the keyboard or choose Advanced Log 

from the Tools, Log menu. Use Alt-A to move the cursor to the Call text box and select its contents. Double-

click a row in the log to edit its contents. 

Log Window Format Preference 

Two log window styles are provided in CommCat. Set your preference for the Quick Log or Advanced Log in 

the File, Settings, Station, Log window. The style you choose determines which log window is opened when 

you click the main CommCat log toolbar button. 

Moving Quick Log Out of the CommCat Main Window 

If you wish to move the Quick Log window out of the Main CommCat window, check the Log option on the 

File, Settings, Program, Window Position window. This option is useful if you want to display the Quick Log 

window while using another program, or you have a dual monitor system. 

Saving a QSO 

Press the Enter key to save the current QSO in your log, or click Save. When you save a contact, the 

background color of the Call field turns gray. Any change in the Call field returns the background color to 

white. Note that the Contest Counter does not increment when using the Quick Log. Use the Advanced Log to 

access the Contest Counter for serial number purposes. 

  

Updated 10/2006  
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Advanced Log Window 

See also: Log Report, Log Maintenance, Quick Log 

The CommCat Advanced Log Window is the main window for entering and maintaining all information for 

contacts you have made. See the Quick Log Help topic for a streamlined version of this window. 

 

Overview 

The CommCat Advanced Log window provides a way for you to log, edit, and keep track of contacts you have 

made with other stations. There are no practical limits to the number of contacts or logs you can maintain. 

Logs can be designed to suit your specific needs, showing the data fields you have selected in any order you 

wish. Logs can be kept for different operators, various bands, or contests in which you participate. 

Logbooks are kept in Master Logs. Master Logs are used to maintain completely independent logbooks. You 

can have as many Master Logs as you wish. 

The log window shows all contacts in your log, or the contact history for a specified station. For example, if 

you have worked W1AW on 4 occasions and have entered the contact details in a single log, four entries will 

appear in that log. If you entered the W1AW contacts in several logs, you can view contacts from all logs. 

The Log window contains the call of the station you have worked, his/her name and location, and the log 

details. An optional Comment field at the bottom of the window provides a place to view miscellaneous details 

about the contact. 

Log_Report.htm
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Starting a new log entry 

CommCat provides a number of ways to enter a new contact in the log. Here are a few: 

1. Open the Log window, select the contents of the Call field, then type the new call. 

2. Click the New Call button on the Log toolbar, then type the new call in the Call field. 

3. Double-click any call in the DX Spot Manager window, then open or activate the Log window. The call is 

entered automatically. 

4. When the Advanced Log window has focus, press ESC. 

Checking for previous contacts 

Once you have entered a call in the Call field using one of the techniques above, click Lookup or press the 

space bar to have CommCat check the log using a filter to see if you have had any previous contacts with that 

station. The details of previous contacts are shown in the detail grid. CommCat also looks up the contact in the 

callbook you have selected to complete additional information. 

Additional filter options are provided with the space bar. 

Space Find all contacts matching the characters in the Call field and look up call in Callbook. The call becomes 

for Focus Call for CommCat. 

Shift + Space Find all contacts for the entity associated with the characters entered in the Call field. The Focus Call does 

not change. 

Ctrl + Space Find all contacts matching the characters in the Call field, plus the band and mode fields. The Focus Call 

does not change. 

Alt + Space Find all contacts for the entity associated with the characters entered in the Call field, plus the band and 

mode fields. The Focus Call does not change. 

Contact details are not permanently recorded in the log until the QSO appears in the QSO log. If you enter 

another call in the Call field or close the Log window without logging a contact, the call and any other 

information you have entered is erased. 

If you have enabled Dupe Checking, contacts meeting the conditions you have set are shown with a light red 

bar. See Dupe, below, for further information on setting the conditions to check for a duplicate contact. 

Logging a New Contact 

Once you have decided to log a contact, CommCat provides several ways to complete the details and record 

the information in the current log. 

1. After entering the call for the new contact, press Enter. (The Enter key can be reassigned to look up the 

details for that station rather than log the contact. This choice is made in the File, Settings, Station, Log 

window.) 

2. Click Log Contact or use Alt+L 
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When the contact is logged, CommCat enters the current time as the start time for the QSO. If you wish to set 

the start time before logging the contact, press Ctrl + Enter to freeze the time. This option is useful if you have 

started a QSO, but want to take your time to fill additional data fields before logging the QSO. 

Ending a QSO 

If you wish to log the ending time and date for a QSO you have just completed, select the QSO in the 

Advanced Log Detail Grid and press Shift + Enter. 

Editing a Contact 

 

Changes can be made to existing contacts to correct data, or to add new data. Click Edit in the Advanced Log 

menu bar or double-click any row in the Advanced Log Detail Grid to open the Edit QSO window for that 

contact. Make any changes you wish to the data, then click OK to accept the changes and close the Edit QSO 

window. 

With the Edit QSO window open, click the Next QSO or Previous QSO buttons to move to another contact. As 

you move from one contact to another, the current field in the Edit QSO window remains selected so you can 

easily modify a given field for more than one contact. Click Lookup to fill bank fields from the callbook 

source you have specified. Click Delete QSO to remove the displayed contact from your log. Make the 

window slightly wider if the Delete QSO button does not show. 

Resize the window to suit your preferences. The height and width of the window are retained for the next time 

you open the Edit QSO window. 

The DXCC Number is the value that CommCat uses to determine the associated entity (country) for all 

contacts. If it is necessary to edit the DXCC number, open the DXCC Number List by clicking DXCC Num in 

the toolbar. With the DXCC Number List you can find the right number for this contact. When you move from 

the current log record by closing the Edit QSO window, or by clicking Next QSO or Previous QSO, CommCat 

checks the Country, Continent, CQ Zone, and ITU Zone against the DXCC Number. If it finds a discrepancy, 
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CommCat asks if you want to correct the data. Click Yes to modify the data so it is consistent with the DXCC 

Number. 

To add the mailing address for a QSL card, click the QSL Address field. Click the down arrow button on the 

right side of the field to open a text box for the complete address. See the Label Report topic for additional 

information on printing address labels. 

Editing Multiple Contacts 

The CommCat Logbook Editor provides a way to edit many contacts at once. You can change data in the 

contacts in the current view, or selected contacts. Open the Logbook Editor by clicking the Edit down arrow 

and choosing Logbook. In the window shown below, CommCat is about to add 'Pse QSL, tnx!' to the QSL 

Note field of all selected contacts. 

 

Enter data in any fields you wish to modify. If you wish to delete existing data, use angle bracket characters 

(<>). To limit the changes to selected contacts, place a check in the Use Selected QSO's checkbox. 

Use the Callbook Lookup option to have CommCat use the callbook source to fill fields for every edited QSO. 

The lookup fills the following fields when corresponding data is available from your callbook source: 

1. Name (full or first, depending on your log settings). 

2. QTH 

3. Email 

4. URL 

5. County 

6. State 

7. Country 

8. Continent 

9. QSL address 

10. QSL manager 

11. Grid square 

Label_Report.htm
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If you wish to fill a field in the above list with fresh info you can delete the existing contents using <> and then 

run lookup. Any existing info in a field will not be changed. Be sure to back up your log before running this 

feature in case the results are not what you want. 

When you are ready to apply the changes, click Modify Log Data. The current QSL being edited is reported in 

status bar at the bottom of the window. 

If you wish to clear all data you have entered to start over, click Clear All Fields. 

Selecting Contacts 

You can select one or many contacts in the Advanced Log contact list. To select a contact, click the gray 

column on the far left. The selected contact is displayed with a dark blue background. 

 

Multiple contacts can be selected in the log to perform operations on a group of log records. For example, if 

you wish to export a portion of your log, select the contacts you wish to be included, then use the Filter option 

in the Export window to use only those contacts. 

To select a range of contacts, click selector column on the far left of the detail grid for the first contact you 

wish to include. Find the last contact you wish to be included, and use Shift + Click. 

To add or remove individual contacts to the selection, click the corresponding selector column position using 

Ctrl + Click. To remove a selected contact, use Ctrl + Click to remove the dark blue highlighting. 

To select all contacts in the current log view, select a contact then type Ctrl + A. 

Note that clicking a column other than the selector column does not add that contact to the selection--you must 

click the selector column. Clicking a column other than the left column removes all selections. 

Use the right mouse menu option Show Only Selected to hide all but the selected contacts from the view. 

Operations with selected contacts 

What can be done How to do it 

Delete contacts Press Delete 

Copy contacts to clipboard Ctrl+C 

Paste contacts Ctrl+V 

Cut contacts Ctrl+X 

QSL Click QSL Now button on Adv Log menu bar 

eQSL Click eQSL Send on right mouse menu, or down arrow on QSL Now menu 

Print Dymo labels Click down arrow on QSL Now menu and choose Print Dymo Label (one contact at a time). 

Edit multiple contacts Click the down arrow on the Edit menu button and select Logbook. Check to option on the 

Logbook Editor window Use Selected QSO's. 
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E-mail selected contacts Right-click over the QSO grid and select Email Selected Contacts to include the information 

for the selected contacts in an e-mail message. An e-mail message is prepared and opened so 

you can edit it, accept or change the e-mail address, and send the message. (This function 

requires that you have a MAPI enabled e-mail client, such as Outlook Express, installed on 

your computer.) 

Export Go to File, Export and choose "Selected Contacts" as filter 

Use for new log Copy contacts (or use cut if you want to move the contacts), then paste into new log, or use 

File, Save As window to save selected contacts. 

Print as data report Go to Reports, Log, and use "Selected Contacts" as filter 

Print QSL report labels Go to Reports, QSL Labels, and use "Selected Contacts" as filter 

Deleting Contacts 

You can delete contacts with the Delete key or by using the Edit QSO window. Once contacts are deleted there 

is no way to recover them other than by restoring your log from a backup. You can delete a single contact, 

selected contacts, or all contacts currently listed in the Advanced Log. 

Delete key 

Select a contact or multiple contacts by clicking the selector column on the left side of the QSO list. Press 

Delete to remove the selected contacts. CommCat reports the number of contacts you are about to delete and 

asks permission before proceeding. 

Edit QSO window 

To remove a contact from the log, double-click the QSO Details row containing the contact you wish to delete 

to open the Edit QSO window. Click Delete QSO in the menu bar. CommCat asks you to confirm that you 

want to delete data. (This confirmation is not requested when you have told CommCat to not ask when you are 

about to delete information.) Click OK to close the Edit QSO window. 

It may be necessary to widen the Edit QSO window slightly to see the Delete QSO button. 

You can also click the Edit button at the top of the Log window and proceed as above. 

If you wish to delete all contacts presently displayed in the Advanced Log, open the Delete menu by clicking 

the down arrow on the right side of the Delete button on the Edit QSO toolbar. Click Delete All to delete all 

displayed contacts from the log. CommCat asks for confirmation before proceeding. Once all contacts are 

deleted, the Edit QSO window closes. 

To delete selected contacts from the Log, select the contacts you wish to delete as described above. Choose 

Delete Selected in the Delete QSO menu to permanently remove the contacts. 

Preparing a QSL card 

CommCat prepares a QSL card for a selected contact when you click QSL Now on the Log toolbar. Once the 

card is created, you can print it. If you select more than one card, cards for the entire selection are printed. 

 

 



149 

 

eQSL 

eQSL is an electronic QSL service on the Internet. To learn more about eQSL, visit http://www.eqsl.cc. Your 

eQSL user name (usually your call) and password are entered in the CommCat File, Settings, Station, Log 

window. When these items have been entered and you select a QSO, right click over the detail grid and choose 

eQSL Send to submit the selected QSO to your eQSL Inbox. (You must be connected to the Internet to use this 

feature.) You can also click the down arrow next to the QSL Now menu item to submit the contact. The 

contact is submitted automatically: it is not necessary to log on to eQSL.cc. 

If you wish to submit more than one contact, create an ADIF file using the File, Export window and upload it 

to eQSL. 

CommCat will not submit contacts that have an unsupported band such as SAT. 

eQSL cards you receive can be saved in the CommCat log as described below. Click eQSL Received in the 

right mouse menu to enter eQSL in the contact's QSL Received Via field. 

Print Dymo Labels 

Dymo labels can be printed from the Advanced Log window to confirm contacts. Report grids can be prepared 

for a single QSO, multiple QSO's with a single station, or for QSO's with multiple stations. A sample report 

label is provided with CommCat. This label is designed to hold up to three contacts with the same station. The 

sample QSL label can be modified or you can design entirely new label templates with the Dymo designer 

software. 

Important: Dymo labels are printed with thermal technology that can fade over time when exposed to light. 
The labels are especially sensitive to sunlight and fluorescent lighting. 

To print Dymo labels, install the Dymo software provided with the printer. CommCat then recognizes that a 

Dymo printer is available. Select the Dymo printer option on the Report Settings, Label window. 

 

http://www.eqsl.cc/
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Select the QSL template from the Label Format list and check the option for P to Y management of printed 

labels if you are using this system. 

Select the contacts for which you wish to print labels, then choose Print Dymo Label from the QSL Now 

menu. 

 

CommCat prints labels in the order they are listed in the log. If you are printing labels from a number of 

stations, set the log to callsign order by clicking the Call column header. Doing so will reduce the number of 

labels required since multiple contacts can fit on one label. 

If you wish to design your own label template, use the Designer software provided with the Dymo printer. 

Open an existing label, or create a new one. Click the Designer button on the Dymo Label window to allow 

objects to be modified or created. 

 

Create text objects to hold text that will print on each label, or empty text objects to hold QSO data. Use Edit, 

Object Properties, and Edit, Object Settings to set up the objects. An object must be selected before these 
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options are enabled in the menu. I've found that it is best to disable "Shrink to fit" for objects that will be filled 

by CommCat. 

 

In the Dymo Label Text Settings window, check the option Function as Variable Text Object so the label 

printer will expect text from CommCat. 

Rename the text objects according to the following rules: 

Text Object Name Details 

CALL Station's callsign, printed once per label. 

CALLn Station's callsign, printed once per QSO. 

DATEn QSO Date, printed once per QSO. 

UTCn QSO Time, printed once per QSO. 

BANDn QSO Band, printed once per QSO. 

2WAYn QSO Mode, printed once per QSO. 

RSTn Station's RST signal report, printed once per QSO. 

Replace n with the QSO line number starting with 1. 

CommCat checks any label you have specified to make sure it will contain QSO data. If it doesn't find a text 

object named "DATE", a bad label format is reported. 

Advanced Log Sidebar 

The Advanced Log Sidebar is similar to the sidebar in the DX Spot Manager. To show the sidebar, click View 

in the Advanced Log menu, then Sidebar. To hide the sidebar, click the X in the upper right corner of the 

sidebar, or click View, Sidebar. 

The sidebar contains a number of panels that help filter your log, display qso history, or serve as an operating 

aid. To display a panel, click an icon at the bottom of the sidebar. You can also customize what icons are 

shown by clicking the Customize button on the right side of the icon bar. 

QSO History 

The QSO History panel shows your 50 most recent contacts. The most recent contact is at the top of the list. 

Click a call in the list to see your QSO's with that call. 

Filter 

The Filter panel provides a way to display a subset of your log. This is useful if you want to create a special 

report, or print QSL cards for specific contacts. You can filter contacts using Band, Mode and Dates. The 

filters are cumulative, so you can show contacts on 20M, CW, for Oct 5, 2008. 
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Click a Band button to show all contacts for that band. Use Ctrl+Click to include more than one band. 

Click a Mode button to narrow the list to a mode, SSB, Digital, or CW. Use Ctrl+Click to include more than 

one mode. 

The Date panel shows a calendar that is marked showing your contacts. Click a date to show all contacts for 

that date. Use Shift+Click to select a second date to show a date range. 

To clear all filters, click Clear All on the Band panel. 

Image 

See below. 

QSO Timer, Notes, Unit Converter 

See the QSO Timer, Notes and Unit Converter descriptions in the DX Spot Manager topic. Drag a QSO from 

the log, or a spot from the DX Spot Manager, to include that info in the Notes. 

Images and Photos 

The CommCat log can store one image per QSO. As you scroll through your log, stored images appear in the 

sidebar image panel. 

 

Important: Photos can consume significant storage space causing your log to become quite large. 

Adding Images to the Log 

Images are added to the log by using drag-and-drop or by pasting from the clipboard. QSL card images from 

eQSL or photos on QRZ.com are examples of images that can be easily added to a QSO through drag-and-

drop. Open the Instant Web Page and display the page for the current DX Focus station. If an image is 

available on QRZ.com, a hot link is provided on the Instant Web Page. Click the link and then drag the photo 
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to the Advanced Log Image sidebar pane. It is also possible to drag images from the Info panel in the DX Spot 

Manager. 

A link to eQSL is provided in the Links tab on the Instant Web Page. If you use the eQSL service you can 

display eQSL cards for stations you have worked. Drag the eQSL card image to the Advanced Log preview 

pane. 

When an image is added to a QSO, the Photo field for that QSO is checked. Click the Photo header in the 

detail grid to group together all QSO's that have a photo. 

Since images are stored in the CommCat log they are backed up when you back up the log. The saving of 

images also affects the size of the log. 

Multiple Logs 

The name of the current logbook is shown in the CommCat title bar in parenthesis. For example, if you are 

currently using a log named "Main" in the "W6HN" Master Log, the CommCat title bar will show CommCat 

(W6HN: Main). If you are displaying all logs, new entries will be added to the current log shown in the title 

bar. You may open an existing log or create a new log at any time. To open an existing log, choose Open Log 

from the CommCat File menu. The Open Log dialog box opens, providing a list of existing logs. Double-click 

the name of the log you wish to open. 

Searching for a Previous Contact 

The simplest way to see if you have already had a contact with a station is to enter the station's call sign in the 

Call box, then press the space bar as described above. All contacts for that station are filtered and displayed in 

the log detail grid. 

You can also search using a partial call. For example, to find all contacts with Canadian stations whose calls 

start with VE3, enter VE3* (add a trailing asterisk) in the Call box and press the Space bar. The 

letters/numbers searched are at the beginning of the call. This quick search with VE3 will not find 

K2XYZ/VE3 (but will  find VE3/K2XYZ). This search technique is not available if you have selected the Clear 

Data option when the QSO is logged (File, Settings, Station, Log). 

If you wish a tone to be played when there is the possibility of a dupe, check the 'Sound alert when dupe' 

option in the File, Settings, Station, Log window. The tone comes from a file named ding.wav located in the 

CommCat Audio folder. You can substitute any wav file for this file, after renaming it ding.wav. 

Find QSO window 

The Find QSO window is shown below. This window provides a way to locate a call in your log by searching 

on call sign. Once found, several commonly edited fields can be modified. Log Search uses the current Log 

view. If you wish to search using all contacts in the current log, click All Contacts in the Log toolbar. If you 

wish to search in all logbooks, click All Logs. 

Log.htm
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To open the Find QSO window, click the Find QSO button on the Log window toolbar. The call sign of the 

selected log entry appears in the Find Call box. Change this call sign to reflect the call or part of a call you 

wish to find. 

Click the radio button corresponding to how you want to search, using the Find Call text as the whole call, the 

first part of the call, or appearing anywhere in the call. 

The following search options are provided: 

 Find Locates and selects the first QSO in the log meeting the search parameters. 

 Next Locates and selects the next QSO in the log meeting the search parameters. 

 All  Finds and selects all QSO's meeting the search parameters 

As each QSO is found, it is selected in the detail log grid. Selected contacts can be used as a group when 

exporting a log, printing a log, or creating QSL cards or labels. You can also delete all selected contacts from a 

log. 

As a search progresses the selection bar on the Log window detail grid moves to identify the contact matching 

the search conditions you have specified. If you are finding individual contacts (not All), you can edit the QSL 

Sent and QSL Received status for that contact. Click the Set P-N button to set the QSL Sent status to P(rint) 

and N(ot Received). Save the changes by clicking Save. 

Advanced Find QSO 

Click >> to open the Advanced Find QSO window. 
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The Advanced Find QSO window provides additional search options. These options allow you to search for 

QSO's after or before a given date, containing specified text in the Comment field, from a specified continent, 

using a specified mode or band, and QSL status. Once you have completed the additional search fields you 

wish to use, click Find to locate the first call that matches the conditions you have specified. Click Next to go 

to the next call that matches the conditions. To find and select all QSO's meeting the search parameters, click 

All.  

The Advanced Find QSO window allows you to conduct multiple searches with different parameters each 

time. This ability permits you to select QSO's meeting a variety of conditions. For example, you can search for 

all RTTY and CW contacts on 20 and 15 meters, which don't include North American contacts. The results of 

each search can replace, add to, or subtract from previous searches. Use the list at the bottom of the window to 

choose which action you wish to use. 

Click << to return to the normal view of the Find QSO window, and click Done to close the window. 

When the Find QSO window closes and the search has resulted in one or more QSO's being selected, you are 

asked if you wish to view only the selected QSO's, or all QSO's. If you select All, the selected QSO's are 

highlighted in gray. You can modify the selection by using Ctrl+Click for unselected QSO's you wish to add, 

or selected QSO's you wish to remove. Once you are done, right-click over the detail grid and select View 

Selected from the menu to view only the selected contacts. 

Updating QSL Status 

CommCat supports paper QSL cards, LoTW, and eQSL QSLing. 
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Paper QSL 

As you send and receive QSL cards, one necessary chore is the updating of QSL status for contacts. The 

easiest way to update the QSL status for a contact is to locate the contact in your log, then choose a status 

update option from the right mouse menu. 

 

The options include setting QSL-S and QSL-R to Y, QSL-S to P and QSL-R to Y, setting one or the other to 

Y, or setting the QSL-S status to P. A status of P signifies that this is a contact you wish to confirm either by a 

CommCat QSL card or by a label. When a corresponding card or label is printed, CommCat can convert 'P' to 

'Y' for you. When you change QSL-S or QSL-R to Y, CommCat automatically enters today's date in the Date 

Sent field and/or Date Received field. 

The DXCC Entity Status Window provides a quick way to view the QSL status for the entity of each QSO as 

you scroll through your log. Use the All Contacts selection on the Advanced Log toolbar to show all contacts. 

By watching the DXCC Entity Status window you can tell if a card should be sent for the selected QSO for 

DXCC purposes. To see all contacts for the selected call, return to the call view of the log by clicking All 

Contacts to disengage it. 

Note that you can use any alpha or numeric character to specify QSL sent and QSL received status. However, 

CommCat uses 'Y' and 'N' to compute QSL status for awards. No entry (blank) in either field is interpreted as 

an 'N'. 

eQSL 

When you choose eQSL Send, the selected contact is submitted to the eQSL Inbox, and eQSL is added to the 

QSL Sent Via field in the CommCat log. When you receive an eQSL, select eQSL Received to add eQSL to 

the QSL Received Via field. 

Choose Satellite Mode to have SAT set as the default for the current band. The Band in the data entry pane 

will show SAT, and is displayed in a red font to remind you that CommCat is ignoring any band information 

derived from frequency. Note that contacts with SAT in their band field cannot be submitted to eQSL. 
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LoTW  

CommCat treats QSL's received through the ARRL LoTW (Logbook of the World) system the same as paper 

QSL's. LoTW confirmations can currently be used for DXCC and WAS awards, and support for additional 

awards is planned. CommCat can import LoTW files from the ARRL, and export logged QSO's for upload to 

LoTW. For more information on importing and exporting LoTW data, see the Import and Export topics in the 

Log Maintenance section. 

Imported LoTW confirmations change the QSL Received field for each confirmed contact to Y and add 

'LoTW' to the QSL Received Via field. QSO's exported to LoTW have 'LoTW' added to the QSL Sent Via 

fields for each exported QSO. 

Manual Data Entry 

If you are using CommCat without a radio, or wish to enter previous contacts that aren't in your log, CommCat 

provides a way to enter data manually. When in the manual data entry mode, the text in the data entry boxes is 

shown in red as a reminder. Enter the Receive Frequency to have CommCat use its band plan to complete the 

band, mode, and default signal reports for you. 

To enter the manual data entry mode, click the down arrow next to the New Call button on the Advanced Log 

menu, choose Manual Entry from the right mouse menu, or check the Manual Entry check box in the File, 

Settings, Station, Log window. The manual mode is reset to Automatic when you restart CommCat. 

Satellite Contacts 

Satellite contacts are normally identified by "SAT" in the Band field for a contact. If you are involved in 

satellite operating, you can lock the Band field contents to SAT by clicking Satellite Mode in the Advamced 

Log right mouse menu. 

Tuning your rig to a logged frequency 

Tune your radio to a frequency entered in a selected contact by choosing Tune from the right mouse menu. 

Customizing the Log View 

Contact Order by Sorting 

The log detail grid normally lists contacts in time/date order. The order can be changed by clicking the header 

of any column you wish to use to establish order. For example, to set the log to call sign order, click the header 

labeled Call. The new sort order is temporary. The next time you change the contents of the detail log grid, the 

order is reset to time/date. Click Call again to set the order to the opposite direction. 

You can use cumulative sorts in the detail grid. For example, you can sort by country and then call. To do a 

cumulative sort, click the header of the first column you wish to use. Right-click over the column headers and 

then click OK on the message box that invites you to click a second header. Click the header you wish to use 

as the second sort. 

The log detail grid also can be customized to suit your preferences. The order of fields can be changed, 

columns can be displayed or hidden, and the size of columns can be changed. The changes you make are 

applied to the current log style (see below). 

Log_Maintenance.htm
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Change column width 

To change the width of a column, drag the line in the detail header separating the column from the next column 

to the right to adjust its width. For example, to make the Date column wider, drag the line to the right of the 

column labeled "Date". 

Hide a column 

Columns can be hidden using the Log Style Editor, or interactively. To hide a column interactively: 

1. Right-click over the detail grid and choose Move Columns. 

2. Click the header of the column you want to hide to select it. 

3. Right-click over the detail grid and click Hide Column. 

4. Right-click over the detail grid and click Move Columns to remove the check mark. 

Unhide columns 

Hidden columns can be unhidden in the Log Style Editor window checking the Grid check box for that item. 

Moving columns 

To change the position of a column in the detail grid: 

1. Right-click over the detail grid and choose Move Columns. 

2. Click the header of the column you want to move to select it. 

3. Drag the column header to a new position. 

4. Right-click over the detail grid and click Move Columns to remove the check mark. 

The column order you establish is used for the Log Report and for the relative horizontal position of data 

boxes in the data entry panel. 

QSO History 

The QSO History list shows the 100 most recent contacts you have mde. Click a call in the list to display 

contacts with that station in the QSO Detail Grid. 

Moving Advanced Log Out of the CommCat Main Window 

If you wish to move the Advanced Log window out of the Main CommCat window, check the Log option on 

the File, Settings, Program, Outside Window window. This option is useful if you want to display the 

Advanced Log window while using another program, or you have a dual monitor system. 

Logbook Style selection 

A log style template determines how the log window appears. It determines which data fields are displayed in a 

log, and the order and width of data columns. CommCat provides a standard log template. You can modify a 

style templates or create your own design. You may have different styles for participating in contests, chasing 

an award, or casual DX operation. When you switch from one template to another, log data is displayed or 

hidden depending on the template design. Click Edit Log Style to open the Log Style Editor window. Click 

Style to open a template. Remember that no data is added or lost in the underlying CommCat log when you 

change a template. 

Configuring_CommCat.htm#Window_Position
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Log Styles 

CommCat provides a great deal of flexibility in how the Log window is organized and what information is 

displayed. Using the Log Style Editor, the layout of the Advanced Log window can be customized for different 

awards, contests, and general operating. Each log has a log style assigned to it. The decision of what style to 

associate with a log is made when the logbook is created, but you can change the style of a log at any time. 

You may create as many log styles as you wish. 

To open the Log Style Editor window, double-click the Log window Data Entry panel background or click 

Edit Log Style on the Log window toolbar. 

 

Changing the Current Log Style 

The Log Style Editor opens displaying the current log style. The columns included in the grid are as follows: 

Column Name Description 

Field The names given to data fields. This name appears in the Data Entry Fields panel to the left or above their data 

boxes (an option that can be set). This item cannot be edited--the field names are fixed. 

Grid When checked, this field appears in the Detail Grid. Choose Show All Grid Fields from the Grid menu to 

initialize the grid to show all fields. Choose Hide All Grid Fields to remove them all. 

Default Add a default value (when the field is white) for the field, automatically entered in the log when a new contact 

is logged. In the Serial Sent field, use the number sign (#) to have CommCat enter the current contest serial 

number for this contact. 

Edit Include this field in the Data Entry Fields panel. The color of this column is the same as the color used as the 

background of the Data Entry Fields panel. Choose Show All Entry Fields from the Edit menu to initialize the 

Data Field Entry panel to show all fields. Choose Hide All Entry Fields to remove them all. 
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Line The line number on which the data box appears in the Data Entry Fields panel. The color of this column is the 

same as the color used as the background of the Data Entry Fields panel. The position of the data box relative 

to other boxes on the same line is determined by the Grid column order (see above). 

Dupe When checked, the contents of this field are used when searching the log to see if this station has been worked 

before. Only check boxes with a white background are available for dupe checking. 

Select the Labels Above or Labels to Left option to set the position of data labels in the Data Entry Fields 

panel. Click Background Color to open a color section window to specify the color for the background of the 

Data Entry Fields panel. 

Transmitter and receiver names can be entered as defaults in this window. If both are the same, or only the 

transmitter is entered, CommCat assumes the rig is a transceiver for reporting purposes. Every QSO will 

receive the transmitter and receiver names entered here. If you wish to have CommCat use the current rig (one 

of the 3 rigs CommCat can control through menu selection) for these fields when a new QSO is entered, leave 

the default values blank. 

Saving a Modified Log Styles 

Once you have made changes to a log style, you can save the style for later use. Click Style on the Log Style 

Editor menu bar and choose Save Log Style. You can save the modified log style using a different name by 

choosing Save Log Style As and then specifying the new log style name. 

Opening an Existing Log Style 

Choose Open Log Style from the Style menu to open an existing log style. When the Log Style Editor window 

is closed, the style that is presently in use is assigned to the current log. In this manner it is possible to change 

the style for any log. 

Creating a New Log Style 

Choose New Log Style from the Style menu to create a new log style. (You can also create a new log style 

based on an existing style by using the Save Log Style As option described above.) 

Deleting a Log Style 

Delete the current log style by choosing Delete from the Log Style Editor Style menu. Deleting a log style does 

not delete modify or delete any log data that has used that style. The All Fields style is permanent and cannot 

be deleted. 

Setting Log Style Defaults 

Defaults are values that CommCat will automatically add to a log entry when a new contact is added. Each log 

style has its own set of default values. 

The default values include: 

 Mode 

 QSL Sent 
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 QSL Received 

 QSL Sent Type 

 QSL Sent Via 

 QSL Received Type 

 QSL Received Via 

 QSL Note 

 Serial Sent 

 Serial Received 

 Contest ID 

 Receiver 

 Transmitter 

 Amplifier 

 Transmitted Power 

 Transmit Antenna 

 Heading 

 Receive Antenna 

 Export? 

 Source 

 My Call 

 Propagation Mode 

 Satellite Name 

 Satellite Mode 

 Comment 

Click Set CommCat Defaults to load the following defaults into the named fields: 
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Field Name CommCat Default Value 

QSL-S N 

QSL-R N 

QSL Sent Type Card 

QSL Sent Via Buro 

QSL Received Type Card 

QSL Received Via Buro 

QSL Note 73 es gud dx! 

Receiver From CommCat Rig/Ant Settings 

Transmitter From CommCat Rig/Ant Settings 

Amplifier From CommCat Rig/Ant Settings 

TX Power From CommCat Rig/Ant Settings 

Export No 

Source CommCat 

My Call From CommCat Station Settings 

To clear all default values, choose Clear Defaults from the Defaults menu. 

Log Window Toolbar 

View Open Log Style Editor or show/hide the sidebar. 

New Call Start a new log entry for a new contact. Click the down arrow to set the Manual Data Entry mode. 

Log Contact Log the contact for the specified station. Click the down arrow and then Start Now to freeze the current time as 

the start time for this QSO. After you have entered a start time, log the contact to establish the ending time. 

Lookup Fill the pending contact data boxes with information from CommCat databases, external call sign databases, 

and the GoList QSL Manager database if present. Set the Lookup option in File, Settings, Station, Log to have 

CommCat look up data for every QSO as logged. If the County entry box is used it will be filled for US calls 

when the county is found. Click the down arrow on the County box to change the county to another in the same 

state. 

QSL Now Prepare a QSL card for the selected contact or contacts. Click the down arrow to submit the selected contact to 

eQSL or print a Dymo Label. 

All Logs Show information from all logbooks in the current Master Log, not just the current log. The logs included 

when you select All Logs can be set in File, Settings, Station, Log. If you have created new logs from old, 

using the Log Select option to ignore the cloned log prevents duplicate contacts from being displayed. 

All Contacts Show all contacts in the current log, not just those for the current call. All Contacts is turned off when you 

search for a new call or display selected QSO's. 

Find QSO Open the Log Search window to search for a contact in the current log view. (To search through all contacts in 

all logs, click the All Logs and All Contacts buttons at the top of the Log window.) 

Edit Open the Edit QSO window for the selected contact. Click the down arrow to access a menu providing QSO 

Edit, Log Style Edit, or Logbook Edit. 

  

Updated 3/2009 
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Great Circle Map 

See also: Band Spotter, DX Spot Manager 

 

The CommCat Great Circle Map provides a view of the world making it easy to determine the bearing and 

distance to any point. The map is centered on your location as determined by the longitude and latitude you 

enter in the File, Settings, Station window. 

Land areas are shown on the map in green (except for Antarctica which is gray), while water is blue. Your 

country is shown in red. A bearing key encircles the map, and as you move the mouse pointer, the bearing and 

distance from your home to the mouse pointer are shown in the status bar at the bottom of the window. 

DX Spots 

The most recent DX spots are superimposed on the map. The number of spots, and the color and shape (square 

or round) of spots are determined by rules you establish in the DX Spot Manager. As you move the mouse 

pointer over a spot, the call sign and frequency of the spot are shown as a tool tip. Double-click any spot to 

tune your rig to the frequency for that spot. 

Band_Spotter.htm
DX_Spots.htm
Configuring_CommCat.htm#Station
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Change the maximum number of spots included on the map using the File, Settings, Spots window. 

Resizing the Map Window 

To resize the map window, drag the lower right corner of the window to the size you wish the window to be. 

Redraw the map in the resized window by clicking Resize on the View menu. 

Other View Options 

The Circle Map View menu has options for controlling the information provided on the map. Items such as the 

grayline, spots, and beacon markers can be turned on and off from this menu. 

Moving the Great Circle Map Out of the CommCat Main Window 

If you wish to move the Great Circle Map window out of the Main CommCat window, check the Circle Map 

option on the File, Settings, Program, Window Position window. This option is useful if you want to display 

the Great Circle Map while using another program, or you have a dual monitor system. 

Band Filter 

Choose Band Filter Settings from the Band Filter menu to open the Band Filter window. 

 

Use the Band Filter to reduce the number of spots displayed. You can include spots from the current band, a 

selected band, or a selection of bands. The Band Filter does not use the Rule system. Even though you do not 

see the spots on the Great Circle Map that are hidden by the Band Filter, they remain in the DX Spot Manager 

Rule processing list. To engage the Band Filter, click the Band Filter button on the Great Circle Map toolbar. 

Configuring_CommCat.htm#Window_Position
Configuring_CommCat.htm#Window_Position
Configuring_CommCat.htm#Window_Position
DX_Spots.htm
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Two types of Band Filtering are provided. To make a selection, click the Down Arrow to the right of the Band 

Filter button and then Band Filter Settings. You can limit the spots to the "Current Band" or to a combination 

of specified bands. 

The Current Band option hides all spots in the spot list except those on the same band as your radio. As you 

tune from one band to another, the filtering tracks the current band. 

You can also specify a band or set of bands you wish to monitor. When a band is selected a check mark 

appears next to the band name. Click a band name to add or remove a check mark. If a band has a check mark, 

spots on that band are not displayed. 

The Band Filter settings in the Great Circle Map window also apply for the DX Spot Manager. 

Antenna Rotor control 

The Great Circle Map provides commands to antenna rotor controllers. The current direction of the antenna is 

shown by the two radial yellow lines. Buttons on the Map toolbar are used to control the rotor. 

To rotate your antenna to a DX station's bearing, double-click any DX spot, then click Go DX on the Great 

Circle Map toolbar (or press F11). When you double-click a spot, your radio is tuned to the spot frequency. 

You can also double-click any point on the map not associated with a spot to set a bearing. Finally, you can 

right-click on any location on the map and choose Rotate Here from the menu. 

The rotor controller determines the direction the rotor must turn to move to the correct bearing. Click Long on 

the Map toolbar (or press Ctrl + F11) to rotate the antenna to the DX station's bearing using the long path. The 

Rotor menu on the Map toolbar also has buttons to turn the rotor in either direction. Stop the rotor at its current 

position by clicking Stop on the Map toolbar, or by pressing Alt + F11. 

Antennas and associated rotors are configured in the File, Settings, Radio/Ant window. Each ham band has 

one preferred antenna assigned. If that antenna has a rotor, the rotor controls on the Map window are enabled 

and the radial direction lines are displayed. Antenna and rotor status are displayed in the status bar on the Map 

window. Up to 3 rotors can be assigned in CommCat, and each rotor can have more than one antenna. 

As an antenna rotates, the radial lines on the map move to show its approximate position. The radial lines may 

dither slightly due to noise in the rotor position measuring circuitry. The rotor bearing must change by at least 

5 degrees before the bearing change is shown on the Great Circle Map. If the bearing change is less than 5 

degrees, the radial lines may not move. 

Grayline 

The grayline shows the current dusk/dawn line. In other words, the grayline shows the transition between night 

and day on the map. Often times radio propagation is enhanced between two points along the grayline. 

The night-to-day transition is shown in red, while the day-to-night transition is shown in black. The region in 

the world where it is night is shaded with gray diagonal lines. 

The grayline is drawn when the map is centered on your "home" location. If you have shifted the center of the 

map to another location using the right mouse menu, the grayline is not drawn. The grayline is enabled on the 

File, Settings, Spots window. 

Configuring_CommCat.htm#Radio
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As time passes, the position of the grayline changes to reflect the new relative position of the earth and sun. 

Use the Refresh button on the Map toolbar to update the grayline manually. 

Detail maps 

A number of high resolution detail maps are provided with the CommCat Gold version. (If you have not 

installed the maps on your system, this section does not apply.) To see a regional map for an area of interest, 

move the mouse pointer over the part of the world you want to see, click the right mouse button, and choose 

Detail Map. 

Copying the Map to the Clipboard 

Copy the map image to the clipboard by choosing Copy from the CommCat Edit menu. Once on the clipboard 

you can paste the map image into any document that can accept clipboard images, including a QSL card design 

or word document. 

Right Mouse Menu 

Additional map functions are accessible through the right mouse menu. The menu is shown below. 

 

Rotate Here Rotate the present antenna to the mouse position 

New Map Redraw the map using the current mouse pointer position as center. 

Go Home Restore the map center to the longitude and latitude specified in File, Settings, Station, Station. 

Instant Web Create an Instant Web Page for the spot identified by the mouse pointer. (This menu option is disabled if the 

mouse pointer is not over a spot marker.) 

Detail Map Display a detailed map of the region identified by the mouse pointer position. 

Time Zones Display the world time zone map in a new window. 

World Political Display the world political map in a new window. 

  

Updated 10/2006  
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Band Spotter 

 

Overview 

The Band Spotter window shows spots close to your current frequency. The spot colors are determined by 

rules in the DX Spot Manager that set spot background colors. The band Spotter gets spot information from the 

DX Spot Manager. Spots from the current folder are used. For example, if you select the Inbox DX Spot 

Manager folder, all spots are shown. If you set up a rule to move spots to a different folder, you can select that 

folder to show its spots. To display spots, the folder must be a sub folder of the Inbox, or be a Band Edge 

folder. 
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Multiple Windows 

You may open as many Band Spotter windows as you wish to monitor band segments, or provide views of the 

same band with different resolutions. Click Hold on the Band Spotter toolbar to freeze the center frequency of 

the Band Spotter window so that the frequency coverage is held constant when you tune your radio. The 

settings for each window are independent. 

To open a new Band Spotter window, click the Band Spotter button on the toolbar, or Band Spotter in the 

Tools menu 

 

Bandwidth 

Click the View toolbar button to set the bandwidth for the Band Spotter window. Bandwidths from +/- 1 to +/- 

100 kHz can be selected. 

Stacking 

When multiple spots are close to each other in frequency, they can overlap. Click the Stacking button to spread 

them apart. 
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Tuning 

Double-click a spot to tune to the frequency of that spot. Double-click anywhere on the Band Spotter window 

to move to a desired frequency. 

Additional Information  

Choose Call Only or Extended Data from the View toolbar menu to determine the amount of information 

shown with each spot. Drag the right side of the Band Spotter window to allow additional data to show.  

When you have specifed your license class in File, Settings, Station, the Band Spotter shows the portions of 

the band where you can operate. The image below shows the lower end of 40 meters for the General class 

license (US). 

 

Changing the Band Spotter Fonts 

The font used to show the spots can be changed in the View menu. You can also change the font from normal 

to bold. 

Moving Band Spotter Out of the CommCat Main Window 

If you wish to move the Band Spotter windows out of the Main CommCat window, check the Band Spotter 

option on the File, Settings, Program, Outside Window window. This option is useful if you want to display 

Band Spotter windows while using another program, or you have a dual monitor system. 

  

Updated 3/2009  
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Instant Web Page Window 

Overview 

 

The Instant Web Page displays a customized web page from the perspective of the Focus DX call. The pages 

shown above has been created for GB0U. CommCat obtains information for the web page from a number of 

sources, organizes the data into folders, and displays the results in the Instant Web Page window. The Spots 

and DX News items are available with CommCatLive. 

Once the page is built, the information can be displayed by clicking the Personal, Local Weather, Country Info, 

Maps or Links tabs. The Web Page header includes the Focus DX call sign, the location of the Focus DX 

station, and if you are using CommCatLive, the country flag for the country. The table below summarizes the 

data in the Instant Web Page folders. 

Tab Contents Source 

Personal Details for the license holder of the Focus DX 

callsign. The amount of data shown depends 

Callbook source specified in the Settings, Station, 

Callbook window. CD-ROM or Internet sources can be 
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on the source. Audio clip, e-mail and home 

page links are provided when available. 

specified for US and non-US call signs. The sample above 

used the QRZ Subscription service, which includes a 

photo when available. Spot history comes from 

MyQSX.net and the DX News from the ARRL. 

Local Weather Current weather conditions for the location of 

the Focus DX Call station. For non-US 

locations the weather report is normally for the 

capital or a major city in the country. (Click 

the Sun button on the Instant Web Page 

toolbar to gather the weather information.) 

 

US National Weather Service (including international 

weather) via the Internet. The coordinates of the Focus DX 

Call licensee are used to find the nearest active weather 

station. 

Country Info Background for the Focus DX Call licensee's 

country, including historical, economic, 

geographic, and political facts. Only available 

in the CommCatLive version or with a (free) 

QSXer account. 

CIA World Fact Database linked from CommCatLive. 

Maps A variety of maps, including a local (country) 

map of the current Focus DX Call licensee's 

location. Only available in the CommCatLive 

version or with a (free) QSXer account. 

CIA World Fact Database linked from CommCatLive. 

Links Miscellaneous Internet links CommCat 

Specifying a Call 

 When the Instant Web Page window is first opened, the web page for the current Focus DX Call is 

shown. If the window is already open, but not the active window, click the window to bring it forward 

and click the Refresh button on the toolbar to display the web page for the Focus DX Call station. 

 To specify a call that is not the Focus DX Call, type the desired call sign in the Lookup box on the 

Instant Web Page toolbar and press Enter. This procedure also sets the Focus DX Call to the call sign 

you have entered. 

 From the DX Spot Manager window, select Instant Web Page option from the right mouse menu to 

open the Instant Web Page for the call that is selected in that window. 

 In File, Settings, Program, Environment, check the option Refresh Instant Web Page when DX Focus 

Call changes, to have the Instant Web Page refreshed automatically. This option is handy if you are 

using CommCat with another program, such as MixW, and wish to have the Instant Web Page show 

details of the current call in that program. 

Personal 

The Personal page contains detailed information about the DX station. The amount of information depends on 

the information provided by the callbook source you have chosen in File, Settings, Station, Callbook. The 

information forGB0U, shown above, was obtained through CommCat's direct Internet connection to the 

QRZ.com Subscription service. 

The distance and bearing to the DX station is computed using the geographic coordinates of your location and 

the location of the DX station. The distance is approximate when the exact coordinates of the DX station are 

not found in the callsign database. When this happens, the coordinates for the center of the DX country are 

used. 
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In addition to the data show above, the personal data can include grid zone, license class, previous call, notes 

you have entered for this station in CommCat's Notepad, and trustee for club stations when this information is 

available. 

If biographical text is found for the DX station, it is displayed next. 

The two buttons below the Personal Information line indicate that an e-mail address and QSL manager are 

available for a station. Other buttons, not shown, are also available to show the presence of a photo, home 

page, audio clip, and biography. Click any button to open the DX Clip page to listen to the station's audio, 

display information, or to send an e-mail to the DX op. You can also click the underlined information below. 

If a contact with the station shown in the Instant Web Page is selected in the Advanced Log window, clicking 

e-mail prepares a message thanking him/her for the contact, including the contact details. 

The DX Notes and Spots items in the Instant Web Page are available with CommCatLive. 

Local Weather 

CommCat Local weather data is obtained from the United States National Weather Service (NWS) through the 

Internet. The NWS also provides limited weather conditions for most countries in the world. 

CommCat uses the geographic coordinates for the DX station to find the closest active weather station. For US 

stations, the ZIP code is used to find the geographic coordinates if the callsign lookup does not produce 

coordinates. Because there are many active weather stations in the US, a report for a fairly close location can 

be expected. 

Because the geographic coordinates for most DX stations are not available, the center of their country is used. 

Depending on the size of the country, the closest weather station can be some distance from the actual location 

of the DX station. 

To find your own weather conditions, click Home on the Instant Web Page toolbar. Next click the Sun button 

on the toolbar. CommCat searches the list of NWS locations, finds the closest one to you, then obtains the 

weather for that site through the Internet. 
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Country Information  

Detailed background information for most countries of the world is provided with CommCatLive. This data is 

taken from the CIA World Fact database provided by the US Government. Changing political and economic 

conditions in the world can rapidly outdate information about any country, so use the data with care. If 

information is not available for the entity of the Focus DX call, CommCat provides a message to explain. 
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Maps 

 

Option Contents Notes 

Local Map Local country maps are provided for most countries 

in the world. Major cities are also shown on each 

map. 

Use the Back button on the Instant Web Page toolbar to 

return to the map selection page. 

Large Flag A large version of the country flag showing details. This is the same flag, with more detail, shown in the 

Instant Web Page header. 

Large Map Map showing the continent in which the DX 

country is located 

See Working with Maps, below. 

World Political Political map of the world See Working with Maps, below. 

Time Zones Time zone map of the world showing political 

boundaries and DX prefixes 

Use the Master Prefix for the DX Country shown on the 

status bar at the bottom of the Instant Web Page window 

to search for the desired country. 
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Working with Maps  

The maps provided with CommCatLive are contained in either PDF (Portable Document Format) or JPG files. 

PDF files are viewed with Adobe Acrobat viewer. If you do not have a viewer installed on your system, one is 

available from Adobe at their web site. 

You must have a CommCatLive account for this feature to be functional. 

The Acrobat viewer toolbar contains options for printing, moving, magnifying, and searching for text on the 

map. The Time Zone map has call sign prefixes for each country allowing you to search for a country by 

prefix. Each country normally has more than one prefix--use the Map Key prefix in the lower right status bar 

on the Instant Web Page window. Use an asterisk (*) as the first character in the prefix so CommCat will know 

you are searching for a prefix and not an arbitrary combination of letters that may appear elsewhere in the map. 

For example, to search for G (England), click the Binocular button on the Acrobat toolbar and enter *G in the 

text box. Click the Find button to locate the specified prefix. The prefix *G is highlighted on the map. If you 

search for a prefix with the map magnified to show greater detail, the map view will re-center itself on the 

prefix that matches your search criteria. 

To return to the map selection page, click Back on the Instant Web Page toolbar. 

Links  

The Links page contains miscellaneous Internet links provided with CommCat. Click a link button to open the 

respective Web site. 

Toolbar 

Back 

Return to the previous page. 

Forward 

Return to the next page. 

Stop 

Stop all Internet activity. 

Refresh 

Redo the Instant Web Page for the current Focus DX Call. 

Home 

Return to your own Instant Web Page. 

Weather 

Obtain weather conditions for the Focus DX Call from the Internet. 

http://www.adobe.com/
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Lookup 

Specify a new call sign to display in the Instant Web Page. 

Google Map 

Google maps are displayed on each Instant Web Page, centered on the coordinates of the DX station. The 

coordinates are taken from the callbook source you have specified. If coordinates aren't found CommCat 

estimates the location from the callsign. 

Audio Clips 

CommCat checks the CommCatLive audio library for audio clips for each DX call. It is not necessary for you 

to have a CommCatLive account for this feature. If an audio clip is found, the audio file icon is shown at the 

top of the Instant Web Page. Click the icon to open the CommCatLive DX Audio Clip library to play the clip 

or clips foun there. 

Moving Instant Web Page Out of the CommCat Main Window 

If you wish to move the Instant Web Page window out of the Main CommCat window, check the Instant Web 

Page option on the File, Settings, Program, Outside Window window. This option is useful if you want to 

display the DX Spot Manager window while using another program, or you have a dual monitor system. 

  

Updated 7/2008  
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Internet Cluster 

See also: DX Spot Manager 

  

Overview 

The Internet Cluster window displays DX spots and associated information from an Internet Cluster, such as 

the popular OH2AQ DX Summit. Through this window you can view spots, WWV propagation reports and 

announcements. Web spots are also sent to the DX Spot Manager window. It is not necessary to have the Web 

Cluster window open to receive and process spots in the DX Spot Manager window. 

It is not possible to set the Focus DX call from the spot list. Click Tune to set the Focus DX call to the most 

recent spot. 

Spots Tab 

The spots shown in the Spots tab are displayed in the format provided by the Internet Cluster. This standard 

format includes columns for the call sign of the station providing the spot, the frequency, the DX call, a note, 

DX_Spots.htm
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time in UTC, and Date in UTC. Internet connection status reports are displayed in the bottom status bar of the 

Internet Cluster window. 

Automatic refreshing is set through the File, Settings, Spots window. Refresh the spot list manually by clicking 

Get DX in the Internet Cluster menu bar. 

WWV Tab  

WWV sunspot and propagation reports are displayed in the WWV tab. The WWV report is refreshed by 

clicking Get Prop on the menu bar. 

Announcements Tab 

Display the chatter from other DX operators in this tab. The Announcements tab is refreshed by clicking Get 

Ann in the menu bar. 

Stopping an Internet Request 

If your request for spots, WWV announcements or Announcements is taking too long, click Cancel on the 

toolbar to stop the request. 

Making a DX Spot Announcement 

Click the Announce button on the toolbar to open the Send DX Spot dialog. Enter the call, frequency, and note 

in the text boxes, then click OK. The spot is sent directly to the Internet Cluster site where it will appear in the 

spot list the next time the list is updated. Note that spots originating through the Internet have "-@" appended 

to the call sign of the reporting station. 

The Send DX Spot dialog is opened from other windows using Ctrl + S. As opposed to sending spots from 

other windows where there are additional options, spots sent from the Internet Cluster window only go to the 

Internet Cluster (and not to other optional destinations such as Telnet). 

Internet Cluster Window Settings 

Connections to the cluster site are defined in the Internet tab of the File, Settings, Spots window. The font used 

in the folders can be changed in the File, Settings, Program window. You can also change the height and width 

of the Internet Cluster window to suit your own preferences. These changed are retained and used the next time 

the window is opened. 

  

Updated 10/2006  
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Packet Cluster 

See also: DX Spot Manager 

 

Overview 

The Packet Cluster window displays DX spots and associated information from a Packet Cluster. Through this 

window you can view spots, WWV reports and announcements. Packet spots are also sent to the DX Spot 

Manager window. It is not necessary to have the Packet Cluster window open or to be connected to the packet 

node to receive and process packet spots in the DX Spot Manager window. (Even though it is not necessary to 

connect to the Packet Node, it is best to connect so you can contribute your own spots to benefit others.) 

Connecting to the Packet Node 

Connecting to a DX packet node requires a TNC (Terminal Node Controller) and VHF or UHF radio capable 

of reaching a packet node near you. See the TNC Connections Help topic in Getting Started for more 

information on configuring your station. 

When CommCat has connected to the TNC, the TNC status light in the CommCat main window is yellow. 

Once you have successfully connected to the packet node, this indicator turns green. Click the Connect button 

on the Packet Cluster toolbar to connect to the packet node. 

 

DX_Spots.htm
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Spots Folder 

The spots shown in the Spots folder are displayed using Packet Cluster format. This standard format includes 

columns for the call sign of the station providing the spot, the frequency, the DX call, a note, time in UTC, and 

Date in UTC. 

Spots are displayed automatically as they arrive from the packet node. You can obtain a list of the most recent 

spots by clicking DX on the Packet Cluster toolbar. 

WWV Folder  

 

WWV sunspot and propagation reports are displayed in the WWV tab. The WWV report is refreshed by 

clicking WWV on the toolbar. A sample WWV report is shown above. 

Personal Messages 

It is possible to send personal messages to other operators whose stations are connected to the Packet Node. 

Messages sent to you are displayed in the Personal Messages folder. 

Showing Current Users 

Click Users on the Packet Cluster toolbar to have the packet node provide a list of the users currently 

connected. 

Making a DX Spot Announcement 

Click Announce on the toolbar to open the Send DX Spot dialog. Enter the call, frequency, and note in the text 

boxes, then click OK. The spot is sent directly to the Packet Cluster node where it will appear in the spot list 

the next time the list is updated. 

Packet Cluster Window Settings 

Connections to the Packet Node are defined in the Packet tab of the File, Settings, Spots window. The font 

used in the tabs can be changed in the File, Settings, Program window. You can also change the height and 

width of the Packet Cluster window to suit your own preferences. These changed are retained and used the 

next time the window is opened. 

Disconnecting from the Packet Node 

Click Disconnect on the Packet Cluster toolbar to disconnect from the packet node. 
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Telnet 

See also: DX Spot Manager 

 

Overview 

The Telnet window displays DX spots and associated information from a Telnet site. Telnet spots are also sent 

to the DX Spot Manager window. 

Connecting to the Telnet Site 

The use of a Telnet site requires that your computer be connected to the Internet. 

Once you have specified a site, CommCat automatically connects to that site when the Telnet window is 

opened. 

Click Connect on the toolbar to connect to a Telnet site. Up to four Telnet URL's can be specified in the File, 

Settings, Spots, Telnet window. Click one of the four sites on the menu to connect. If you have specified a Call 

Prompt in the settings for the site you are using, CommCat will send your call to the site when the prompt is 

received, completing the log on process for you. The normal prompt sent by the Telnet site as you are logging 

on is "Please enter your call:". 

The Telnet server invites you to enter your call. If you don't have a Call Prompt which results in your call 

being inserted automatically, type your call in the Message Area at the bottom of the window and press Enter. 

If this is the first time you have connected to the Telnet site, you will be asked for additional information, such 

as your name. Answer the questions in the Message Area and press Enter to send them to the site. Once the 

registration is complete, spots appear in the Telnet Spots panel. 

When CommCat is connected to a Telnet site, the Telnet status light in the status bar at the bottom of the 

CommCat main window is green. 

Maintaining a Connection to the Telnet Site 

When connected to a Telnet site it is possible for the connection to be broken, which stops incoming spots. 

CommCat has a KeepAlive option that monitors incoming data. If no spots arrive for approximately 2 minutes, 

DX_Spots.htm


182 

 

CommCat sends a query to the site asking for a response. If a response isn't received, CommCat goes through a 

reconnection cycle to once again establish the data flow. This feature is enabled using the File, Settings, Spots, 

Telnet window. The Telnet window must be open for this feature to work. 

Telnet Window 

The spots in the Telnet window are displayed in the format provided by the Telnet site. This standard format 

includes columns for the call sign of the station providing the spot, the frequency, the DX call, a note, time in 

UTC, and Date in UTC. 

Spots are displayed automatically as they arrive from the Telnet site. You can obtain a list of the most recent 

spots by clicking DX in the Show menu on the toolbar. 

Showing Current Users 

Click Users in the View menu on the toolbar to have the Telnet site provide a list of the users currently 

connected. 

Making a DX Spot Announcement 

Click Announce on the toolbar to open the Send DX Spot dialog. Enter the call, frequency, and note in the text 

boxes, then click OK. The spot is sent directly to the Telnet site where it will appear in the spot list. 

Telnet Window Settings 

Connections to the Telnet site are specified in the Telnet tab of the File, Settings, Spots window. The Telnet 

window font can be changed in the File, Settings, Program window. You can also change the height and width 

of the Telnet window to suit your own preferences. These changes are retained and used the next time the 

window is opened. 

Disconnecting from the Telnet Site 

Click Disconnect on the Telnet toolbar to disconnect from the Telnet site. 

DXTelnet 

CommCat can be configured to work with DXTelnet. DXTelnet can connect to multiple Telnet sites 

simultaneously, and feed spots to CommCat. See the Accessories Help topic for more information. 

View Options 

The black Information Panel at the top of the window and the status bar at the bottom of the window can be 

hidden to reduce the amount of screen space required. Click View in the Telnet toolbar to change the settings. 

Updated 10/2006  
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DXCC Tracking  

DXCC Summary 

View the current status for DXCC awards with the DXCC Summary window. 

 

The DXCC Summary window shown above reports that there are 334 possible active entities. This number 

will change as active entities are added to the list and deleted entities are removed. Choose the award you wish 

to check from the Award drop down list. 

Click All Logs to show the results for multiple logs (selected in File, Settings, Station, Log) instead of the 

current log. This option allows you to maintain the status of special logs, such as QRP, or one used for portable 

operation. 

The equivalent status for deleted entities is displayed by clicking Deleted. Click Show to refresh the status 

when you make a change in the options. 

Entity Status Grid Window 

The Entity Status Grid provides a way to determine the QSL status for all stations worked in any entity. 
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The Entity Status Grid window displays a list of all entities in alphabetical order. The order can be set to 

Prefix, Entity Name, DXCC Number, Worked, Pending, or Confirmed by clicking the header at the top of each 

column. Each time you click a header, the order is reversed. The DXCC column is the DXCC reference 

number associated with each entity. 

The numbers of stations worked, QSL's pending, and contacts confirmed are shown in the three columns. By 

clicking one of the three cells associated with an entity, a list is displayed showing all call signs that apply to 

the Worked, Pending or Confirmed column. Click a call to open the Advanced Log window displaying 

contacts for that call. Choose All to display all Worked, Pending, or Confirmed contacts for the entity in the 

Advanced Log window. 

Choose the Band and Mode you wish to display. For example, select 20M and Mixed to display QSL status for 

contacts on the 20-meter band. Select 15M and Phone to show the status for Phone contacts on 15. Click 

Refresh to calculate the QSL statistics when you have changed the Band or Mode. 

Use the Status drop down list to filter the list depending on QSL status. The options include All, Confirmed, 

Needed, Pending, Not Pending, Worked, and Not Worked. Pending computes the status for entities that have 

been worked, and for which you have sent a QSL. Not Pending displays entities you have worked, but haven't 

sent a QSL. The number of entities found for the Status you have selected is shown at the bottom of the 

window. 
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The contents of the Entity Status Grid are updated by clicking Refresh. If you change logs or have changed the 

contact status for an entity, you can display the revised statistics by using Refresh. While the statistics are 

being collected by CommCat, a bar shows the progress as entities are analyzed. 

You may show the statistics for the current log or for all logs. To display the statistics for all logs, click All 

Logs. CommCat proceeds to find the entity totals for contacts in all logs. To see the results for entities that are 

no longer active, click Inactive. 

The contents of the DXCC Entity Status Grid can be printed by clicking Print Preview on the File menu, or 

choosing Print Preview from the menu that is opened by right-clicking over the grid. You can select two or 

more rows to print. To select multiple rows, use Ctrl-Click. To select a range or rows, click the first row you 

wish to include, then Shift-click the last row in the range. 

Open the Entity Editor for any entity by double-clicking a row, or choose Edit Entity from the right mouse 

menu. 

DXCC Entity Status 

Open the DXCC Entity Status window to see the DXCC details for the entity of the Focus DX call or for any 

entity selected in the entity list. The current band is shown by the black frame. Each of the DXCC awards and 

endorsements are shown for the entity, along with the Worked/QSL Sent/Confirmed status. The view below 

shows that Faroe Island has been worked on then current banf, 17 meter CW, bt not confirmed. A QSL has not 

been sent for this contact. 
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The DXCC Entity Status window shows the status for the entity, band and mode of the DX Focus Call. If you 

double-click a spot in the DX Spot Manager spot list, the entity status for that spot is displayed. 

The entity list provides a fast way to check the status for many entities. Type the first letter of the entity you 

wish to report, such as M for Mongolia, to move rapidly to that location in the list. The list is normally in 

entity order, but you can change it to prefix order by clicking the prefix header at the top of the prefix column. 

When the list is in prefix order, the first letter you type takes you to the matching prefix. 

You may also enter the call (or prefix) in the lookup box to determine the status for that entity. 

Click All Logs in the View menu to see the DXCC entity status for multiple logs you have specified in File, 

Settings, Station, Log.. 

If the contact qualifies for the QRP DXCC award, the QRP annunciator changes from white to green. 

(Confirmation is not required, and the entity can be worked on any band or mode to qualify.) 

 

The size of the DXCC Entity Status window can be made smaller to conserve screen space. Remove the entity 

list through the View menu or right-click over the window and choose Next Size to change the size from large 

to small. Repeat the procedure to return the view to the large window. The size of this small version can be 

changed by dragging the right edge of the window. 
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Using the DXCC Entity Status Window with the Advanced Log 

Double-click any colored square to open the Advanced Log window to display all contacts that apply to that 

entity, band, and mode. This feature is useful if you spot a band/mode for an entity that you have contacted but 

you haven't sent a card. 

When All Contacts are displayed in the Advanced Log, the DXCC Entity Status window tracks the entity for 

each contact as you scroll through your log. This provides a quick way to look for needed cards. 

Moving DXCC Entity Status Out of the CommCat Main Window 

If you wish to move the DXCC Entity Status window out of the Main CommCat window, check the DXCC 

Entity Status option on the File, Settings, Program, Window Position window. This option is useful if you 

want to display the DXCC Entity Status window while using another program, or you have a dual monitor 

system. 

DXCC Logging 

SSB, USB, LSB, FM, and AM contacts are included in the DXCC statistics for Phone modes. Satellite contacts 

must have a satellite name entered in the Sat Name log field to be counted. 

DXCC Award  

CommCat provides a powerful and easy-to-use facility for keeping track of your DXCC Award status. 

 Track DXCC Award status for any log or all logs. 

 Easily update DXCC Status for previously submitted QSL's using a Log View. 

 View and edit the status for any DXCC Award including QRP and Millennium. 

 Prepare the ARRL application and Record Sheets, including the proper arrangement of cards that 

confirm multiple contacts. CommCat even fills in the ARRL award matrix for you! 

 Import LoTW confirmations from the ARRL and export logged QSO's and send to the LoTW system. 

The LoTW system eliminates the need for paper QSL confirmations for the DXCC award. When you apply for 

an award you may submit cards for which you do not have LoTW confirmation. The following instructions 

apply to those QSO's you must confirm with cards. 

When you are ready to submit cards to the ARRL for DXCC Awards use the DXCC Award window. The 

DXCC Award window provides tools to organize, track, and print the necessary forms for all DXCC Awards, 

including the 5-Band DXCC, QRP, and Millennium certificates. The DXCC Award window is shown below. 

Even though you can submit as many cards to the ARRL as you wish, there is a price to pay in the form of 

added charges if you go over their limits. Be sure to review the ARRL requirements which are summarized on 

the Application form. It is also noteworthy that the ARRL keeps track of cards you have submitted and credits 

all applicable awards even though you may not be submitting a card for that award. For example, if you have 

several 40M cards in a submission for the Mixed award, the ARRL credits you with those cards for 40M. If 

you wish to apply for the 40M award in the future, it is not necessary to resubmit those cards. 

The DXCC Award window contains a toolbar at the top, the QSO list section, the Award list section, and a 

status bar. In the view above, the first panel in the status bar shows the number of active entities and the 

number of deleted entities (active/deleted). These numbers will change depending on options chosen in the 

View menu, and whether or not you are viewing a composite award list. 
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8 Steps to Prepare a Submission 

1. Open the DXCC Award window and select Use All Logs on the View menu to use your entire log, or 

leave unselected to use the current log. 

2. Open the Log View from the Award list to identify all QSO's previously submitted. 

3. Open each Award list you wish to use from the Award list and click Auto Select to have CommCat 

find the latest confirmed contact for each entity. 

4. Make manual adjustments where necessary to select alternate cards (see below). 

5. Open the Composite view from the Award list. 

6. Specify Multi QSO's (more than one submitted QSO on a QSL card). Multi cards must be listed at the 

end of the form, a chore CommCat handles for you. 

7. Preview and print the ARRL Record Sheet (Reports, ARRL Forms). CommCat will ask to mark all 

QSO's in the list as submitted. 

8. Preview, edit and print the ARRL Application (Reports, ARRL Forms). 

Confirmations and Entities 

Confirmed contacts are submitted to the ARRL, via LoTW or by sending QSL Cards, to receive credit for 

entities worked. If by QSL Card, the card is checked, and the ARRL credits the entity to all awards to which 

the card applies. If by LoTW, the checking and crediting is automatic. From then on it can be argued that it 

doesn't matter what card or contact was submitted, only that the entity has been confirmed. Any confirmation 

that meets the mode and band details that have been credited can be tagged as "submitted" so CommCat will 

not use that entity/band/mode in future submissions. 

Even though you may be submitting confirmations for a subset of the possible awards, it is important to select 

as many cards as possible for all awards so CommCat can credit entities in the same way as the ARRL. The 

ARRL provides updated listing of entities by award, so it is easy to use the DXCC Award Log View to update 

your submitted data in the future. 

CommCat uses a three pass search for confirmed QSO's to use for awards. In the first pass, the cards are drawn 

from submitted contacts in existing award lists. The second pass adds contacts that are in an existing award 

list, but have not been submitted. The third pass fills in QSO's from your log. The purpose of this approach is 

to reuse confirmations as much as possible to reduce the number required for any award. 

Log View 

Use the Log View, selected from the Award list, to update your log with the Submitted status for any QSO's 

you have previously submitted to the ARRL for DXCC credit. 



189 

 

 

The Log View displays all Confirmed QSO's in the current log (or All Logs). Check boxes are provided for all 

DXCC Awards. By checking an Award box, CommCat credits that entity with that award. Future submissions 

for that Award will bypass any entity for which a QSO is marked "submitted". 

Double-click a QSO to have CommCat fill all check boxes appropriate to that contact. For example, if you 

double-click an RTTY 20M QSO, CommCat will fill the Mixed, RTTY and 20M check boxes. These 

selections override previous check box settings since only one entity/band/mode submission is possible. For 

example, if you've previously set an RTTY 20M contact for Canada as submitted, when you double-click 

another Canadian RTTY contact on 15M, CommCat will use this new contact for the Mixed and RTTY awards 

for Canada. 

If you double-click an entity, then clear the check boxes, CommCat retains that QSO for future submission 

purposes. This technique provides a quick way to specify which cards you wish to use for each entity. 

Click a column header to set the order of the Log View to that item. To see all Mixed submitted QSO's click 

the Mixed header. As you move the mouse pointer over the list, CommCat tells you the number of that QSO in 

the list in a tool tip. It is easy to check the number of submitted QSO's for each award in this manner. 

CommCat determines entities by the DXCC reference number. Contacts that have a blank entity field probably 

do not have an assigned DXCC Number. To go to the Log entry for that contact, select the contact and right-

click. Choose Show Log for this Call from the menu. 

Award QSO List 

The Award view is available for all DXCC Awards, including the QRP and Millennium awards. The Award 

view shows the details for each entity including the submitted status and date, and the checked status and date. 

The checked status and date are provided for reference purposes--CommCat does not use this information. 

When you click a Sub check box, today's date is automatically added to the date column. If you edit the date, 

the edited date is then used when you check Sub for other contacts. Note that submitted status can also be 

added automatically when you prepare a Record Sheet for submission to the ARRL. Any entities marked as 
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submitted are used to calculate eligibility for new awards and endorsements, but are not included on the 

Record Sheet for the ARRL (because you presumably submitted them previously). 

Click the column header of any column to set the order of the list to that item. 

  

Column Description 

Prefix The master prefix for the associated entity. There may be more than one QSO per entity (and therefore duplicated 

prefixes) if you are viewing a composite (multiple award) QSO list. 

DXCC The DXCC Reference number used by CommCat to identify each entity. 

Confirmed The number of Confirmed QSO's for this entity. To refresh this column, use Maintenance, Get Confirmed. CommCat 

searches the current log (or All Logs if so specified in the View menu) for all confirmed QSO's. Click any cell in this 

column to expose a down arrow that provides a list of all QSO's that qualify. Click any QSO to use that contact for 

the current award. 

Call The call sign for the QSO to be used for this award. 

Worked The date the station was worked (in the same format as your system date). 

Band The Band used for the contact. 

Mode The Mode used for the contact. CommCat uses the Mode table to determine which modes qualify. To open the Mode 

table, go to File, Settings, Station, and click the Mode tab. The Award Name in the Mode table is used to qualify any 

mode for inclusion in the submission. For example, USB, LSB, SSB, AM, and FM are valid modes for PHONE. 

DXCC uses PHONE, CW, and RTTY modes. 

Sub Check box to indicate that this QSO has been submitted for an award. If a QSO is checked, it will not be included 

when the QSO Record Sheet is prepared for submission. When a Record sheet is viewed you are asked if you want to 

have CommCat automatically fill the Sub and Sub Date fields for the submitted QSO's. 

Date The date this QSO was submitted for an award. 

Chk Check box to indicate that this QSO has been checked for the award. 

Date Date the QSO was checked. 

Entity The full entity name. 

The current Award view can be printed by right clicking over the grid and choosing Print Preview from the 

menu. 

Starting a new Award 

CommCat has the ability to track status for all DXCC Award categories. You can prepare submission record 

sheets for any individual award, or combine individual awards into a composite submission. Records sheets 

can be prepared for confirmed contacts for normal DXCC awards, or worked and not necessarily confirmed 

contacts for awards that do not require cards such as the DXCC QRP and Millennium awards. 

CommCat keeps DXCC Award status for confirmed, worked, current log, and all logs. Each award can 

therefore have up to four different status record lists. For example, you can keep status information for DXCC 

Mixed (confirmed, current log), DXCC mixed (worked, current log), DXCC Mixed (confirmed from all logs), 

and DXCC Mixed (worked from all logs). Depending on how you've set up your logs, you will normally use 

the first option, DXCC Mixed confirmed in current log. The choices of what format to use are made in DXCC 

Award window View menu. 
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 Open the log you wish to use for an award (you can also use All Logs once the DXCC Award window 

is open). 

 Open the DXCC Award window from Awards, DXCC, DXCC Award. CommCat displays the status 

for the Mixed Award, confirmed, in the current log. 

 Select the award you wish to view from the Award list at the bottom of the window. CommCat 

refreshes the view. 

 Click Auto Select to instruct CommCat to search the current log (or All Logs, if selected in the View 

menu) for the most recent confirmed QSO for each entity. Only QSO's meeting the requirements for 

the selected award are used. For example, if you are working on the RTTY award, only RTTY 

contacts (or contacts using a mode that has been identified as "RTTY") are used. QSO's added to the 

Award are colored blue so you can easily identify and check them. 

 Click any header in the list to set the order of the list to the order of that column. Click the header 

again to set the order to the opposite direction. 

 If preparing a submission that requires QSL cards, locate the QSL cards in the list. Click DXCC Order 

Preview to set the list to the order required for the submission and organize the QSL cards in that 

order. 

If you can't find a card, you can select another QSO for that entity. Click Get Confirmed in the Maintenance 

Menu. CommCat finds all confirmed QSO's for each entity and displays the number in the Confirmed column. 

Click the cell holding the number, then click the down arrow to display a list of all qualifying QSO's. Select 

the QSO you want to use, or "none" if you want to exclude that entity from the submission. 

The Listing shows confirmations received by card and by LoTW. The data from the QSL Received Type is 

shown for each call in the drop down list. If an entity has been confirmed by LoTW you do not need to submit 

a card. 

Composite (Multiple Award) Submissions 

The DXCC Award window has two formats for data, one for individual award tracking, and a second for 

managing composite (multiple award) submissions. To create a composite submission you must first collect 

data for the individual awards you want to submit. For example, suppose you want to submit an application to 

the ARRL for DXCC Mixed, DXCC Phone, and DXCC 20. 

 Open the QSO list for Mixed from the drop down list in the lower right corner of the window, and 

collect data. The most convenient way to collect data is to use Auto Select. Auto Select finds the most 
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recent confirmed QSO for each entity. Check "Sub" (Submitted) for any QSO's you want to exclude 

from your new submission. 

 If you prefer to make your own selections, click Get Confirmed in the Maintenance menu. 

 Complete the same steps for Phone and 20. 

 Open the QSO list for Composite from the drop down award list. You will be asked what awards you 

want to include. Awards for which CommCat has found unsubmitted QSO's are enabled. Check 

Mixed, Phone and 20. 

 Multi QSO's must be treated differently in a composite submission. Any QSO's you are submitting 

where more than one QSO is confirmed by a single card are considered to be "Multi" and must be 

placed at the end of the submission list. To look for Multi QSO's, click the Call header to place the list 

in call sign order. You will be able to easily spot repeated calls in the list. If two or more QSO's are on 

the same QSL card, click Multi for those contacts. Multi status is not retained in the database since a 

QSO can be multi in one composite submission and not in another. 

 Check the data by clicking DXCC Order Preview, collect the cards, and organize them in the same 

order. 

 Create the printed form by using Reports, ARRL, and the form you want to use. 

Note you can use the current log (the default) or All Logs by clicking Use All Logs in the View menu. You 

can also include QSO's from Deleted Entities the same way. When you are using All Logs, composite 

submission uses the data for individual awards that have also been collected using All Logs. 

Editing Contacts 

The open the Advanced Log for any contact in an Award View or Log View, select the contact, right-click, 

and choose Show Log for This Call... 

Printing Reports 

You can print the Award View table for any award. Right click over the table and choose Print Preview. It is 

not possible to print the Log View. 

CommCat prepares DXCC Record Sheets (QSO Lists) and DXCC Award Application cover sheets for DXCC, 

QRP DXCC, and Millennium DXCC awards. The Record Sheets follow the order and data guidelines required 

by the ARRL for these forms. Sample Record Sheet and Award Application windows are shown below. 
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CommCat prepares the DXCC Award Application in Adobe Acrobat PDF form and displays it in the Acrobat 

Reader window. The form is partially completed with information already known by CommCat. Any field can 

be edited and blank fields completed by clicking the field you wish to change and typing the required 

information. Check marks can be added to or removed from check boxes by clicking the box you wish to 

modify. 

 




